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Design Studio Overview
Features

Ketra’s Design Studio and companion software, Tech Tool, 
offer a multi-faceted interface for comprehensive control of 
an installation. With Design Studio, you can configure settings 
on lights and controllers, craft scenes and shows to assign to 
Ketra or Lutron keypads, and perform more technical functions 
like establishing an emergency-lighting protocol or integrating 
other companies’ lighting systems. Tech Tool offers even more 
advanced features. 

PART 1: GETTING STARTED
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What’s New in 3.0?

Design Studio 3.0 is Ketra’s first release tailored to support integration with Lutron technology 
in residential applications. You can now choose between two installation types: Ketra Only and 
Ketra with HomeWorks QS. Ketra Only installations have access to Design Studio’s full range of 
functionality, whereas Ketra with HomeWorks QS installations use a simpler interface to integrate 
with a Lutron control system. 

The table below summarizes the differences in available functionality between the two installation 
types. Note that the differences in workflow between the two installation types are described in 
Commissioning Workflow, page 17. 

Ketra Only (Commercial)
Ketra with HomeWorks 

QS (Residential)

Configuring N4 Hubs on the network ✓ ✓

Adding and configuring Ketra lights ✓ ✓
Adding and configuring third-party 
lights ✓ ✓

Dividing linear runs into separate 
groups ✓ ✓

Using Design Studio’s color picker to 
customize light content ✓ ✓

Setting default states for groups of 
Ketra lights ✓ ✓
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Ketra Only (Commercial)
Ketra with HomeWorks 

QS (Residential)

Building scenes and shows ✓ ✓
Assigning scenes and shows to Ketra 
keypads ✓

Integrating DMX outputs ✓ ✓
Integrating sensors, DMX inputs, and 
third-party outputs ✓

Performing firmware updates ✓ ✓

Troubleshooting devices ✓ ✓

Local autosaves (stored on computer) ✓ ✓
Automatic backup to Ketra’s cloud 
servers ✓ ✓

In addition to the changes above, Design Studio 3.0 allows you to choose whether power-cycled 
Ketra lights return to their last-published default state or return to their state prior to power-
cycling. Toggling this feature on and off is done by individual device in the Device Settings tab.

How to Use This Manual

This manual applies to:

•	 Design Studio 3.0 and firmware version 2.0 (For updating firmware, see Updating Firmware,  
page 155)

•	 Installations that use Ketra N4 Hubs to communicate, not the N1 Network Dongle

 
This manual does not cover Lutron’s HomeWorks QS software. For documentation on integrating 
Ketra with HomeWorks QS, we recommend Lutron’s app note #696, Integrating Ketra products into 
HomeWorks QS systems:

•	 Web link (Requires Internet access)

•	 Appendix A, page 178

 
Navigation tips:

•	 We recommend using Ctrl+F (on Windows) or Cmd+F (on Mac) to search for terms or phrases.

•	 Any page references that appear in this document are clickable links to the referenced sections. 

http://www.lutron.com/TechnicalDocumentLibrary/048696.pdf
http://www.lutron.com/TechnicalDocumentLibrary/048696.pdf
http://www.lutron.com/TechnicalDocumentLibrary/048696.pdf
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Key Concepts
You can easily understand many processes in Design Studio if you 
have a solid grasp of three fundamental concepts: groups, scenes, 
and triggers. 

Groups are collections of devices intended to be controlled 
together. Scenes are combinations of color and intensity 
configurations for groups. Triggers are the events that switch 
between one scene and another (in some cases, one show and 
another). To use an analogy, a group is like a squad, a scene is like 
a command, and a trigger is the event that causes the command. 

Groups

A group (sometimes known as a control zone) is a custom subset 
of an installation’s devices (e.g., lights) that you intend to control 
as a unit. Any devices you intend to control together should be 
put into a group. For example, a residential installation will likely 
have a group called Kitchen and a group called Living Room.

Further, you can use nested groups or subgroups to represent 
zones within rooms, or rooms within suites. Commands issued to 
a nested group will only affect that group. Commands issued to a 
parent group, however, will affect that group as well as any nested 
groups it contains.

Figs. 1 and 2 provide two examples of groups and nested groups.

A Master Suite 
keypad could 
control all of 
these, but a 
Closet keypad 
could only 
control Closet

Same level 
of hierarchy; 
Controls from 
one can’t affect 
the other

fig. 1

Same level 
of hierarchy; 
Controls from 
one can’t affect 
the other

fig. 2

Could be 
controlled 
by different 
occupancy 
sensors
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To control a single light or output, put it in its own group.

To control a single light or output, put 
it in its own group

fig. 3

Groups can contain a variety of devices, depending on the type of installation. 

•	 In a Ketra with HomeWorks QS installation, groups can contain either Ketra lights or nested 
groups, but not both. In other words, only leaf nodes (likely representing zones and small rooms) 
can have Ketra lights.

Note: A Ketra N3 Satellite with attached linear fixtures counts as a light. 

•	 In a Ketra Only installation, groups can contain any combination of the following:

–– Ketra lights

–– Ketra keypads (and virtual keypads)

–– Third-party lighting (connected to an N3 Satellite or X2 Dimmer)

–– Other third-party outputs (connected to an N3 Satellite)

Keypads in Groups

In Ketra Only installations, groups can contain Ketra keypads in addition to lights and outputs. 
When a keypad is in a group, it can control the devices within that group as well as any devices in 
the nested groups, i.e., it can control from its point in the hierarchy down. However, keypads cannot 
control groups from other parts of the hierarchy. 

Keypad 3 can control both private 
offices and the open office spaces

Keypad 1 can only control the corridor

Keypad 2 can control the open office spaces

fig. 4
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Grouping Hierarchy

In Design Studio’s Organization tab, you will construct the installation’s grouping hierarchy or 
grouping tree. Fig. 5 shows how two rooms might translate into a grouping hierarchy. 

The grouping hierarchy is especially important in Ketra Only installations, because Ketra keypads 
can only control their own group and subgroups. Therefore the keypad’s placement in the hierarchy 
determines which devices it can control. 

One Device in Multiple Groups

Ketra lights and third-party outputs can belong to multiple groups. An example application is 
security or “away” lighting: an installation could have a Kitchen group and a Living Room group, as 
well as an Away group containing one or two lights from both. At night, the user could turn off both 
rooms’ lights, then turn on the Away group for security. 

continued on next page

“Office”

“General” “General”

“Accent”

“Accent”

“Task”

“Lobby”

fig. 5

fig. 6

The under-cabinet lighting and 
fireplace lighting can be controlled 
with their rooms, or they can be 
activated together in the “Away” group.

Caution: A common mistake is to put a device into 
two groups and then include both groups in a scene. 
If the scene has different settings for each of those 
groups, the device will receive conflicting commands, 
causing it to behave unexpectedly. 
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Scenes

A scene is a set of lighting configurations that applies to an installation’s groups. These 
configurations may include color, intensity, and other parameters. For example, the Daytime scene, 
shown in fig. 7, sets all groups to 4500K at 100% intensity. 

fig. 7

Note: As fig. 7 suggests, scenes always have content for every group in an installation. 
However, when you assign the scene to a trigger in the installation, you can specify which 
of those groups the scene applies to. This enables you to assign a single scene to multiple 
triggers affecting different sets of groups. For more information, see Global Scenes, Local 
Applications, page 10. 

Ketra curates a number of default scenes for any installation. When you add a keypad to your device 
list, some of these scenes get automatically assigned to the keypad based on the keypad’s button 
names. You can always clear these scenes and custom-program any buttons you want. 

Feel free to modify any of Ketra’s default scenes, or create your own. 

Scenes vs. Shows

Whereas scenes are static, shows are dynamic. When you play the Daytime scene, your lights will 
stay on the Daytime setting until some other change is triggered; by contrast, when you play the 
Natural show, your lights’ color temperature will shift over the course of the day to match sunlight. 

Shows are made up of any number of time triggers, each of which plays a scene. Thus the Natural 
show is actually a long series of scenes associated with times of day; in every scene scheduled 
to play before noon, the color temperature is slightly higher than before, while in every scene 
scheduled to play after noon, the color temperature is slightly lower than before.
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Global Scenes, Local Applications

Note: This section applies to Ketra Only installations and does not cover managing Design 
Studio scenes in HomeWorks QS.

Scenes always have settings for every group in an installation. For example, in the Daytime  
scene shown in fig. 7, notice that every group has content (4500K, 100% intensity). However, when 
you assign a scene to a trigger, you have the opportunity to limit the number of groups that the 
scene affects. 

The three bullets below describe how to limit groups for each kind of trigger. Triggers themselves 
are discussed in more detail in Triggers, page 12. 

•	 Ketra keypad buttons - Ketra keypads can only control their own part of the grouping hierarchy, 
i.e., their own groups and subgroups. You can further narrow this by picking which subgroups 
to apply the scene to whenever a given button is pressed. In fig. 8, pressing the keypad’s “Away” 
button will play the Away scene on the Open Area group and its subgroups. Note that the West 
Wing group is not the highest-level group in the installation; the keypad only has a subset of the 
larger grouping hierarchy.

continued on next page

•	 Contact-closure inputs - Analog inputs that trigger scenes allow you to pick and choose 
any groups or subgroups in the installation to apply the scene to. In fig. 9 (next page), the 
N3 Satellite will play the Away scene on the Open Area group and its subgroups anytime the 
contact-closure input is put into a switched state. 

fig. 8

Scene will only play 
Open Area groups
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fig. 9

•	 Time triggers in shows - Timeclock events in shows control every group in the installation by 
default. Your method for excluding groups from shows varies depending on how the show is 
configured to run. (Both methods for excluding groups from shows are discussed in more detail 
in Excluding Groups from Shows, page 88.)

–– If the show is assigned to a keypad button or analog input trigger, you can use the 
checkboxes described in the previous two bullets to control which groups the entire show 
affects. In fig. 10, for example, the Natural show will only play on the Open Area group 
and its subgroups. Note that the West Wing group is not the highest-level group in the 
installation; the keypad only has a subset of the larger grouping hierarchy.

You can select and deselect groups when assigning a show to 
a keypad.

fig. 10

continued on next page
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–– If the show is set to run automatically, you should ensure that every scene shows NA for 
whichever groups you want to exclude from the show. In fig. 11, whenever the Run Always 
show is playing, the 12:00 PM trigger will only affect the Open Area group and its subgroups. 

For Run Always shows, set groups you don’t want to include to NA.

fig. 11

Triggers

A trigger is an event that causes a change in the state of your lighting. Generally, a trigger causes a 
scene or show to play. There are several kinds of triggers:

Keypad Button Press

When a user presses a keypad button, the keypad broadcasts a corresponding command to the 
Ketra devices it controls. Button presses can trigger scenes or shows to play. 

For example, pressing the “Natural” button on a Ketra keypad causes the Natural show to play on 
whatever devices the keypad controls.

Note: Whenever a show is triggered from a keypad, it comes on at the correct setting for the 
current time.
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Timeclock Event in a Show

A show is a series of time triggers, or events linked to times of day. For example, a time trigger might 
be set to take place at 4 PM, or at 2 hours before sunset, or every fourth minute in a loop. Each time 
trigger in a show causes a scene to play. 

For example, a natural show may include triggers every 5 minutes, each shifting lights’ color 
temperature and intensity to mimic shifts in sunlight over the course of the day.

Input Signal from a Sensor or Third-Party Device

Sustained contact-closure inputs and some 0-10V inputs can be thought of as causing trigger 
events, since they relay only one of two states. 

For example, an occupancy sensor may trigger a scene when it detects occupancy, then trigger an 
off state when it detects vacancy. 
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Installing the Software
The Design Studio software package (including Tech Tool) can be downloaded through your 
myLutron account at lutron.com. Design Studio is only available to users who have been through 
Ketra’s technical training. 

Qualified users who do not have myLutron accounts can get access to Design Studio and Tech Tool 
by contacting Ketra Support at ketrasupport@lutron.com. 

System Requirements

Design Studio requires:

•	 A Windows 7 or later Windows operating system.

•	 At least 30 MB of free storage.

Note: Design Studio is not Mac-compatible.

mailto:ketrasupport@lutron.com
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Managing Accounts
Changing Account Information

Use my.goketra to change your account name, email, or password. Changing your Ketra account 
information will not affect your myLutron account.

1	 In your web browser, navigate to https://my.goketra.com/users/edit.

2	 Log in if prompted. 

3	 Use the same Ketra account information you use to log in to Design Studio.

4	 Make the desired changes.

5	 Enter your current password and click Update.

fig. 12

Logging Out of Design Studio

Note: Logging out of Design Studio does not log you out of my.goketra in your web browser.

continued on next page
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To log out of Design Studio, follow these steps:

1	 In Design Studio, navigate to the Existing Installations list. 

2	 Open the sidebar by clicking the user icon in the top-left corner. 

fig. 13

fig. 14

fig. 15

3	 In the sidebar, click Log Out.



DESIGN STUDIO 3.017

DESIGN STUDIO 3.0 
COMMISSIONING AN INSTALLATION

PART 2: COMMISSIONING AN INSTALLATION

Commissioning Workflow

continued on next page
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The Design Studio workflow for Ketra with HomeWorks QS installations varies depending on whether 
you are programming on-site or off-site. 

Note: We recommend saving progress regularly. If your computer has an Internet connection, 
the best way to save progress is to sync by closing out of the installation. If there is no 
Internet, the best way is to click Publish and Save in the top-right. For more information, see 
Saving Your Progress, page 168.

If programming entirely on-site:

1	 Create an Installation (page 21)

2	 Enable API Authentication on N4 Hubs (only if commissioning without Internet access) (page 26)

3	 Build Groups (page 31)

4	 Add Devices (page 38)

5	 As needed:

i	 Divide Linear Runs into Groups (page 47)

ii	 Manage Power-On Lighting States (page 59)

iii	 Build Scenes (page 68)

iv	 Build Shows (page 78)

v	 Integrate Third-Party Lighting via DMX Output (see DMX Output, page 141)

The Design Studio workflow varies significantly depending on 
whether the installation is Ketra with HomeWorks QS (Residential) 
or Ketra Only (Commercial).

Ketra with HomeWorks QS (Residential)

For a document that specifically covers integration between Ketra 
products and the HomeWorks QS system, we recommend referring 
to Lutron’s app note #696, Integrating Ketra products into 
HomeWorks QS systems:

• Web link (Requires Internet access)

• Appendix A, page 178

http://www.lutron.com/TechnicalDocumentLibrary/048696.pdf
http://www.lutron.com/TechnicalDocumentLibrary/048696.pdf
http://www.lutron.com/TechnicalDocumentLibrary/048696.pdf
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6	 Publish Configurations (see Publishing: Saving Configurations to Devices, page 152)

7	 Return to HomeWorks QS, import the Design Studio installation, and continue commissioning

If programming partially off-site:

1	 Create an Installation (page 21)

Note: If creating an installation off-site, skip the N4 provisioning steps.

2	 Build Groups (page 31)

3	 As needed:

i	 Build Scenes (page 68)

ii	 Build Shows (page 78)

4	 Travel to site

5	 Add N4 Hubs (see Adding Additional Hubs, page 29)

6	 Enable API Authentication on N4 Hubs (only if commissioning without Internet access)  
(page 26)

7	 Add Devices (page 38)

8	 As needed:

i	 Divide Linear Runs into Groups (page 47)

ii	 Manage Power-On Lighting States (page 59)

iii	 Integrate Third-Party Lighting via DMX Output (see DMX Output, page 141)

9	 Publish Configurations (see Publishing: Saving Configurations to Devices, page 152)

10	 Return to HomeWorks QS, import the Design Studio installation, and continue commissioning

Ketra Only (Commercial)

Ketra Only installations have an expanded range of features to support an entire installation’s 
needs. A typical workflow is as follows:

1	 Create an Installation (see Creating an Installation, page 21)

2	 Enable API Authentication on N4 Hubs (only if commissioning without Internet access)  
(page 26)

3	 Configure Network Settings for N4 Hubs (As needed) (see Managing N4 Hubs, pages 26–29)

4	 Build Groups (page 31)

5	 Add Devices (page 41)

continued on next page
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6	 As needed: 

i	 Divide Linear Runs into Groups (page 47)

ii	 Manage Power-On Lighting States (page 59)

iii	 Build Scenes (page 68)

iv	 Build Shows (As needed) (page 78)

v	 Assign Scenes and Shows to Keypads (see Programming Ketra Keypads, page 103)

vi	 Configure Emergency Lighting (see Enabling Emergency Mode Lighting, page 118)

vii	 Configure Sensors and Other Inputs (see Enabling Sensor Control, page 113; All Analog 
Integration Profiles, page 131; and DMX Input, page 136)

viii	 Integrate Third-Party Lighting and Other Outputs (see All Analog Integration Profiles, page 
131; and DMX Output, page 141) 

7	 Publish Configurations (page 152)

Pre-Commissioning Checklist

Installation Conditions

☐☐ All Ketra products are installed in their intended fixtures and power is applied.

☐☐ All Ketra products are energized and operating. Light is emitting from lamps and luminaires, 
keypads are backlit, and N3 and N4 indicator lights are on. 

☐☐ Visual diagnostic colors have been cleared. (Ketra fixtures should power on to a default  
white state. If any power on to a different color, they were most likely installed incorrectly. 
A table of diagnostic colors and their meanings can be found in the respective products’ 
installation guides.)

If you detect an error in the installation conditions, contact service@ketra.com immediately.

N3 Satellites

☐☐ Integration wiring (if applicable) matches Ketra submittal. Wires of the expected color are 
connected to the correct ports. 

Documentation (If Applicable)

☐☐ N4, N3, and X2 product serial numbers have been noted on RCP and in the Satellite key provided 
in the submittal.

☐☐ Occupancy, vacancy, and daylight sensors marked on RCP, including physical location and 
intended control zones.

☐☐ Ketra-controlled third-party loads are marked on RCP indicating physical location.

☐☐ All documentation for wiring and implementation of non-Ketra loads is available for reference.

☐☐ Network credentials have been documented for any N4 installation.

continued on next page

mailto:service@ketra.com
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Note: Internet connection is not required for the computer or the N4s. However, the 
computer must be able to connect to the N4s’ LAN (Local Area Network), either by Wifi or by 
hardwire connection to the N4s’ router. For instructions on troubleshooting your connection 
to N4 Hubs, see Troubleshooting N4 Hubs, page 25.
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Creating an Installation

Creating an installation is the first step in the commissioning process. 
It generates a file for your Ketra configurations to live in. 

What account should I use to create the installation? 
We recommend using a specific account, e.g., one with your name in 
it as opposed to a company account. This ensures that there is a clear 
record of who created the installation.

Setup

To create an installation and perform the necessary setup, follow 
these steps:

2	 Name the installation.

Naming Convention 
We recommend naming the installation after the project title on the Ketra submittal (if 
available), and/or the address of the project. This level of specificity will be helpful if technical 
support is needed later on.

continued on next page

fig. 16
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1	 Click Create a New Installation on the Design Studio home screen. 
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3	 Choose Secure Installation. Open installations should be used only for temporary 
demonstrations of Ketra’s lighting system. 
 
In secure installations, devices are provisioned (added) to a private network unique to the 
installation, meaning no other installation will be able to access them unless you deprovision 
them first. Open installations, by contrast, leave devices on the public network, allowing use of 
the same products for multiple installations.  
 
Open installations can be converted to secure installations once the installation setup is 
complete. See Converting to a Secure Installation, page 165.

fig. 17

4	 Click Next.

5	 On the next screen, select N4 Hub(s).

6	 Set whether you are building a Ketra Only or Ketra with HomeWorks QS installation (see fig. 
18, next page). If you select a Ketra with HomeWorks QS installation, you will have a smaller 
number of available Design Studio features for the installation, since the Ketra software will only 
be used to set up groups, scenes, and shows prior to configuration in Lutron HomeWorks QS.

Note: Only Ketra with HomeWorks QS installations can be imported into the Homeworks  
QS software. 

continued on next page
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7	 Click Next.

8	 Set the installation location and pick an installation template. For a Ketra Only installation, 
we recommend using the Office template. For a Ketra with HomeWorks QS installation, we 
recommend using the Residential template.

fig. 18

Select one

fig. 19

9	 Click Next.
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Provisioning N4 Hubs

Design Studio will now display a list of N4 Hubs available on the computer’s LAN subnet. You can 
add the N4s in this list to your installation. 

Note: If you are setting up an installation off-site and don’t have access to the N4 Hubs, you 
can click Continue to skip this step.

If an N4 is missing from the list, click Refresh. If no N4s appear, see Troubleshooting N4 Hubs,  
page 25. 

To add N4s to your installation, follow these steps:

1	 Highlight an N4 in the list. Highlighting the N4 causes the hub to identify itself by flashing its 
indicator lights. We recommend that for the first few N4s you provision, you use the identify 
feature to confirm that the N4 has been installed in its expected place.

2	 Determine the KNet that the N4 should support. Reference the KNet Diagram (if available) for 
the KNet locations and names. Note that each N4 supports one KNet. 

Rename the N4 by clicking the pencil icon . 
 
Naming Convention 
We recommend renaming the N4 after the KNet it is supposed to support. For example, “1.01” 
might be a better name than “KP00002684.” 

3	 Change the N4’s channel as necessary. Adjacent KNets should be set at least 2 channels apart. 
This ensures that there will not be radio interference between them. 

4	 Repeat steps 1-4 for all of the other N4s you intend to add.

5	 Highlight all of the N4s using Shift+Click and then click Add Hubs to Installation.

6	 Click Continue.

fig. 20
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Troubleshooting N4 Hubs

If you are on-site and unable to discover any of the installation’s N4s, there are several potential 
issues you may be encountering:

•	 The N4 Hubs might not have power

•	 The N4 Hubs might not be on a LAN

•	 The N4 Hubs might not be receiving DHCP addresses

•	 The N4 Hubs might be on a network with a firewall

Use this troubleshooting workflow to identify and fix N4 discovery problems:

If you still cannot discover your N4s after performing those steps, contact Ketra Tech Support. 

Next Steps

After creating the installation, you should be ready to commission. 

What do I do next?

1	 Check the Toggling API Authentication section of this manual, page 26, to see whether you 
need to enable authentication on your N4 Hubs. (Requires communication with hubs)

2	 If the network’s IT administrator has requested that the N4s be assigned static IP addresses  
or custom DNS addresses, see the relevant sections in pages 27-28. (Requires communication  
with hubs)

3	 Start building groups. See Building Groups, page 31.

fig. 21
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Managing N4 Hubs

Depending on the network requirements for the installation, you  
may want to perform some of these optional functions.

•	 Toggling API Authentication: Strongly recommended for any 
installation created without Internet access

•	 Setting Static IP Addresses for Hubs: Not necessary for most 
applications, but may be required by IT administrators in 
commercial spaces

•	 Setting Custom DNS Addresses for Hubs: Not necessary for 
most applications, but may be required by IT administrators in 
commercial spaces

•	 Adding Additional Hubs: Typically used if you realize you haven’t 
added all of the hubs in the space

continued on next page

Contents

Toggling API 
Authentication	 	       26

Setting Static  
IP Addresses for Hubs	     28

Setting Custom 
DNS Addresses  
for Hubs		      29

Adding Additional 
Hubs			       29

Changing a Hub’s 
Channel			      30

•	 Changing a Hub’s Channel: Used to troubleshoot signal interference caused by two adjacent KNets 
broadcasting at the same radio frequency

Toggling API Authentication

The Device Settings tab allows you to toggle API authentication on and off for individual hubs. We 
recommend using the Select All checkbox to ensure that every hub gets the same setting. 

Should I enable API authentication?

N4 Network Enable/Disable
N4 network is connected to the Internet Enable

N4 network is not currently connected  
to the Internet but will be in the future

•	 Another person will use Design Studio or API 
before Internet is established: Disable

•	 Internet connection will be established 
before anyone else uses Design Studio or 
API: Enable

N4 network will never be connected to  
the Internet

Disable

Disabling API authentication is not allowed when remote access is enabled.

Why does API authentication matter? 
API authentication determines whether a Design Studio session or the API can connect to  
the installation. 
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When API authentication is enabled, the N4 will authenticate any message’s OAuth token against 
an onboard database of past tokens, and then against Ketra’s cloud database of authorized tokens. 
However, if there is no Internet connection, the N4 will only be able to access its onboard database. 
That means it will only accept tokens it has encountered in the past. One consequence might be 
that the N4 refuses access to legitimate users who have different OAuth tokens or are working from 
a different Design Studio session. Therefore, authentication is recommended for N4 networks that 
have an Internet connection.

Conversely, when API authentication is disabled, the N4 will accept any message it receives via 
Ethernet without checking its access token. If the N4 network has an Internet connection, disabling 
authentication could allow any user on the Wifi network to send messages via the API. However, if 
the N4 network does not have an Internet connection, disabling authentication may be necessary 
to ensure that new OAuth tokens (from new Design Studio sessions or from other API users) are 
granted access to the installation.

How to toggle API authentication on and off:

1	 In Design Studio, navigate to the Device Settings tab.

2	 In the Settings For dropdown (top-left), select “Hubs”.

3	 Use the Select All checkbox to highlight all N4 Hubs.

4	 In the Modify Hub Settings pane, use the dropdown to set API Authentication to “Enabled”  
or “Disabled”. 

5	 Click Apply To Selected.

continued on next page
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Setting Static IP Addresses for Hubs

Use the Device Settings tab to configure N4 Hubs’ IP addressing per IT requirements. By default, N4s 
use DHCP addressing, but after receiving a dynamic IP address they can support static IPs. 

Note: The best solution for static IP addressing is to reserve an IP address for each N4’s MAC 
address on the DHCP server. Only when this is not an option should you set a static IP address 
for the N4 through Design Studio. 

To set a static IP address for an N4 Hub, follow these steps:

1	 Navigate to the Device Settings tab of Design Studio.

2	 In the Settings For dropdown, select “Hubs”.

3	 Select a hub from the list of devices on the left. 

4	 In the panel on the right, change the IP Settings dropdown to “Static”.

5	 Fill in the “IP Address”, “Subnet Mask”, and “Default Gateway” fields. These values should be 
provided by the facility’s IT administrator.

6	 Determine when the change should take effect. 

7	 Click Apply To Selected.

Note: Each N4 Hub requires its own IP address.
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fig. 23
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Setting Custom DNS Addresses for Hubs

Ketra Tech Tool enables you to set a primary and secondary DNS for individual N4 Hubs. This action 
should only be performed if specifically request by an IT administrator for the network. 

To set custom DNS addresses, follow these steps:

1	 Open the installation in Ketra Tech Tool.

2	 Navigate to Tech Tool’s Advanced Features tab.

3	 Use the Select a Feature dropdown to select “N4 Settings”.

4	 Enter the primary and secondary DNS addresses in the text fields.

3

2

4

fig. 24

Adding Additional Hubs

On Design Studio’s Organization tab, the top-right pane has a tab labeled Add Hubs. (See fig. 25.) 
This displays any N4s connected to your LAN (Local Area Network). 

fig. 25

continued on next page
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Notice that you can change a hub’s channel before you add it. Only do this if you have multiple N4s 
that will be positioned close together in your installation. In that case, you will want adjacent N4s 
to be on different channels from one another to ensure ideal communication. If your N4s will not be 
close together, leave the hub on its default channel.

Changing a Hub’s Channel

You can change the channels of hubs you’ve already added to your installation. Since adjacent 
KNets on the same channel can cause mutual interference, changing a hub’s channel may be the 
best way to ensure reliable communication. 

Caution: Before changing a hub’s channel, make sure that all of the KNet’s devices respond 
to wireless control as expected (instructions below). If they fail to communicate for any 
reason, they will be left behind when the hub changes channels. The only way to reach them 
(after troubleshooting whatever error caused them to fail to communicate in the first place) 
will be to use Find a Missing Device in Tech Tool, which can search multiple channels. (See 
Recovering an Unresponsive Device, page 174.)

To change an N4 Hub’s channel, follow these steps:

1	 Confirm that the KNet’s devices respond to wireless control.

i	 Navigate to Design Studio’s Organization tab.

ii	 In the My Devices list, expand the Hubs section.

iii	 Expand the N4 Hub for which you want to change the channel.

iv	 Using Shift+Click, highlight all of the hub’s devices. This should cause all of them to identify. 

v	 Confirm that all of the devices identify successfully. There should be a blue box next to 
the device name/serial that says “Identified.” If any device fails to identify, troubleshoot the 
device. Do not change the hub’s channel until you can successfully identify the device.

2	 Open the installation sidebar. To do so, click the user icon in the top-left corner.

3	 In the sidebar, select “Change Network Channel”.

4	 In the dialogue box, select the hub and a new channel, then click CHANGE. Pick a channel that 
is at least two channels away from any adjacent KNets.
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Building Groups

Building groups is a necessary step in all installations. We recommend 
building empty groups for the entire installation before you add any 
devices. This is much more efficient than adding devices first and 
then sorting them into groups, although you could technically do 
that too.

For an explanation of what groups are, see Key Concepts, page 6. 

Planning a Grouping Hierarchy

Before adding any groups, we recommend thinking about what your 
grouping hierarchy will be, possibly even laying it out on paper. After 
you create your hierarchy, you will not be able to drag and drop 
groups to relocate them, so knowing the structure before you build 
might prevent laborious rework later.

Planning your hierarchy should be done with consideration to the 
space and stakeholder preferences. 

Contents
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Deleting Descriptors	     37

Note: Groups can overlap KNets. 

Not every installation needs to use nested groups, but they can be helpful in many applications.

•	 Use nested groups to represent zones within rooms. This includes any group that you want to 
be discreetly controllable at any time. Examples:

–– General, task, and accent lighting in an office or study

–– Lights above a media station: Putting these into a nested group enables you to control 
them separately from the room’s other lighting when a video or movie is playing, and to 
control them together with the room’s other lighting when no video or movie is playing.

•	 Use nested groups to represent rooms within suites. These nested “room” groups might in turn 
have their own nested “zone” groups. Example:

–– A Master Suite group might contain subgroups "Master BR", "Master Bath", and "WIC". In turn, 
"Master BR" might contain several groups for zones, as in the previous example. Since these 
are all nested within "Master Suite", a "Master Suite" keypad could turn the entire suite off as 
needed. See fig. 26, next page.
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Adding Groups

To add new groups, use the top-right panel of the Organization tab. (See fig. 27.)

fig. 27

Group names are recommended based on the installation template. For example, the Residential 
template includes group recommendations like “Living Room,” “Kitchen,” or “Bedroom.” In turn, 
most rooms contain "General", "Task", and "Accent" groups. You can also add a custom group by 
scrolling to the bottom of the list. 

To add the group to its place in the hierarchy, follow these steps:

1	 In the top-right pane of the Organization tab, select a group type to add. You can also scroll to 
the bottom of the list and select "Custom Group".  
 
To select multiple groups at once, use Ctrl+Click or Shift+Click.  
 
The group type you pick determines the descriptors (tags) that the group comes with. For 
example, the “Accent” group comes with the descriptor “accent.” These descriptors determine 
what content the groups receive by default in each of the pre-curated Ketra scenes. However, 
both the descriptors and the Ketra scenes can be modified. 

continued on next page
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2	 Highlight the parent group in the My Devices panel. This could be the highest-level group in the 
installation or a group lower in the hierarchy.

3	 Click the green Add Group to <Parent> button.

4	 Rename the group by clicking the pencil icon next to its name. 
 
Naming Convention 
Each group should have a unique and specific name. For zone groups, we recommend 
including the name of the room—e.g., “Kitchen General” rather than “General (2).” In office 
spaces, we recommend naming room groups after the label in the KNet diagram, plus a 
descriptive blurb as needed—e.g., “2-6019 NW Office.”

fig. 29

fig. 28
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Deleting Empty Groups

Groups can be deleted as long as they are empty. To empty out a group, either deprovision its 
devices or move them to other groups. Then, to delete the group, highlight it and click the X 
(Remove) button at the top of the My Devices panel. 

fig. 31

Managing Group Descriptors

Note: Groups come pre-loaded with descriptors. Changing group descriptors is optional, 
and unnecessary for most applications. If used incorrectly, custom descriptors can cause 
complications later during the programming workflow.

Descriptors are tags for groups. They can be added in the Details pane at bottom-right in the 
Organization tab. 

fig. 30

continued on next page
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When building scenes in template view (see Template View, page 73), you will be able to apply 
content to any groups with a certain descriptor. Tagging groups with descriptors can therefore 
streamline your Design Studio workflow under some circumstances.

We recommend using descriptors for:

•	 Groups that are not siblings (i.e., belong to different parent groups in the hierarchy) but should 
have the same content in scenes

•	 Groups that are siblings but should be controlled differently from their other siblings

Example: An installation has 4 bedrooms, each with the same 3 zones: overhead lights, standing 
lights, and bedside lights. You want every bedroom keypad to have a scene where the overhead 
lights have one setting, the standing lights have another, and the bedside lights have a third. 

A quick way to accomplish this would be to use 3 custom descriptors (e.g., “br overhead,” “br 
standing,” and “br bedside”), one for each type of zone. When you build the scene, you can save time 
by using Template View to assign content by descriptor rather than by group. Rather than having to 
make 12 settings (4 bedrooms x 3 zones), you can accomplish the same effect by making 3 settings (1 
setting per descriptor).

Tips for Using Descriptors

Avoid deleting descriptors if you have already used them in a scene. 
Descriptors can be removed from groups in the Details pane. However, deleting descriptors does not 
modify any scenes the descriptors are used in, and it will cause the group to NOT be included in the 
scene. For example, if a scene applies a setting to anything with the “residential” and “wood floors” 
tag, deleting the “wood floors” tag from a certain group will exclude that group from the scene.

Use as few descriptors as possible to get the job done. 
Using superfluous or redundant descriptors can result in confusion, requiring you to delete 
descriptors from their groups for the sake of clarity. For the reasons discussed in the previous tip, 
this situation can cause complications and should be avoided. 

For instructions on using descriptors in scenes, see Template View, page 73.

Descriptor Inheritance

It is important to note that groups inherit the descriptors of their ancestor groups (i.e., groups 
higher in the hierarchy). These inherited descriptors do not appear in the Details pane (bottom-
right) with the group’s other descriptors. 

For example, in fig. 32 (next page), the group "FL1 Bath General" has a descriptor called “general,” 
which you can see in the Details pane. But it also has other descriptors:

•	 “bathroom,” inherited from "FL1 Bath"

•	 “floor,” inherited from "Floor 1"

•	 “residence” and “custom,” inherited from "Residence"

continued on next page
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Overlooking descriptor inheritance can cause problems when building scenes in Template View. For 
example, you might assign content to any group with the descriptor “custom,” only to find every 
subgroup of "Residence" playing that content. 

The solution, in the case of the group "FL1 Bath General", would be to use Template View to assign 
the scene content to any groups with the descriptors “residence,” “custom,” “floor,” “bathroom,” and 
“general.” This would only match "FL1 Bath General". If you wanted to target "FL1 Bath" and all its 
subgroups, you could assign the content to any groups with the descriptors “residence,” “custom,” 
“floor,” and “bathroom.” And so on.

Adding Descriptors

To add descriptors, follow these steps:

1	 Select a group in the group hierarchy (in the My Devices panel).

2	 In the Details pane (bottom-right), write a descriptor name in the textbox.

3	 Click +.
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fig. 33
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DESIGN STUDIO 3.037

DESIGN STUDIO 3.0 
COMMISSIONING AN INSTALLATION

Note: Groups inherit the descriptors of their ancestor groups (i.e., groups higher in the 
hierarchy). These inherited descriptors do not appear in the Details pane. 

Deleting Descriptors

You can delete a descriptor by clicking the X button next to its name in the same pane. For the 
reasons detailed in Tips for Using Descriptors, page 35, we recommend against deleting descriptors.
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Adding Devices

Adding devices is a necessary step in Design Studio and follows 
a simple workflow. For each KNet, you will first search for nearby 
devices on the public network, then provision (add) them to groups. 
In a Ketra Only installation, you can also add virtual keypads to use  
in the Ketra mobile app.

To search for and add devices to groups, use the top-right panel  
of the Organization tab.

Note: If you are using a Ketra Only installation, you can 
provision Ketra X2 Keypads or virtual keypads. When you 
provision these keypads, Design Studio automatically assigns 
content based on the button labels. For example, a button 
labeled “Media” would receive the default scene Media.  

Contents

Searching for Devices	     38
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Adding Virtual Keypads	     43

Setting Default Keypad  
Button Content		      44

Regrouping Devices	     46

To change what scenes are assigned to each button label, we recommend setting default 
button content before you provision keypads. For example, if you want any button labeled 
“Media” to receive a custom scene called My Scene, you could set “media” as My Scene’s 
default button name, then provision your keypads. For instructions on setting default button 
names, see Setting Default Button Names for Scenes, page 44.

Searching for Devices

The first step in adding devices to your installation is discovering them. This means searching for any 
powered-on devices (lights, keypads, and satellites) within a certain radius. Design Studio will display 
the search results, and you’ll be able to select which devices you want to add.

To perform discovery, follow these steps:

1	 On the Add Devices tab of the top-right pane, click Find New Devices.

fig. 34

continued on next page



DESIGN STUDIO 3.039

DESIGN STUDIO 3.0 
COMMISSIONING AN INSTALLATION

Note: In an installation with only one N4, skip steps 2-4.

2	 In the Select Hub to Add Devices box, designate an N4 with which to search.  The N4 you select 
will search for any powered-on Ketra devices within a certain radius. You will then add devices to 
this N4’s KNet. 

3	 Set the discovery range. This affects the number of devices that Design Studio tries to contact 
during the search. We recommend you pick a range according to these guidelines: 

–– Normal: Use if your N4 is closely surrounded by more than 75 devices that have not been 
provisioned (added to a KNet).

–– Extended: Use if neither Normal nor Maximum returns the devices you expect.

–– Maximum: Use if there are fewer than 75 unprovisioned devices close to your N4.

4	 Click Find Devices to begin the search.

fig. 35
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After you begin the search, the N4 will spend about thirty seconds searching. Any Ketra lights it 
finds will go to a dim blue. The results should look like this:

fig. 36

continued on next page



DESIGN STUDIO 3.040

DESIGN STUDIO 3.0 
COMMISSIONING AN INSTALLATION

An N3 with linear attached will look roughly the same as an N3 without linear attached. (See fig. 37.) 
Read the description beneath the serial number to tell them apart. 

fig. 37

continued on next page

Note: In Ketra with HomeWorks QS installations, only Ketra lights (and N3 Satellites with Ketra 
linear fixtures attached) will appear in the search results. You cannot add Ketra keypads or 
independent N3 Satellites to a Ketra with HomeWorks QS installation.

What do I do about a missing device? 
If a device is missing from the list, click Refresh to repeat discovery of available devices. If it still 
doesn’t appear after several searches, confirm that the device is powered on and has not already been 
added to this installation or a different secure installation.  

Why does my device say “Incompatible Device”? (See fig. 38.) 
The device has been factory-programmed for Ketra Only installations, but you are operating a Ketra 
with HomeWorks QS installation (or vice versa). You may have received the wrong product type. We 
recommend contacting our support team to resolve the issue. You can reach us Monday through 
Friday, 9 AM - 5 PM, CST. Call 1-844-588-6445, or email ketrasupport@lutron.com. 

Why does my device say “Requires Updated Firmware”? (See fig. 38.) 
In Ketra with HomeWorks QS installations, a device may say “Requires Updated Firmware” next to 
its serial number. You will not be able to add that device until it has been updated. However, since 
updating firmware requires that the device be provisioned to some installation, you will have to create 
a temporary Ketra Only installation, add the device into it, update its firmware through Tech Tool, and 
then delete the installation. For instructions on updating device firmware, see Updating Firmware, 
page 160. For instructions on deleting an installation, see Deleting an Installation, page 166.

fig. 38
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continued on next page

Adding Devices

To provision (add) one KNet’s devices to groups, follow these steps:

1	 Use your keyboard’s Up Arrow and Down Arrow to go through the list of found devices. Each 
device will identify itself as you come to it—lights by shining a bright blue, keypads and satellites 
by flashing their indicator lights.  
 
If you select an N3 Satellite with attached linear fixtures, confirm that the number of attached 
fixtures shown below the serial number matches the expected number. 

2	 Keypads and satellites: Rename the device(s) by clicking the pencil icon.  
 

fig. 39
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Naming Convention 
We recommend renaming the keypad or satellite to whatever label appears on the Ketra 
submittal (if you have one). For example, an X2 keypad might be renamed from “KX00001001”  
to “6.02.06”.

3	 Press the spacebar to check the box of the device(s) you want to add. Lights will turn yellow 
when their boxes are checked.

4	 Highlight the destination group(s) in the My Devices panel.

Note: If a run of linear fixtures should be subdivided into multiple groups, add the run to 
whichever group the first fixture belongs in. Example: If the N3 is located in a server room but 
the first Ketra fixture in the run is in Conference Room A, provision the run to the Conference 
Room A group, not the Server Room group. 

After adding all of your devices, see Dividing Linear Runs into Groups, page 47.

5	 Click the green Add button. The device will disappear from the right-side panel and  
reappear in the My Devices panel, on the left. Lights will temporarily shine green to show  
they’ve been added. 
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fig. 40
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fig. 41

Note: If a satellite does not have any attached linear fixtures, it does not go into a group; 
rather, it will appear in the Satellites list toward the bottom of the My Devices panel.

Note: If an error tells you your device is not compatible with the installation, it either requires 
a firmware update prior to adding or it is not suited for your installation type (Ketra Only 
or Ketra with HomeWorks QS). We recommend contacting our support team to resolve the 
issue. You can reach us Monday through Friday, 9 AM - 5 PM, CST. Call 1-844-588-6445, or 
email ketrasupport@lutron.com.

After adding all of a KNet’s devices, finalize your additions by clicking Finish this Hub in the top-
right corner. 

mailto:ketrasupport@lutron.com
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Adding Virtual Keypads

Note: Not available in Ketra with HomeWorks QS installations.

A virtual keypad is one that does not exist physically but that you can control through the Ketra 
mobile app or API. Like a hardware keypad, a virtual keypad can play scenes and shows and be linked 
to other keypads to control the same groups. Unlike a hardware keypad, it can have up to  
19 buttons.

To add a virtual keypad to the installation, follow these steps:

1	 Go to the Add Virtual Devices tab in the top-right pane of the Organization tab. (See fig. 42.) 

fig. 42

2	 Highlight the destination group in My Devices and click the green Add button. (See fig. 43.) 

fig. 43

continued on next page
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3	 In the dialogue box, set a template for the keypad. The template will determine the button 
names as well as the default scenes and shows that the buttons receive. You will be able to 
change the button names and content later, in Device Control > Keypads.

4	 Set the number of buttons. Any buttons beyond the template’s default quantity will be not be 
assigned any content. You will be able to change the button quantities later on.

5	 Click OK. 

6	 Rename the virtual keypad. Select the keypad in the My Devices panel, then click the  
pencil icon. 

Virtual keypads are programmed in the same way as hardware keypads: using the Keypads tab of 
Device Control. For more details, see Programming Ketra Keypads, page 103. 

You can remove virtual keypads from the installation by deprovisioning them. 

Setting Default Keypad Button Content

When you provision a keypad, Design Studio reads its button names and then maps corresponding 
scene or show content to them. For example, a button labeled “Natural” will always get the pre-
curated Natural show as soon as you provision the keypad. 

By default, custom button labels do not get assigned any content. If you plan to add many keypads 
that use custom button labels, we recommend first associating those labels with scenes; this will 
ensure that the buttons do receive default content when you provision the keypads.  

To associate default button names with scenes, follow these steps:

1	 Navigate to Device Control > Scenes. You may need to click Finish or Finish this Hub in the top-
right before you can leave the Organization tab. 

2	 Select the desired default scene from the My Scenes list at left. If you prefer to create a scene, 
you can find instructions on scene-building in Building Scenes, page 68.

continued on next page
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3	 Click the pencil icon next to the scene’s name.

4	 Optional: Rename the scene to match the custom button label.

5	 In the Default Button Names text field, enter the custom button label.

6	 Press +.

7	 Click OK. 

continued on next page
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You can now return to the Organization tab and provision the keypads. 
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Regrouping Devices

Design Studio supports copy, cut, and paste operations to move devices between groups. To  
use these features, click the icons at the top of the My Devices panel (fig. 47), or use any of the 
shortcuts below. 

•	 Ctrl+C: Copy 

•	 Ctrl+X: Cut 

•	 Ctrl+V: Paste

fig. 47
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Dividing Linear Runs into Groups

A run of linear fixtures is all of the Ketra fixtures attached to a single N3 Satellite. By default, Design 
Studio requires all fixtures in a run to be grouped together. However, you can divide a run into 
multiple groups to enable discrete control. 

To do so, use Tech Tool’s ii feature. Emitter Grouping can sort individual linear fixtures into groups, 
and even sort individual emitters within the fixtures into groups. It can also  
put fixtures and emitters from different runs into a group together. 

Example applications:

•	 If a single run contains overhead fixtures in more than one room, use Emitter Grouping to  
divide the run into two groups—one per room. Each room can then be configured and 
controlled independently.

•	 If a single run contains recessed and pendant fixtures, you can use Emitter Grouping to divide 
the run into two groups—one per type of fixture. Each type of fixture can then be configured 
and controlled independently. (The groups can use consecutive or nonconsecutive fixtures.)

fig. 48
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fig. 49

continued on next page
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•	 9 G2 Linear fixtures are washing a wall, and you want half of the wall to have one color and the 
other half to have another color. In this case, you would do the following math:

(6 emitters per G2 fixture) x (9 fixtures) = 54 total emitters 

2 groups 
=   27 emitters per group

Cove

Color 1

G2 Linear

Color 2

fig. 50

N3

Note: Groups must be built in Design Studio prior to using Emitter Grouping. You cannot 
build groups in Tech Tool. 

In the step process below, all example images will draw from this blueprint:

continued on next page
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To sort fixtures and emitters into groups, follow these steps:

1	 If you haven’t done so, create a group for each room or each run segment. If creating groups, 
be sure to add them to their proper place in the grouping hierarchy. 

2	 Add or cut/paste the N3 Satellite into the first group in which its fixtures appear.

Note: The N3 will not necessarily be located in the same room as the first fixture in the run. 
Always put the N3 into the first room that has fixtures. In our example, the N3 is located in 
the utility room, but we will add the N3 to "Bedroom 1".

fig. 52

3	 Make a note of the N3 Satellite’s serial number or name. You will reference this serial number or 
name later in Tech Tool.

4	 Click Finish This Hub to save your hub configurations.

5	 Click Publish and Save.

6	 Close Design Studio and open the installation in Tech Tool.

7	 On Tech Tool’s Emitter Grouping tab, use the Select a Hub dropdown to select the hub/KNet 
that hosts the N3 Satellite. 

continued on next page
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8	 In the Select By dropdown, pick the N3 Satellite’s group (i.e., the first group in which fixtures 
appear). The checkboxes represent emitters connected to the N3. 

fig. 53

All emitters checked 
because they all belong 
to “Bedroom 1” group

7

8

9	 Remove any emitters that shouldn’t be in the group. You can either do this by unchecking each 
emitter’s box or by using the dropdowns as shortcuts. 
 
If using the dropdowns:

–– The dropdowns called out in fig. 54 (next page) (Start, End, and the unlabeled ones that 
default to Add and Evens) let you tell Tech Tool which boxes you want to uncheck. Once you 
click Apply, it will automatically uncheck those boxes for you. No changes will be made to 
the devices themselves until you click Publish and Save.

–– Before clicking Apply, you must check the box to the left of the N3 Satellite’s name or  
serial number.

–– Use the Add/Remove dropdown to determine whether you want to check or uncheck boxes.

–– Use the Start and End dropdowns to set a fixture range whose boxes you want to check or 
uncheck. This range is inclusive (e.g., to include first 10 fixtures, set Start to 1 and End to 10). 

–– Use the Evens/Odds/Entire Run/etc. dropdown to determine which boxes you want to check 
or uncheck within that range. 

–– Example: Uncheck (remove) all even-numbered emitters in fixtures 5-8.

–– Click Apply to check or uncheck the boxes.

continued on next page
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10	 Repeat steps 8-9, selecting the next group in the chain and adding emitters rather  
than removing. 

Note: Be sure you are selecting the correct group. Once you place the emitters in the group 
and return to Design Studio, you will not be able to cut/copy/paste the subdivided run into a 
different group; you will have to return to Tech Tool to make changes.

Clicking Apply will deselect all checkboxes from fixture 12 to fixture 40.

fig. 54

Use dropdowns to streamline 
selecting/deselecting 
checkboxes

Must check 
N3’s box before 
clicking Apply

fig. 55

Select second 
group in chain

Must check 
N3’s box before 
clicking Apply

Change “Remove“ 
to “Add”

Add fixtures 12-22 to Bedroom 2

continued on next page
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Caution: Be careful to ensure that every emitter is sorted into a group, and that no emitter 
is sorted into two groups.

11	 After dividing the entire run into groups, click Publish and Save in Tech Tool. This adds the 
emitters (or fixtures) you selected to the group you selected. 

Caution: Clicking View Group as Published will turn the group green but also turn all other 
groups in the installation red. 

Your emitters should now be sorted into their new groups, as shown in fig. 56. (In Design Studio, they 
will all be listed using the N3 Satellite’s serial number or name.) 

fig. 56

Note: You cannot cut/copy/paste the subdivided sections of the run(s). To move emitter-
grouped linear fixtures between groups, you will need to return to Tech Tool and change their 
grouping using the same Emitter Grouping tool you just used.
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Using the Color Picker

The color picker (fig. 57) enables you to control the color and 
intensity settings of Ketra lights, as well as controlling parameters of 
any third-party outputs in scenes. It is accessible from any of the tabs 
in Device Control and an essential part of your Design Studio toolkit. 

fig. 57

Manual control, white 
and pastel tab

Third party outputs tab

Manual control, full 
gamut tab

Content library tab User presets tab

continued on next page
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Using the color picker, you can:

•	 Emulate classic lighting styles and dimming curves. For easy lighting customization, select 
from popular presets in the Content Library tab. Presets include natural and colored light, warm 
dimming curves, and common light styles like incandescents. See Content Library, page 56.

•	 Control advanced color parameters of your light. For advanced customization, use the  
Manual Control tab of the color picker. There you can select your own color from a color 
diagram, set RGB values, and specify settings for hue, vibrancy, and other parameters. See 
Manual Control, page 55.

•	 Save your own presets for later use across installations. See User Presets, page 57. 

•	 Customize settings for third-party outputs in a scene. If a group contains any third-party 
outputs wired to an N3 Satellite or X2 Dimmer, use the 3rd Party Outputs tab to control output 
voltage, contact-closure state, and numerous DMX parameters. See 3rd Party Outputs, page 57. 

Note: The 3rd Party Outputs tab is available for scene-building, but you cannot assign default 
states to third-party devices, so the tab is grayed out on the Lamps tab.

Intensity Slider

At the top of the color picker, a sliding scale controls intensity. 

fig. 58

Note: While you cannot adjust the intensity to 0%, you can press the On/Off button to the 
right of the slider to determine whether the lights are on or off. 

Ketra’s intensity slider uses an exponential model rather than linear. When the slider is at 90%, your 
lights will be at approximately 50%. See graph in fig. 59.

fig. 59
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Manual Control

In Manual Control, Design Studio presents a CIE 1931 color diagram from which you can select color 
coordinates. Having the ability to control color as well as intensity (using the intensity slider) gives 
you 3-dimensional control over your lighting’s color space. 

White and Pastel

The White and Pastel tab, shown in fig. 60, lets you pick from the softer hues at the heart of a 
chromaticity diagram, which all Ketra lights can match with guaranteed accuracy. The curve at the 
center is the black body locus, representing the changing color of a theoretical black body radiator 
as its temperature increases in units of Kelvin. 

In White and Pastel, you can:

1	 Freely set specific color coordinates within a subset 
of Ketra’s available coordinates (all accessible in 
the Full Gamut tab). In order to match warm colors 
below 1700K, Design Studio may scale down your 
light’s intensity.

2	 Enter exact x, y chromaticity coordinates.

3	 Add user presets to save coordinates and settings.

4	 Adjust the CCT (Correlated Color Temperature, the 
temperature corresponding to a given point along 
the locus) via a sliding scale that follows the shape 
of the locus, or select from preset CCTs.

5	 Adjust your light’s tint via a sliding scale that 
follows the isotherms for a given CCT.

6	 Adjust your light’s vibrancy via a sliding scale. 

7	 Select from a list of common CCTs.

Note: When vibrancy is closer to 100%, illuminated objects can appear more vibrant. To 
understand vibrancy, be aware that every Ketra emitter has 4 LEDs: red, blue, green, and 
white. When you adjust the vibrancy of your light, you change the ratio of RGB to W output: 
at closer to 100%, output is generated more by the RGB LEDs; at closer to 0%, it is generated 
more by the W LED. In either case, the color points and intensity are the same, while the SPD 
output and CRI change. 

fig. 60
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Full Gamut

The Full Gamut tab, shown in fig. 61,  lets you select from Ketra’s extended gamut of color coordinates.

In this section, you can:

1	 Freely set color coordinates across a full 
chromaticity diagram as well as the whites and 
pastels near the black body locus.

2	 Enter exact x, y chromaticity coordinates.

3	 Add user presets to save settings.

4	 Adjust the hue, saturation, and red-blue-green 
composition of your light via sliding scales.

fig. 61
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Note: For coordinates outside of the dashed triangle, and especially on the outer edges of the 
full gamut, you may notice some very slight variation in the color of your lights.

Content Library

fig. 62

The Content Library displays categories of presets that 
Ketra has saved, as well as warm dimming curve options 
for your lights.

Note: For circadian lighting that changes over time, 
do not use the collection called “Generic Circadian 
Settings.” Instead, use a natural show, which is a 
collection of triggers set to offsets from sunrise 
and sunset. Design Studio comes with a default 
natural show. In a Ketra Only installation, this 
default natural show is automatically assigned to 
keypads that have a button labeled “Natural”; in a 
Ketra with HomeWorks QS installation, the natural 
show will be one of the presets you import into 
HomeWorks QS. 

continued on next page
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As shown in fig. 63, hovering over a preset will give you 3 icons:

1	 Bookmark a setting. Bookmarking saves the setting to your library of user presets. You will be 
able to access the preset quickly in this installation or any others tied to your account. (For more 
on user presets, see User Presets, below.)

2	 Play a setting on your lights. This makes the group preview the setting. 

Note: Static configurations, such as light colors, that you select in the Content Library will be 
visible on your lights immediately upon selection. However, warm dimming curves—i.e. the 
options in the “Dimming Curves” folder at the end of the list—will not be visible on your lights 
until after you have clicked Publish and Save. 

3	 Read information about a setting. Each Ketra-curated preset has some brief text on the 
setting’s potential uses or significance.

fig. 63

1 2 3

User Presets

The User Presets tab itemizes all the preset configurations you have stored. Your presets are 
accessible across installations in your account.

Presets can be stored for any lighting configurations you’ve designed; just select Add Preset under 
the chromaticity diagram in Manual Control, or click the bookmark icon you see by hovering over 
any Ketra preset in the Content Library. 

3rd Party Outputs

Note: Not available in Ketra with HomeWorks QS installations. 

In a Ketra Only installation, the 3rd Party Outputs tab is available after you have configured an 
N3 Satellite for analog or DMX output. On this tab, you can adjust the voltage output of a 0-10V 
output, switch the output state of a sustained contact closure, or adjust output configurations for a 
DMX master. 

continued on next page
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Even though third-party outputs are often in the same groups as Ketra lights, they can have entirely 
different settings in a given scene. 

You cannot use Design Studio to assign default states to third-party lighting, so the 3rd Party 
Outputs tab is grayed out on the Lamps tab.

fig. 64
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Managing Lighting 
Power-Restore States

Each Ketra light has a restore state setting. A state is any 
configuration for color and intensity (e.g., 3000K at 100% intensity), 
and a restore state is the state that lights come on to when power-
cycled. In residential and hospitality applications, we recommend 
modifying a small number of lights’ restore states per the guidelines 
in this section.

What counts as a power cycle?  
A power cycle is anything that reboots a Ketra light’s onboard 
computer. This includes Ketra firmware updates and events that cut 
power to the circuit for more than 2 seconds. It does NOT include Off 

Contents

Restore States in Ketra with 
HomeWorks QS Installations 60

Restore States in Ketra  
Only Installations  	     63

Modifying the Default 
Restore State		      66

Viewing a Light’s Current 
Restore State		      67

commands from keypads or contact-closure inputs, as these do not cut power to the lights’ circuit. 

The restore state can be a color and intensity chosen in Design Studio, or it can be whatever the 
light’s most recent state was prior to being power-cycled. 

continued on next page

fig. 65

Lights can restore to a 
preconfigured default

Lights can restore to their 
most recent state

or

•	 We strongly recommend that all Ketra with HomeWorks QS installations include some of both. 
For details, see Restore States in Ketra with HomeWorks QS Installations, page 60.

•	 We recommend that residential or hospitality Ketra Only installations include some of both. For 
details, see Restore States in Ketra Only Installations, page 63.

Note: In Ketra Only installations, the default restore state is 3000K, 100% intensity. To change 
this default restore state, see Modifying the Default Restore State, page 66.
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Restore States in Ketra with HomeWorks QS Installations

In Ketra with HomeWorks QS installations, the default restore state is whatever the light’s state was 
prior to being power-cycled. This comes with pros and cons.

•	 Pro: If power is restored after an outage at night, bedroom lights will stay off rather than coming 
on at full intensity.

•	 Pro: In vacation homes, lights will stay off after an outage rather than coming on at full intensity 
(otherwise they could stay on for weeks until the space were occupied again).

•	 Con: If the N4s lose connection to the LAN (Local Area Network) while the lights are off, the 
homeowner will not be able to turn the lights on until the network is restored. (This scenario is 
unlikely but still possible due to third-party Ethernet switch failure or N4 failure.)

To avoid that con scenario, we strongly recommend designating some “safety” lights. Configure these 
safety lights to restore to a predefined color and intensity, and provide the user with an accessible 
means of power-cycling the lights (e.g., a regular toggle switch or a clearly-labeled breaker). This 
enables the user to force the safety lights on.

Caution: Explain to the user that they can power-cycle the lights once to turn them on, 
but recommend that they leave the safety lights on until network is restored. Lights are 
sometimes wired to the same circuit as other devices that should not be turned off. 

1	 Designate safety lights. These are the lights to which you will assign default restore states. 

–– DO give default restore states to any lights in stairways or points of egress.

–– Do NOT give default restore states to any lights in sleeping areas. If you do, the lights could 
come on in the middle of the night following a power outage.

–– We recommend giving a default restore state to one or two lights in every room (except 
sleeping areas), but this can be left to the homeowner’s discretion.

Note: In a vacation home or other space that will be unoccupied for long periods, we 
recommend following the steps below for the safety lights, then using HomeWorks QS to 
add a timeclock activated with vacation mode. That way, if there is a power outage while the 
homeowner is away, the HomeWorks QS system will turn off the safety lights soon after they 
come back on. 

continued on next page
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2	 Add the safety lights to a group. 

i	 On Design Studio’s Organization tab, add a custom group to the highest level of  
the hierarchy.

ii	 Rename the group something like "Safety Lights".

iii	 Copy the lights into the group. Be sure to use Copy (Ctrl+C), not Cut.

The Safety Lights group has one light each from Kitchen 
and Dining Room, but no lights from Bedroom

fig. 67

3	 Disable restoring to most recent state. 

i	 Go to Design Studio’s Device Settings tab.

ii	 If necessary, set the Settings For dropdown to “Lamps”.

iii	 Set the Device Filter to the “Safety Lights” group. By default, every light should say Enabled  
in the Restore Last State on Power Cycle column. 

iv	 Check the Select All box to highlight all devices in the group.

v	 In the Modify Lamp Settings panel, set the Restore Last State on Power Cycle dropdown  
to "Disabled".

vi	 Click Apply To Selected.
i

ii iii

iv

v vifig. 68

continued on next page
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4	 Preview the installation space with only the safety lights (Recommended). This should  
be done room-by-room. Check each room to ensure that the safety lights are giving  
adequate illumination. 

i	 Go to Device Control > Lamps.

ii	 Select the room group in the My Lamp Groups panel.

iii	 In the color picker panel on the right, click the Power button to the right of the intensity 
slider. This should turn off the room.

iv	 Select the “Safety Lights” group.

v	 Click the power button twice. This should turn on the safety lights that are in the room.

If the safety lights are not providing adequate illumination, add more safety lights to the group and 
disable restoring to their most recent state.

You can turn the room’s lights back on with the same button you used to turn them off. 

fig. 69

Turn the room group off

Turn the safety 
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5	 Optional: Modify the default restore state. The factory-default restore state for lights is 3000K 
(warm white), 100% intensity. You can change the color and intensity of the safety lights’ restore 
state as needed. For details, see Modifying the Default Restore State, page 66. 
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Restore States in Ketra Only Installations

In Ketra Only installations, the default restore state is 3000K, 100% intensity. You can either 
configure lights to restore to their most recent state prior to power-cycling, or modify their default 
restore state (i.e., set a different color and intensity for them to always come on to). For modifying 
the default restore state, see page 66.

For most commercial applications, we recommend leaving lights at the factory-default restore 
state of 3000K, 100% intensity. 

An exception is hospitality applications, where we recommend the following:

•	 In sleeping areas, all lights should be set to restore to their most recent states.  
This ensures that if the occupant is asleep when a power outage occurs, the lights will not come 
back on when power is restored.

•	 In dining areas, most lights should be set to restore to their most recent states.  
This ensures that a space’s atmosphere will not abruptly change if power is cut and restored 
during business hours.

•	 A handful of “safety” lights in dining areas should keep the default restore state.  
You could leave this at the default 3000K, 100% intensity, or you could set a new default restore 
state. This accounts for a situation where the network goes down for any reason while the lights 
are off. In that situation, the user might lose control of their lights until the network is restored. 
The only way to turn on your lights until then would be to power-cycle them and have the 
selected lights come on to their default restore states.  

•	 All other lights can be left to the default restore state of 3000K, 100% intensity. 
It is especially important that emergency lighting be left to restore to a default state rather than 
its most recent state. 

Caution: Do not enable restoring to most recent state for any emergency lighting. 

To set those configurations, follow these steps.

1	 Configure dining areas.

i	 Decide which lights will serve as “safety” lights. These lights will keep a default restore state 
so that the user can hard-reset the lights if necessary to ensure adequate lighting during a 
network failure.

ii	 In Design Studio’s Organization tab, add a custom group to the highest level of the 
grouping hierarchy. 

iii	 Rename the new group something like “Dining Safety Lights”.

iv	 Copy/paste each dining area’s lights into the safety group. Be sure to use Copy (Ctrl+C), not 
Cut. You want the safety lights to be in their original group as well as the safety group. See 
fig. 70, next page.

continued on next page
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v	 Go to the Device Settings tab.

vi	 If necessary, set the Settings For dropdown to “Lamps”.

vii	 Set the Device Filter to the “Dining Safety Lights” group.

viii	 Check the Select All box.

ix	 In the Modify Lamp Settings panel, set the Restore Last State on Power Cycle dropdown to 
"Enabled".

x	 Click Apply To Selected.

fig. 70

The Dining Safety Lights group has one light from each dining space

fig. 71
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2	 Preview dining areas with only the safety lights (Recommended). This should be done room-by-
room. Check each dining area to ensure that the safety lights are giving adequate illumination. 

i	 Go to Device Control > Lamps.

ii	 Select a dining area group in the My Lamp Groups panel.

iii	 In the color picker panel on the right, click the Power button to the right of the intensity 
slider. If there are multiple dining area groups in the same room, turn those ones off as well.

iv	 Select the “Dining Safety Lights” group.

v	 Click the power button two times. This should turn on the safety group.

If the safety lights are not providing adequate illumination, add more safety lights to the group and 
disable default restore on them.

You can turn the room’s lights back on with the same button you used to turn them off. 

fig. 72
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3	 Configure sleeping areas

i	 Go to Design Studio’s Device Settings tab.

ii	 Set the Device Filter to a sleeping area group.

iii	 Check the Select All box.

iv	 In the Modify Lamp Settings panel, set the Restore Last State on Power Cycle dropdown  
to "Enabled".

v	 Click Apply To Selected.

vi	 Repeat steps ii-v for additional sleeping area groups as needed.

continued on next page



DESIGN STUDIO 3.066

DESIGN STUDIO 3.0 
COMMISSIONING AN INSTALLATION

4	 Optional: Modify the default restore state. For any lights that will restore to a default rather 
than restoring to their last state, you can modify the default. (This has to be done by the group 
rather than by the individual light.) If you do not modify the default, the lights will restore to 
3000K (warm white), 100% intensity. 
 
For details on modifying the default restore state, see below.

Modifying the Default Restore State

Note: In Ketra with HomeWorks QS installations, lights will restore by default to their most 
recent state prior to power cycling. To disable this feature so that lights restore to a single 
default, see Restore States in Ketra with HomeWorks QS Installations, page 60.

The factory-default restore state is 3000K (warm white), 100% intensity. Design Studio enables you 
to modify this default restore state—i.e., set a different color and intensity—for groups of Ketra 
lights. (You cannot set a default restore state for non-Ketra lights using Design Studio.)

To do so, follow these steps: 

1	 Go to Device Control > Lamps.

2	 Select a group from the My Lamp Groups list on the left.

3	 Use the color picker panel to set a new color and/or intensity. For instructions, see Using the 
Color Picker, page 53.

4	 At center screen, click the Set Group Default Content button. 

5	 Click Publish and Save in the top-right.

fig. 73
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Viewing a Light’s Current Restore State

1	 Check whether the light is set to restore to its last state or a default.

i	 Go to the Device Settings tab.

ii	 If necessary, set the Settings For dropdown to "Lamps".

iii	 Find the light’s serial number or name in the Devices list. 

iv	 Check whether the value in the Restore Last State On Power Cycle column is "Enabled"  
or "Disabled". 

If the value is "Enabled", the light will return to its most recent state when power-cycled. 

If the value is "Disabled", the light will return to a default restore state.

2	 If the light is set to restore to a default, view the default on the Lamps tab.

i	 Go to Device Control > Lamps.

ii	 Select the light’s group in the My Lamp Groups panel.

The default restore state’s color is visible at center screen, under Default Lamp Color Setting.  
The default intensity is visible on the slider at the top of the color picker panel on the right.
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Building Scenes
As discussed in Key Concepts > Scenes, page 9, a scene is a set of 
lighting configurations that applies to an installation’s groups. These 
configurations may include color, intensity, and other parameters.

Scenes may be assigned to several kinds of triggers, including keypad 
buttons, contact closure inputs, and time triggers in shows. Since 
there are multiple potential uses for scenes, they can be built on four 
out of the five tabs of Device Control. As a general rule, however, we 
recommend building them on the Scenes tab. 

Contents

Ketra’s Pre-Curated Scenes    69

Ways to Build Scenes	     69

Key Features of  
Scene Building		      71

Tree View		      71

Template View		      73

Template View Example	     75

Note: Scenes that you build on the Shows or Integration tab will not be accessible from 
other locations. For example, if you build a scene on the Shows tab for a 5:00 PM trigger, you 
cannot then assign that scene to a keypad button. However, if you build the scene on the 
Scenes tab or Keypads tab, you will be able to use it elsewhere in the installation.

fig. 74

Energize, a 
typical scene

We recommend building 
scenes on the Scenes tab
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Ketra’s Pre-Curated Scenes

Design Studio curates content so that you never need to build a custom scene unless the 
installation calls for it. You can see our pre-made scenes in the Scenes tab, listed in the My Scenes 
panel. These scenes are ready to be assigned to a keypad button, contact closure input, or time 
trigger in a show. 

When you provision a keypad to a Ketra Only installation, each button’s name determines what 
default scene it gets (e.g., a button labeled Media would get the Media scene). You can always assign 
a different scene or show to the button by selecting the button in the Keypads tab and clicking 
Clear Scene or Clear Show.

For most commercial applications, mapping these default scenes to Ketra keypads is sufficient 
to meet installation requirements, saving programmers significant amounts of time. Many 
homeowners, however, will ask for custom scenes. 

Ketra’s pre-curated scenes differ in the color and intensity that they set for groups in the 
installation. Typically, each scene treats "Task" and "Accent" groups differently from other groups.

Ways to Build Scenes

You can create or modify scenes from multiple places in the software. We always recommend 
building scenes on the Scenes tab and then assigning them on the Keypads, Integration, and/or 
Shows tabs, but you could build them there as well. 

To access Design Studio’s scene-building functionality from each tab, consult the images below.

•	 The Scenes tab

continued on next page

fig. 75
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•	 The Keypads tab: Click the green Edit button to open the Ketra Scene Builder window

•	 The Integration tab: Click the green Edit button to open the Ketra Scene Builder window

Note: Scenes you create on the Integration tab for analog inputs can be reused on the 
Integration tab by inputs. However, they will not appear on other tabs. 

fig. 76

fig. 77

continued on next page
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•	 The Shows tab: Click the green Edit button to open the Ketra Scene Builder window

Note: Scenes you create on the Shows tab for time triggers can be reused on the Shows tab 
by other time triggers. However, they will not appear on other tabs.

Key Features of Scene Building

Users can build scenes using two methods: Tree View and Template View. Different use cases call for 
one method or the other. 

Note: Tree View is the default method; users can access Template View by clicking Swap to 
Template View. 

Tree View

Tree View replicates the grouping hierarchy, or tree, from the Organization tab. It is ideal for 
building scenes that apply the same content to entire branches of the tree—i.e., to groups  
and subgroups. 

An effective use of Tree View might look like the curated Daytime scene. This scene has one color 
setting that applies to all groups. Since its content applies globally, whichever keypad it is assigned 
to will play that setting on its groups and subgroups.

fig. 78

continued on next page
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To create and configure a scene using tree view, follow these steps:

1	 Navigate to Device Control > Scenes.

2	 Click the Create New Scene button.

3	 Set the highest-level group in the installation to the desired color and intensity setting. This 
causes everything lower in the hierarchy to change as well. 

Note: When you assign the scene to the keypad, it will only play on the subset of the 
grouping hierarchy that the keypad has access to.

fig. 79

An ideal use of Tree View

fig. 80

continued on next page
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Note: NA can be toggled on or off by clicking the X button. NA groups do not change content 
when the scene is triggered. However, they do respond to brightness controls when the scene 
is active and turn off when the scene is deactivated. To truly exclude a group from a scene 
such that it does not respond in any way to a trigger, you need to uncheck the group when 
assigning the scene. 

4	 Optional: Make adjustments as needed to the lower levels in the hierarchy.

Groups lower in the hierarchy can be changed as needed

fig. 81

Template View

Template View lets the user vary content based on groups’ descriptors. It is ideal for building scenes 
that apply distinct color settings at different points in the hierarchy. 

An effective use of Template View might look like the curated Candlelight scene. All the "Task" 
groups have one kind of content, all the "Accent" groups have another kind, and everything else has 
a third kind. 

Note: The following image shows Candlelight in Tree View so you can easily see how the 
scene applies to the installation’s groups. 

continued on next page
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In Tree View, executing the Candlelight scene would require individual editing of every Task or 
Accent group. In Template View, it only requires three lines:

fig. 82

fig. 83

Groups tagged “residential”: 
1600K, 5% intensity

Groups tagged “task”  
and “residential”: 2200K, 
70% intensity (Overrides  
first line)

Groups tagged “accent”  
and “residential”: 2200K, 
30% intensity (Overrides  
first line)
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Template View Example

Let’s build a custom scene that can apply special content to any corner offices in an office building. 
Since corner offices have more natural light, imagine an energy code requires distinct content for 
them versus other offices.

Using Tree View would be inefficient: when building the scene, we would need to modify every 
corner office’s zones, one at a time. Using Template View will save time, because we can simply 
assign a shared descriptor to every corner office and set content for the descriptor.

We’ll start with this simple grouping structure already built on the Organization tab:

fig. 84

There are two corner offices and two regular offices. Each office has three zones: General, Task, and 
Accent. To create a scene that affects any corner office, follow these steps:

1	 On the Organization tab, set a “corner office” descriptor for each corner office. To add 
descriptors, select the group and enter the descriptor name into the bottom-right text field.

continued on next page

fig. 85



DESIGN STUDIO 3.076

DESIGN STUDIO 3.0 
COMMISSIONING AN INSTALLATION

2	 In Device Control > Scenes, click the Create New Scene button.

3	 Rename the scene something like Corner Offices.

4	 Click the Swap to Template View button. 

5	 Click the + button three times—once for each corner office zone. Since our corner offices have 
three zones—General, Task, and Accent—we’ll add three lines.

6	 For each line, add the zone’s descriptor and the “corner office” descriptor. You should press 
Enter after each value rather than using comma-separated values.  
 
In our example, the first line will target any groups with both the “task” and “corner office” 
descriptors. This way, no other groups that have the “task” descriptor will be affected.

Note: Groups inherit descriptors from higher-level groups. 

7	 Customize each line’s color content. Note that you can toggle NA on or off for each line by 
clicking the X button. A group marked NA will not be affected when the scene is triggered. 

Note: NA can be toggled on or off by clicking the X button. NA groups do not change content 
when the scene is triggered. However, they do respond to brightness controls when the scene 
is active and turn off when the scene is deactivated. To truly exclude a group from a scene 
such that it does not respond in any way to a trigger, you need to uncheck the group when 
assigning the scene.

fig. 86
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8	 Return to Tree View to confirm your settings. In our example, the corner offices now have 
special content for each of their zones. When we assign the scene to each corner office’s keypad, 
only the given office’s zones will be affected.

fig. 88

fig. 87 5
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Building Shows
Shows enable you to link changes in your lighting to certain times 
of day. A show consists of at least one time trigger, i.e., a trigger set 
to occur at a given time whenever the show is active. 

Example applications:

•	 Circadian lighting that smoothly brightens and dims over the 
course of the day to mimic sunlight (see Creating a Natural 
Show, page 81, or use Ketra’s curated Natural show)

•	 Automating opening and closing times by turning lights on at 9 
AM and off at 11 PM (see Automated Open/Close Time, page 97)

•	 Meeting Title 24’s Auto-Off Timeclock requirement (see Auto-
Off Timeclock, page 95)

•	 A looping holiday show that turns a group of lights red for one 
minute, then green for 1 minute (see Looping Triggers, page 86)

You can create and configure shows on the Shows tab of Device 
Control. You can then implement your shows in several ways:

•	 Set them to run automatically: Shows can run automatically 
365 days a year, or only on certain days of the week, or only 
within a certain date range.

•	 Assign them to Ketra keypad buttons or contact-closure inputs: 
In a Ketra Only installation, shows can be linked to inputs in the 
installation. A user could press a keypad button to activate the 
show, or an external device could play the show via a contact-
closure integration with an N3 Satellite. 

•	 Use them in Lutron’s HomeWorks QS software: After building 
shows in Design Studio, you will be able to import the 
installation to HomeWorks QS and access the shows from there.

Contents

The Shows Tab		      79

Creating a Show		     80

Importing a Show	     80

Creating a Natural Show	     81

Creating a Custom Show	     83
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What you can do on the Shows tab of Device Control:

•	 See your existing shows

•	 Create new shows

•	 Customize shows’ triggers and scene content

•	 Set shows to run automatically (without needing to be activated by a user or contact closure)

What you cannot do on the Shows tab:

•	 Assign a show to a keypad button (Use the Keypads tab after building the show)

•	 Assign a show to a contact-closure input (Use the Integration tab after building the show)

The Shows Tab

fig. 89
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Creating a Show

Importing a Show

You can import Ketra shows that come packaged with Design Studio for your convenience, or shows 
that you have exported previously. To import a show, follow these steps:

1	 Click Import Show. Clicking this button, found at the bottom of the My Shows panel, will open a 
setup wizard.

2	 Select the show file you would like to import. Click Choose File to select the file from a list. This 
will direct you to a folder in which there are a number of shows curated by Ketra—including 
Fixed Time and circadian (Astronomical) shows—along with any you’ve exported in the past.

3	 Name your show. You can use the same name as before or give it a new one.

4	 Select groups to assign the show to. 

Note: The show will apply content to whichever groups you select, as well as all subgroups. 

–– If you intend to assign the show to a keypad button or analog input trigger, we recommend 
selecting the highest-level group. As discussed in Global Scenes, Local Applications, page 
10, a scene or show that applies content to all groups will not necessarily affect all groups; 
once you assign the scene or show, it can only affect whichever groups the keypad or input 
trigger controls. 

–– If you intend to set the show to run automatically, we recommend using this opportunity to 
select the groups you want the show to affect. Any group that you do not select here will be 
assigned NA in all of the show’s scenes. This effectively excludes the unselected groups from 
the show. 

continued on next page
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5	 Click Import Show.  

6	 Optional: Rename the show by clicking the pencil icon next to its name in the My Shows panel.

Required Next Step:

•	 Implement the show by setting it to run automatically or assigning it to an input trigger (See 
Implementing Shows in an Installation, page 89)

Optional Next Steps:

•	 Add or modify time triggers (See Setting Time Triggers, page 84)

•	 Add or modify scenes for the show’s triggers (See Setting Scenes for Time Triggers, page 87)

•	 Limit sunrise and sunset trigger times for installations at high latitudes (north or south) (See 
Limiting Astronomical Triggers, page 92)

•	 Set override permissions for the show (See Enabling Show Control by DMX or Analog Input, 
page 93, and/or Enabling Show Override, page 94)

•	 Export the show for use in other installations (See Exporting a Show, page 95)

Creating a Natural Show

Note: Ketra curates a default show called Natural, which can be found in the My Shows list. 
This show is automatically assigned to any keypad buttons with the "Natural" label. If you 
prefer a different natural show, you can either create your own using the steps below, or 
modify the existing show by selecting "Natural" in the My Shows list and making changes. 

To create a natural show, follow these steps:

1	 Click Create Natural Show. Clicking this button, found at the bottom of the My Shows panel 
on the left, will open a small dialogue box with basic configuration options. You can change 
any configurations you set here later on, by using the corresponding controls in the show’s 
configuration page. 

2	 Optional: Modify the minimum and maximum CCT and intensity. You can think of these  
two sets of values as being the poles between which your lighting will transition at sunrise  
and sunset. 

–– The minimum (nighttime) values correspond to triggers just before sunrise and just after 
sunset. Example: If sunrise occurs at 6 AM and sunset at 6 PM, then by default, your lights 
will be set to the minimum CCT and intensity from 6:30 PM to 5:35 AM. 

–– The maximum (daytime) values correspond to triggers just after sunrise and just before 
sunset. Example: If sunrise occurs at 6 AM and sunset at 6 PM, then by default, your lights 
will be set to the maximum CCT and intensity from 6:30 AM to 5:30 PM.

continued on next page
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3	 Optional: Modify the morning and evening transition start times. Use this feature to determine 
the times at which the “sunrise” and “sunset” transitions will begin. Each transition is a series of 
triggers lasting about 1 hour, gradually increasing or falling in CCT and intensity. These triggers 
make your lighting emulate sunrise and sunset.

–– Astronomical: The transition will begin at a certain offset from sunrise or sunset. The default 
offset is 30 minutes. You can change the offset by clicking the blue Show Advanced Options 
link, then modifying the Offset dropdown. Example: If you set Sunrise Offset to -1:00, then the 
first trigger in the show would occur 1 hour before sunrise.

–– Fixed Time: The transition will begin at the same time of day, every day. Example: If you set  
the Morning Transition Start Time to 7:00 AM, then the first trigger in the show would occur  
at 7:00 AM, regardless of the real time of sunrise that day.

4	 Optional: Set an incandescent CCT threshold. Click Show Advanced Options to reveal this option. 
Use a CCT threshold for shows that incorporate incandescent loads via analog outputs. Set the 
threshold value to the CCT of the incandescents.  
 
When the Ketra lights in a group are above the threshold CCT, the incandescents will turn off, 
ensuring no mismatch in color temperatures. When the Ketra lights in a group cross below the 
threshold, the incandescents will turn on. If they are integrated via 0-10V output, they will then 
dim as the Ketra lights go to lower CCTs.

5	 Name your show. 

6	 Pick groups to apply the natural show to. Select one or multiple from the list of all your groups.

Note: Any group that you do not select from this list will be assigned NA for every scene in the 
show. It is very important to note that this does not necessarily exclude the group from the 
show. If you intend for the show to run automatically without needing to be triggered from a 
keypad button, then NA is sufficient to exclude the group from the show. However, if you intend 
to assign the show to an input trigger like a keypad button, you must deselect the groups you 
want to exclude when assigning the show. See Excluding Groups from Shows, page 88. 

continued on next page
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7	 Click Build Natural Show. 

8	 Rename the show by clicking the pencil icon next to its name in the My Shows panel.

You now have a natural show with pre-built time triggers and scenes. When running, the show  
will follow this sequence: 

i	 At the Morning Transition Start Time, the show will begin at the Nighttime CCT and 
Nighttime Intensity. 

ii	 Over the next hour, your lighting will smoothly transition to the Daytime CCT and  
Daytime Intensity.

iii	 Your lighting will maintain the daytime CCT and intensity until the Evening Transition Start 
Time. (In the interim, other inputs—e.g., keypad buttons—can change the lighting state 
freely, triggering scenes, turning off power, and/or adjusting intensity and other parameters.)

iv	 For an hour following the Evening Transition Start Time, your lighting will smoothly 
transition to the Nighttime CCT and Nighttime Intensity. 

v	 Your lighting will maintain the nighttime CCT and intensity until the Morning Transition 
Start Time. (In the interim, other inputs—e.g., keypad buttons—can change the lighting state 
freely, triggering scenes, turning off power, and/or adjusting intensity and other parameters.)

Required Next Step

•	 Implement the show by setting it to run automatically or assigning it to an input trigger (See 
Implementing Shows in an Installation, page 89)

Optional Next Steps

•	 Add or modify astronomical triggers (See Astronomical Triggers, page 85)

•	 Add or modify scenes for the show’s triggers (See Setting Scenes for Time Triggers, page 87)

•	 Limit sunrise and sunset trigger times for installations at high latitudes (north or south) (See 
Limiting Astronomical Triggers, page 92)

•	 Set override permissions for the show (See Enabling Show Control by DMX or Analog Input, 
page 93, and/or Enabling Show Override, page 94)

•	 Export the show for use in other installations (See Exporting a Show, page 95)

Creating a Custom Show

To create a custom show, click Create Show at the bottom of the My Shows panel on the left. By 
default, the show will have no content, giving you full rein to customize it however you want. 

Required Next Steps

•	 Create fixed-time, astronomical, or looping time triggers (See Setting Time Triggers, page 84)

continued on next page



DESIGN STUDIO 3.084

DESIGN STUDIO 3.0 
COMMISSIONING AN INSTALLATION

•	 Assign a scene to each time trigger (See Setting Scenes for Time Triggers, page 87)

•	 Determine how and when the show should run:

–– Set the show to run automatically (See Enabling a Show to Run Automatically, page 89)

–– Assign the show to a keypad button or contact-closure input (See Enabling a Show to Run 
When Triggered, page 91)

–– Disable the show for later use (See Disabling a Show for Later Use, page 92)

Optional Next Steps

•	 If using astronomical triggers, limit sunrise and sunset trigger times for installations at high 
latitudes (north or south) (See Limiting Astronomical Triggers, page 92)

•	 Set override permissions for the show (See Enabling Show Control by DMX or Analog Input, 
page 93, and/or Enabling Show Override, page 94)

•	 Export the show for use in other installations (See Exporting a Show, page 95)

Setting Time Triggers

In a show, a trigger is a time at which a change in lighting takes place. The triggers for any show 
can be found in the triggers list, near center screen. You can use the same pane to add, remove, and 
modify triggers.

There are three types of time trigger, and your show will function differently depending on which 
type you pick. 

fig. 92
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Fixed Time Triggers

These take effect at specific times of day. Example: At 2 PM, a new scene plays; at 3 PM, another 
scene plays. 

On the Time subtab of the triggers list, use the + button to add triggers. Remove triggers by 
highlighting one and clicking -. 

You can change the time of a trigger using the dropdown, the increment/decrement buttons (^ and 

�), or by clicking on the time and typing a new one. 

fig. 93

fig. 94

Astronomical Triggers

These take effect at times that are relative to sunrise and sunset. Example: Starting an hour before 
sunrise and lasting until an hour after sunrise, lighting gradually brightens to mimic sunlight. 

Note: Times of sunrise and sunset are determined daily, based on the installation’s location. 
This enables your lighting to stay in sync with natural light year-round.

On the Astronomical subtab of the triggers list, use the + button to add times; remove times by 
highlighting one and clicking -.

In this image, the show will trigger changes at sunrise and at four hours after sunrise, then again at 
four hours before sunset and at sunset.

continued on next page
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Note: For accelerated creation of a show with astronomical triggers, click Create Natural 
Show at the bottom of the My Shows list.

Looping Triggers

These take effect in a looping sequence. Example: Every 2 minutes, a new scene plays; after 6 
minutes (i.e., 3 scenes), the sequence repeats.

For a step-by-step example of how loops work, see 6-Minute Looping Show, page 100, in the 
Tutorials section. For an overview, continue reading this section.

Note: Design Studio does not support configuring loops to start from the beginning when 
triggered by a keypad button or contact closure. Looping goes on in the background at all 
times, even when the show is not active, so keypads and contact closures can only start the 
loop at whatever scene is currently active. 

On the Loops subtab of the triggers list, use the + button to add triggers. Remove triggers by 
highlighting one and clicking the minus button, -. 

Loops repeat after an amount of time provided by you. Each loop consists of multiple triggers. You 
will add individual triggers, and then determine how they fit together in a loop.

Note: The runtime must be a factor of 60 minutes. For example, your runtime can be 6 
minutes, but not 7. It also cannot be less than 1 minute. 

fig. 95

When you first add a trigger in a loop, it is considered undefined. To define a trigger, select it and 
click the Timer button to open the small configuration dialogue box. Each trigger needs to know 
the runtime of the loop it’s in (Loop every), how long to wait before starting (Start offset), and the 
range of times to be active (Starting at and Ending at). 
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Setting Scenes for Time Triggers

For any trigger you select from the triggers list, you can use functionality native to the Shows tab to 
assign or modify a scene. To do so, follow these steps:

1	 Select a trigger in the triggers list. 

2	 If assigning a scene, choose to create a new scene or copy from a previous scene.  
 
If you are creating a new scene: Give your scene a name, and then click Next. Note that you 
cannot reuse names you have already used within one installation. 
 
If you are copying a previous scene: Select the previous scene’s name from the dropdown. Note 
that the dropdown only includes scenes you have used in this installation. Once you select a 
scene, you will have the ability to edit it or use it as it is. Any edits made to the copy will not be 
reflected in the original. 

3	 Edit the scene. Click the green Edit button to open the Ketra Scene Builder window. 
(Alternatively, if you created a new scene, the window will open automatically. See fig. 97  
next page.)  
 
For instructions on using the Ketra Scene Builder window, refer to Building Scenes Using Scene 
Builder, page 69. 

1

2

fig. 96

continued on next page
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4	 Assign scenes to or modify scenes for other triggers in the triggers lists.

Note: In a custom show, you have to create a scene for any trigger you add to the list.

Excluding Groups from Shows or Triggers

Depending on the type of show (Run Always or Trigger with Show Group), you can exclude groups 
from shows or triggers. 

Ketra Only installation
Ketra with HomeWorks QS 
installation

Run Always show Exclude groups from individual 
triggers by setting them to NA. 

Has to be done by trigger, not for 
whole show

Do not use Run Always shows 
for Ketra with HomeWorks QS 
installations. 

Trigger with Show 
Group show

When assigning the show to a 
keypad or contact-closure input, 
use the checkboxes to deselect 
groups you want to exclude.

Has to be done for the whole  
show, not trigger by trigger

When assigning the show to a 
HomeWorks QS keypad, apply the 
show only to the groups you intend 
to use in the show. Any other groups 
will be excluded by default.

Has to be done for the whole show, 
not trigger by trigger

fig. 97

Ketra Scene Builder
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Implementing Shows in an Installation

Shows can either run automatically or run upon being triggered by a keypad button press or 
contact closure input. 

Enabling a Show to Run Automatically

Caution: In Ketra with HomeWorks QS installations, you should set shows to run 
automatically using a timeclock in HomeWorks QS, not Ketra Design Studio. Make sure to 
set any of the shows you build in Design Studio to Trigger with Show Group, not Run Always, 
before you import the installation into HomeWorks QS.  

If a show is set to run automatically, it will run on a recurring basis (you define how frequently). 

Note: Automatic shows are ideal for groups that are not also being controlled by keypad. If 
a group is being controlled by keypad, it is more appropriate to assign the show to a keypad 
button, since automatic shows cannot be initiated or deactivated by a keypad button or 
other trigger. 

To set a show to run automatically, follow these steps:

continued on next page

fig. 98
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1	 Select the show in the My Shows panel (left).

2	 Set the Control dropdown.

–– In a Ketra Only show, choose "Run Always".

–– In a Ketra with HomeWorks QS show, choose "Trigger with Show Group".
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3	 Optional: In a Ketra Only show, set days of the week, a date range, or a monthly schedule on 
which the show will run. 
By default, automatic shows will run 365 days a year. However, you can use this run frequency 
tool to tell an automatic show to run only on, say, Monday through Friday in December.  
 
You can configure your show’s run frequency as one of the following:

–– Daily: Determine which days of the week your show will run. 

fig. 100

fig. 101

fig. 99

Runs on blue days; 
inactive on white days

Note: Days of the week turn blue when they’re selected, and white when they’re deselected. 
For example, in the image above, Monday, Wednesday, and Friday are selected.

–– Date Range: Set a range of dates for the show to run, using the two calendars. You can also 
choose days of the week to run. In the image below, a show is configured to run Monday 
through Friday in December.  
 
You cannot set a date range that gets interrupted by a holiday or other event and then 
continues. To do that, you would need multiple shows.

–– Monthly: This option lets you repeat the show in a certain week of every month. Here, too, 
you can pick days of the week that you want your show to run. In the image below, the 
show will run every Monday, Wednesday, and Friday in the first week of every month.

4	 Save your settings by clicking Publish and Save in the top-right.
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Enabling a Show to Run When Triggered

Shows can be run upon being triggered by either a keypad button or a contact closure input (e.g.,  
an occupancy sensor).

To assign a show to a keypad button or contact closure input, follow these steps:

1	 Select the show in the My Shows panel (left).

2	 Set the Control dropdown to "Trigger with Show Group". This tells the show you are going to 
assign it to a keypad or contact closure input. When the show is triggered, it will play on the 
keypad’s or satellite’s groups. 

fig. 102

1

2

 
If you choose "Trigger with Show Group", pick a “show group” (i.e., category) for your show. You 
will reference the show group when you assign the show on the Keypads tab or Integration tab.  
 
You can add a show group by clicking the Add Group button. To rename the show group, go  
to Shows > Settings > Show Groups. (This is covered in more detail in Managing Show Groups, 
page 102.)

Note: You can put multiple shows into the same show group. When an analog input 
or keypad button press triggers the show group, all of the shows will play. You should 
therefore make sure that none of the shows that are grouped together will issue conflicting 
commands. For example, you might have one show that runs Monday through Friday and 
another show that runs Saturday and Sunday. 

continued on next page
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Selecting "Trigger with Show Group" enables you to assign the show to a keypad button or 
analog input, but it doesn’t automatically assign it for you. You still need to go to the Keypads or 
Integration tab and assign the show group to a trigger. 

Note: When a show is triggered, it automatically retrieves the correct color and intensity 
configurations for the given time, even if their corresponding time trigger has already passed. 
So if you have a trigger for 2 PM and a trigger for 3 PM, then triggering the show at 2:30 PM 
will turn the lights on with the 2 PM setting.

Disabling a Show for Later Use

You can disable any show to save it for later while ensuring that it doesn’t run on your lights. To do 
so, follow these steps:

1	 Select the show in the My Shows list (left).

2	 Set the Control dropdown to "Disabled".

3	 Click Publish and Save in the top-right corner.

Note: If the show was part of a show group which had already been assigned to a keypad 
button or contact closure input, the show group will remain assigned to that input. However, 
the show itself will no longer be part of the show group. If that leaves the show group empty, 
then the input will not actually be able to trigger any changes to your lighting. 

fig. 103

Other Operations

Limiting Astronomical Triggers

Whereas fixed time triggers are set to times like 2:00 PM, astronomical triggers are set to offsets 
from sunrise and sunset, e.g., Sunset -2:00 rather than 4:00 PM. These triggers are typically used in 
natural shows. 

Astronomical triggers can be problematic in high latitudes, where, for example, sunrise might come 
at 10:00 AM in January and 4:15 AM in June.

For greater control over the times at which a natural show runs, we recommend setting minimum 
and maximum times for sunrise and sunset. To do so, click More Options and customize the settings 
shown in the image below.

continued on next page
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Enabling Show Control by DMX or Analog Input

Check the box for "Enable Master Intensity Override" to allow a 0-10V or DMX input to control 
master intensity while the show controls intensity. This makes the show’s intensity proportional to 
the input’s master intensity command.

fig. 104

fig. 105

continued on next page

Example: Say a circadian show begins with the trigger Sunrise +1:00. If you set the minimum sunrise 
time to 7:00 AM, the trigger will never occur earlier than 8:00 AM. Without this minimum, it would 
always occur an hour after sunrise, even if the sun rose at 5:00 AM. 
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Example: 

•	 Show A has master intensity override enabled

•	 Show B has master intensity override disabled

•	 Show A and Show B both set lights to 50% intensity

•	 A photocell sends a command to dim both shows to master intensity = 60%

•	 Show A accepts photocell’s master intensity command, dims lights to 50% of 60%, i.e. 30%

•	 Show B ignores photocell’s master intensity command, dims lights to 50%

Note: Before they can interact with your show, third-party devices must be connected to  
an N3 Satellite via DMX or analog input. This is done in the Integration tab. See Enabling 
Sensor Control > Photocells, page 115; 0-10V and 0-24V Input Profiles, page 132; and  
DMX Input, page 136.

Enabling Show Override

fig. 106

With Show Override, you can designate a show that you want the currently-selected show  
to override.

By default, shows don’t know about each other; they just run at their given times. The result of this 
default can be chaos if you’ve got two shows controlling one group of lights at the same time, with 
the group trying to respond to commands from both. So if you know you want Show A to override 
Show B any time they’re running simultaneously, then you should open Show A in the Shows tab, 
click More Options, check the "Show Override" box, and select "Show B" from the dropdown. 
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Exporting a Show

In the Export tab, Design Studio gives you the option to save a show to a local file, which you can 
then import into a separate Design Studio installation. The default save location is Ketra > Time 
Trigger Shows, where you will find some of Ketra’s pre-made shows. 

Tutorials

Auto-Off Timeclock

According to some building energy codes, commercial spaces that don’t have vacancy sensors must 
automatically turn their lights off outside of normal business hours. You can do this by creating an 
auto-off timeclock show in the Shows tab.

Note: The groups you intend to turn off must be controlled by at least one keypad.

Will my keypad still respond to touch control after-hours? 
Yes. Users coming in after-hours will be able to press any button on the keypad to turn on the lights. 
(This is referred to as a manual override; some codes require it.) 

To set up an auto-off timeclock, follow these steps:

1	 Click Import Show at bottom-left.

2	 In the dialogue box, select the file Auto Off Timeclock.KTRA.

3	 Name the show. 

fig. 107

continued on next page
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4	 Select the highest-level group in the installation. This group will be the first in the list and will 
likely be named "Installation" or "Office".

5	 Click Import Show. 

continued on next page

fig. 108

Auto Off Timeclock.KTRA

Select highest-level group

6	 In the upper-right, click Publish and Save.

fig. 109
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You now have a working auto-off timeclock show.

•	 At 9 PM, the auto-off show will turn off every group in the installation.

•	 A user can manually override the show by pressing a button on any keypad. 

•	 Every two hours, the auto-off show will confirm that the lights are still off. If it finds the lights 
on, it will turn them off. 

Note: Even if a user manually overrides the show at 10:59 PM, the show will turn the lights 
back off at 11 PM. In that case, the user can just manually override again and the lights will 
stay on for two hours.

•	 At opening time, a user can press any button on the keypad to turn on the lights.

Automated Open/Close Time

In this tutorial, we’ll imagine a business that is open 7 days a week. On weekdays, it is open from 10 
AM to 9 PM. On Saturday and Sunday, it is open from 12 PM to 6 PM. To automate open and close 
times for this business, we will build two shows—one for weekdays, and one for weekends.

The weekday show will:

•	 Run automatically Monday through Friday

•	 Turn all lights on at 8:00 AM (1 hour prior to opening)

•	 Trigger a user-defined Retail scene at 8:55 AM (5 minutes prior to opening)

•	 Turn all lights off at 10:30 PM (1.5 hours after closing)

Note: For the purposes of this tutorial, we’ll assume that the Retail scene has already been 
built on the Scenes tab.

The weekend show will:

•	 Run automatically Saturday and Sunday

•	 Turn all lights on at 11:00 AM (1 hour prior to opening)

•	 Trigger a user-defined Retail scene at 11:55 AM (5 minutes prior to opening)

•	 Turn all lights off at 7:30 PM (1.5 hours after closing)

To configure the weekday show, follow these steps:

1	 Create a new show. You can do so by clicking Create Show at the bottom of the My Shows panel. 

2	 Rename the show something like “Weekday Open/Close.” To rename a show, highlight it in the 
My Shows list and click the pencil icon.

3	 Set the Control dropdown to "Run Always".

continued on next page
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4	 To make sure the show only runs on weekdays, deselect Saturday and Sunday in the run 
frequency pane. When deselected, the S and SU buttons will turn white instead of blue.

5	 In the triggers list, add 3 triggers on the Time tab by clicking the + button. We will program 
one trigger to turn all lights on, another to set lights to the Retail scene, and the last to turn all 
lights off.

6	 Set times for the triggers. In our example, the times are 8:00 AM (1 hour before opening), 8:55 
AM (5 minutes before opening), and 10:30 PM (1.5 hours after closing).

7	 Make a copy of a generic On scene for the first trigger. Since this trigger will just turn all lights 
on, we recommend making a copy of the Collaborate or Daytime scene. This will set every light 
in the installation to a warm white at 100% intensity. 

2

3

4

5

6

1

fig. 110

Note: To exclude some groups from the trigger, click the green Edit button to open the Ketra 
Scene Builder window, then set the groups to NA by highlighting them and clicking the X 
button. Note that this method of excluding groups from triggers only applies to shows that 
run automatically. If you intend to link the show to a keypad button or analog input, do not 
use NA. For more information, see Excluding Groups from Shows, page 88. 

8	 Make a copy of the Retail scene for the second trigger. 

Note: For the purposes of this tutorial, we’ll assume that the Retail scene has already been 
built on the Scenes tab.

continued on next page
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9	 Create a new scene for the third trigger. Name the scene something like “All Off.”

10	 In the Ketra Scene Builder window, set the highest-level group to Off. To do so, highlight  
the group and click the power button in the top-right corner of the window (next to the 
intensity slider). 

fig. 111

Power

Groups set to 
Off have semi-
transparent color/
intensity boxes

11	 Close the Ketra Scene Builder window.

Repeat those steps for the weekend show, substituting configurations where appropriate. You  
can make a copy of the All Off scene this time. The finished Weekend Open/Close show should look 
like this:

continued on next page

fig. 112

Weekend 
show

Only runs on Saturday 
and Sunday
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After configuring both shows, click the Publish and Save buttons in the top-right corner. 

6-Minute Looping Show

Let’s create a six-minute loop with three triggers, where each trigger lasts two minutes. The loop will 
run all day, repeating every six minutes.

1	 In the Loops subtab of the triggers list, click the + button three times. This creates three 
undefined triggers.

2	 Highlight the first trigger and click Timer.

3	 Set Loop Every to 6 mins. 

4	 Set Start Offset to 0 mins. This means that the first trigger will become active zero minutes  
into the loop. 

5	 Since we want the loop to run all day, leave Starting At and Ending At at their default value  
of 12 am. 

6	 Click Done.

Second trigger

fig. 114

7	 Highlight the second trigger and click Timer.

8	 Repeat steps 3-5, this time setting Start Offset to 2 mins. Note that Loop Every should be the 
same as in the previous trigger. Setting Start Offset to 2 mins means that this second trigger will 
become active two minutes into the loop—i.e., after the first trigger gets its two minutes.

9	 Click Done.

continued on next page

First trigger
fig. 113
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10	 Highlight the third trigger and click Timer.

11	 Repeat steps 3-5, this time setting Start Offset to 4 mins. Again, it is important that Loop  
Every be set to 6 mins. Setting Start Offset to 4 mins means that this third trigger will become 
active four minutes into the loop—i.e., after the first and second triggers have each had their 
two minutes. 

12	 Click Done.

Third trigger

fig. 115

Finished loop

fig. 116

You now have a loop that repeats 3 triggers every 6 minutes, giving each trigger 2 minutes to run. 

Note: Design Studio does not support configuring loops to start from the beginning when 
triggered by a keypad button or contact closure. Looping goes on in the background at all 
times, even when the show is not active, so keypads and contact closures can only start the 
loop at whatever scene is currently active. 
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Managing Show Groups

•	 To add a show to a show group, use the Control dropdown in the top-left corner (just right of 
the My Keypads panel). Afterward, you will be able to assign the show group to a Ketra keypad 
button, contact-closure input, or HomeWorks QS keypad.

Note: A show group can consist of one show or multiple shows. If the show group contains 
multiple shows and you assign it an input trigger (i.e., keypad button or contact closure), then 
multiple shows will play when the input is received. 

•	 To create a show group, use the Schedule tab for any given show. First set the Control 
dropdown to "Trigger with Show Group", then press the Add Group button that appears. The 
generic name will be "Show Group <X>". 

•	 To rename a show group, use the Settings tab for any given show. In the Show Groups list, 
highlight the group and click the pencil icon next to its name.

Note: Renaming a show group will not change its assignments. 

•	 To delete a show group, use the Settings tab for any given show. In the Show Groups list, 
highlight the group and click the X button. 

Note: Deleting a show group does not delete any shows that the show group contains. If you 
have already assigned the show group to a keypad button or contact closure, you should 
change the button or CC’s programming before publishing. 
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Programming Ketra Keypads

Contents

The Keypads Tab		     103

Assigning a Scene	     104

Assigning a Show	     106

Automatic Button 
Linking			       107

Tutorials		      108

Adding a Global On/Off 
Button to a Local Keypad	    108

Configuring Discrete 
Zones on One Keypad	     110

Keypad User Interface	     111

In the Device Control tab, device categories are displayed near the 
top of the screen. The Keypads tab is where you assign scenes and 
shows to Ketra keypad buttons. We recommend building scenes on 
the Scenes tab and shows on the Shows tab, although you can build 
them on the Keypads tab as well. 

About keypads:

•	 Keypads control groups of Ketra lights, X2 dimmers, and 
outputs. With a single keypad, you can control multiple groups 
at the touch of a button. Keypads can be programmed to give 
detailed instructions to groups, including color configurations 
and time triggers. 

•	 By default, keypads can control the group they belong to as 
well as any subgroups in the hierarchy. For example, a Kitchen 
keypad might control devices in the "Kitchen" group as well as 
in the subgroups "Task", "General", and "Accent". This hierarchical 
control enables discrete zone control, since one button on the keypad might be programmed to 
affect "Task" while another affects "General".

•	 Keypads can be independent or linked. If you have more than one keypad controlling the same 
groups, Design Studio will automatically link them. 

The Keypads Tab

fig. 117

List of Ketra keypads Keypad button interface Scene or show
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When you select a keypad in the My Keypads list on the left, the center of the screen changes to 
display the keypad’s buttons. You can assign scenes and shows to these buttons by clicking them on 
the screen.

You’ll notice that Design Studio also displays the keypad’s grouping hierarchy. The groups that 
appear on this screen represent the keypad’s place in the overall installation hierarchy. Recall that 
keypads can control their own groups plus any subgroups. 

Note: If the keypad should control additional groups, return to the Organization tab and 
move the keypad to its appropriate place in the hierarchy.

In the grouping hierarchy reproduced on the Keypads tab, you can use the checkboxes to determine 
which of the keypad’s groups the scene or show will affect when the given button is pressed. Any 
checked groups will go to the scene when the user presses the button, turn off when the user 
presses the button again, and dim when the user presses the intensity controls.

Assigning a Scene 

To assign a scene to one of your keypad buttons, follow these steps:

1	 Select a keypad in the My Keypads panel at left, then select the button to program. If the 
button has default content, click Clear Scene or Clear Show.

2	 Select "Assign a Scene" in the Content Type dropdown, then click Next. 

fig. 118

3	 Select Use an already constructed scene for the assignment option (recommended). We 
recommend building scenes on the Scenes tab, then assigning them on the Keypads tab. You 
will be able to control the groups that will be affected when the scene is triggered. 

Note: If you intend to make any modifications to the existing scene, select Make a copy of 
another scene. This will ensure that your modifications do not take effect throughout the 
installation wherever the original scene is applied. 

continued on next page
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4	 Select or name the scene and click Next. 

fig. 120

5	 Optional: Use the checkboxes to set which groups can be controlled by the button. If a group 
does not have a checkmark, the keypad will not send it any commands when the scene is 
activated, dimmed, or deactivated. Effectively, the group is excluded from the scene. 

Note: To enable discrete zone control on a keypad, use these checkboxes. For example, to 
ensure that a scene only affects the "Accent" group, check only the box for Accent.

6	 Publish your settings. This saves your configurations to your keypad. Click Publish and Save in 
the top-right corner of the screen. For more information on publishing, see Publishing, page 152.

fig. 119

Recommended 
Option
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Assigning a Show

Note: Shows can be assigned to an input (e.g., a keypad button) or set to run automatically. 
For more information on setting shows to run automatically, see Enabling a Show to Run 
Automatically, page 89.

To assign a show to one of your keypad buttons, follow these instructions:

1	 Go to Device Control > Shows.

2	 Make sure that the show has been created and assigned to a show group. To assign a show 
group, set the Control dropdown to "Trigger with Show Group" and pick a “show group” (i.e., 
category) for your show.  
 
You can add a new show group by clicking the Add Group button. To rename the show group, 
go to Shows > Settings > Show Groups. 

fig. 121

3	 Return to Device Control > Keypads.

4	 Select a keypad in the My Keypads panel on the left, then pick the button to program. If the 
button has default content, click Clear Scene or Clear Show.

5	 Select "Assign a Show" in the Content Type dropdown, then click Next. 

fig. 122

continued on next page
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6	 Select a show group ID to assign. 

7	 Optional: Use the checkboxes to set which groups can be controlled by the button. If a 
group does not have a checkmark, the keypad will not send it any show commands, including 
activation, deactivation, and dimming. Effectively, the group is excluded from the show. 

Note: To enable discrete zone control on a keypad, use these checkboxes. For example, to 
ensure that a show only affects the "Accent" group, check only the box for Accent.

8	 Optional: Use the "Fade Time" text field to adjust the time it takes to fade between scenes in 
the show. 

9	 Publish your settings. This saves your configurations to your keypad. Click Publish and Save in 
the top-right corner of the screen. For more information on publishing, see Publishing, page 152.

fig. 123
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Automatic Button Linking

Whenever two or more keypad buttons (whether on the same or different Ketra keypads) control 
the same groups, Design Studio automatically links them. Pressing one button will trigger a change 
in the state of the other button’s backlighting (illuminated, dark, or flashing). This automatic 
linking requires nothing of the programmer while ensuring that the user always receives accurate 
information about group states.

continued on next page
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Design Studio links two buttons when it detects a) overlap in the groups they control, or b) overlap 
in their content settings. There are several forms of linking:

•	 Cascading: The buttons control all the same groups using different scenes. Pressing one button 
causes the other(s) to go dark. 

•	 Mirroring: The buttons control all the same groups using the same scene. Pressing one button 
highlights the other(s). 

•	 Parent/Child: One button controls a set of groups while the other button(s) control a subset 
of those groups. Pressing the parent button will cause the child button to illuminate, since its 
groups are on. Pressing the child button will cause the parent to go to a flashing “modified” 
state, since some of its groups are now playing different content.

Relax Media Relax Relax

Scenario 1: Cascading Scenario 2: Mirroring

fig. 124

Relax and Media control the same groups with 
different content. Selecting Relax causes the 
Media button to turn off.

Keypad A Keypad AKeypad B Keypad B

These keypad buttons control the same groups with 
the same content. Selecting Relax on Keypad A causes 
the Relax button on Keypad B to light up.

Design Studio will automatically determine how commands from parent keypads affect child 
keypads. Setting a Whole House keypad to Power Off will set all house keypads to Power Off. If 
someone then sets the Dining Room keypad to another setting, the top scene button of the Whole 
House keypad will flash to indicate a modified state, while all other keypads remain in the off state. 

Tutorials

Adding a Global On/Off Button to a Local Keypad

Example: Adding an All On / All Off button to an entryway keypad

1	 On the Organization tab, place the keypad in the highest-level group in the installation. The 
default name of this group will be either "Residence", "Office", or "Installation", depending on the 
type of installation. 

continued on next page
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2	 Go to Device Control > Keypads and select the keypad at left. 

3	 Make a Master On/Off button and program it as desired.

–– If you want the button to turn on and off every group in the installation, make sure every 
group is checked. (Pictured)

–– If you want the button to only turn on and off some groups, make sure those groups are 
checked and the others are unchecked. 

–– If you want the button to turn on a subset of groups but turn off all groups, use the NA 
feature. First, make sure all groups are checked. Then edit the scene such that the groups 
you do not want the button to turn on are marked NA, while those you do want it to turn 
on are set. When the user taps the Master button to turn it on, only the groups that are not 
marked NA will power on. When the user taps the Master button to turn it off, all checked 
groups will turn off.

fig. 125

When the button is pressed, all groups will turn off or on

fig. 126
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continued on next page
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Note: To exclude a group from a scene, select the scene button in the Keypads tab and 
uncheck the group. A common error is to try to exclude groups from scenes using the 
NA feature on the Scenes tab rather than unchecking the group on the Keypads tab. NA 
groups do not respond to the activation of a scene, but they do turn off when the scene is 
deactivated, and they are also affected by the keypad’s dimming controls.

4	 For the other keypad buttons, uncheck all groups except the "Entryway" group and/or 
subgroups. This ensures that those buttons only control the lighting in the entryway or 
entryway zones.

fig. 127

Configuring Discrete Zones on One Keypad

Example: Programming a Kitchen keypad with General, Task, and Accent zones

1	 On the Organization tab, place the keypad in the room-level group. In our example, the keypad 
goes in the Kitchen group. It will then be able to control any devices in the "General", "Task", and 
"Accent" groups.

fig. 128

continued on next page
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2	 Go to Device Control > Keypads and select the keypad on the left.

3	 For each button, ensure that only the corresponding zone (group) is checked. If assigning a 
different scene created on the Scenes tab, it is okay if the scene would normally control other 
groups as well. As long as only the desired zone is checked for this button, only that zone will be 
affected by the button.

fig. 129
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Note: To exclude a group from a scene, select the scene button in the Keypads tab and 
uncheck the group. A common error is to try to exclude groups from scenes using the 
NA feature on the Scenes tab rather than unchecking the group on the Keypads tab. NA 
groups do not respond to the activation of a scene, but they do turn off when the scene is 
deactivated, and they are also be affected by the keypad’s dimming controls.

4	 Optional: Customize the zone’s scene or show. To customize, click the green Edit button.

Note: Changing an existing scene affects other instances of the scene in the installation.

Keypad User Interface

On Ketra X2 keypads and in the Ketra mobile app, multiple zones can be turned on at once. To 
support discrete zone control, each keypad has an active zone—the last zone the user interacted 
with. By default, the keypad’s brightness controls will only affect the active zone; when there is no 
active zone, the brightness controls affect all groups. 

On an X2 keypad, the active zone’s button will shine brighter than the other buttons to help the 
user identify it. In the mobile app, the active zone has an asterisk next to its name. 

continued on next page
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Example Usage: Dimming two zones that are in different states

1	 Press Zone 1 button to set the first zone to its state. 
Effect: Zone 1 is triggered and becomes active zone.

2	 Press Zone 2 to set the second zone to its state. 
Effect: Zone 2 is triggered and becomes active zone. Zone 1 stays on in its state.

3	 Press and hold Zone 2 for three seconds. 
Effect: The keypad unsets the active zone, but both zones stay on in their respective states.  
(To confirm, make sure that the Zone 2 button has the same illumination intensity as the  
Zone 1 button.)

4	 Press the keypad’s raise/lower buttons. 
Effect: Raises/lowers intensity for both zones.

For a complete guide to button interactions and behaviors, see the table below.

Keypad Button Interactions in 3.0

Interaction Effect
Single press on button Toggle scene on or off. When turning on, sets 

active zone

Press and hold button for one second Sets active zone

Press and hold active zone button for  
three seconds

Unsets active zone so brightness controls affect 
all scenes

Keypad Button Feedback in 3.0

Behavior Meaning
Unlit button Scene is not turned on

Backlit button, steady light Scene is turned on and playing on the 
corresponding groups

Brightly backlit button, steady light Scene is turned on and playing on the 
corresponding groups. The button is the  
active zone

Flashing button Scene is in a modified state: at least one 
subgroup has changed state
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Enabling Sensor Control

In a Ketra Only installation, the Ketra system can take input  
from sensors via wired connection to an N3 Satellite’s Analog I/O 
ports. Wiring should be completed by a licensed electrician prior  
to commissioning. 

After wiring has been completed, you still need to configure the N3 
Satellite in Design Studio. This section discusses configuration of 
occupancy sensors, vacancy sensors, and photocells.

Occupancy/Vacancy Sensors

Contents

Occupancy/Vacancy  
Sensors			       113

Photocells	 	     115

Most occupancy sensors can also be programmed for vacancy mode. 

•	 In occupancy mode, the sensor turns lights off when no one is present and turns them back on 
when an occupant enters the room.

•	 In vacancy mode, the sensor turns lights off when no one is present. An occupant entering the 
room would need to use a keypad to turn the lights back on.

You should determine which mode to use according to energy codes. You will be able to manually 
adjust the hypersonic and/or infrared sensitivity values on the units themselves.

Note: Sustained contact closures only.

To enable an occupancy/vacancy sensor to control certain groups in the installation, follow  
these steps:

1	 Go to Device Control > Integration.

2	 Select the appropriate N3 Satellite from the My Control Devices list on the left.

3	 Go to the Analog I/O tab.

fig. 130

1

2

3

continued on next page
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fig. 131

COM 1 corresponds 
to Port 1

4	 Consult the Ketra submittal to see which port the sensor is wired to. There are 4 Analog  
I/O ports on the N3 Satellite. In the Ketra submittal, “COM1” corresponds to Port 1, “COM2”  
to Port 2, etc. 

5	 Set the Port Type dropdown to "Contact Closure".

6	 Set whether the port is normally open or normally closed. Each contact-closure port has two 
states—open and closed—depending on its input. Some sensors consider an occupied port to be 
open; others consider it to be closed.

7	 Use the dropdown on the right to set the profile of the input.

fig. 132

Pick Normally Open 
or Normally Closed

Pick 1 of the 4 profiles in fig. 1335 6 7

Use profile if... Effect
Vacancy Mode  
(linked to keypad)

Every group controlled by 
the vacancy sensor will 
also be controllable from  
a keypad.

When vacancy is detected, the group(s) will turn 
off. The keypad will unhighlight any buttons 
except the power button. The keypad will remain 
responsive to touch-based control. 

Vacancy Mode 
(Configure 1 scene)

The group(s) to be 
controlled by the vacancy 
sensor will not be 
controllable from a keypad. 

You will be able to customize one scene that will 
play when vacancy is detected. Customizing this 
scene will let you determine whether all lights 
should go off or some should stay on, for example 
as a night light or for passage illumination.

Occupancy Mode 
(Linked to Keypad)

The group(s) to be 
controlled by the 
occupancy sensor will also 
be controlled by a keypad. 

Syncs the port to a particular scene button on 
a keypad. The button must already have an 
associated scene or show. When occupancy is 
detected, that button will highlight and the 
associated groups will go to that scene or show; 
when vacancy is detected, the lights will turn off 
and the keypad button will unhighlight. 

Occupancy Mode 
(Configure 2 Scenes)

The group(s) to be 
controlled by the 
occupancy sensor will not 
be controlled by a keypad.

Allows customization of two scenes: one for when 
occupancy is detected and one for when it is not.

fig. 133
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8	 Click Next.

9	 Set additional configurations for the contact-closure input.Your options on this screen vary 
depending on the profile you chose.

–– Vacancy Mode (Linked to Keypad): Select the keypad that controls the sensor’s groups. If 
the groups are controlled by multiple keypads, just select one of the keypads; the others will 
be accounted for under the hood.

–– Vacancy Mode (Configure 1 scene): Assign a scene or show to play when vacancy is detected. 
Check the Off Trigger Delay box to enable the N3 to delay sending a wireless command after 
the sensor has reported unoccupied.

–– Occupancy Mode (Linked to Keypad): Select the keypad that controls the sensor’s groups. 
Select that button that you want to turn on when occupancy is detected. Set the intensity 
level at which the scene or show should come on when occupancy is detected. The default 
is 50% intensity, but unless energy codes dictate otherwise, we recommend adjusting this to 
100% to ensure full visibility for users entering the space.

–– Occupancy Mode (Configure 2 scenes): Program a scene or show for occupancy and vacancy. 
Use the Occupancy On/Off dropdown to determine which setting you are assigning content 
for. Check the Off Trigger Delay box to enable the N3 to delay sending a wireless command 
after the sensor has reported unoccupied.

10	 Click Next.

The port is now configured to receive and process contact-closure input from the occupancy or 
vacancy sensor. 

Troubleshooting Unexpected Behavior

•	 Manually adjust the ultrasonic and/or infrared sensitivity settings on the sensor itself. 

•	 Confirm that the sensor has been wired to the correct port on the N3 Satellite.

•	 Double-check your configurations in Design Studio.

Photocells

To enable a photocell to control certain groups in the installation, follow these steps:

1	 Go to Device Control > Integration.

2	 Select the appropriate N3 Satellite from the My Control Devices list on the left.

3	 Go to the Analog I/O tab.

4	 Consult the Ketra submittal to see which port the photocell is wired to. There are 4  
Analog I/O ports on the N3 Satellite. In the Ketra submittal, “COM1” corresponds to Port 1, 
“COM2” to Port 2, etc. (See fig. 133, next page.)
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Note: If the submittal shows the photocell connecting to two ports, only configure the first 
port. The second will be automatically included once you select a profile in step 7.

5	 Set the Port Type dropdown to 0-10V.

6	 Set the lower dropdown to "Current Source".

7	 Use the dropdown on the right to set the profile of the input.

fig. 133

COM 1 corresponds 
to Port 1

fig. 134

Pick 1 of the 4 profiles in fig. 1355 6 7

Use profile if... Effect
Ketra Dimming 
Photocell

1.  The photocell is Leviton brand 
AND 
2.  Every group controlled by the photocell 
will also be controllable from a keypad

The groups’ intensity will be 
controlled by the photocell, but it 
can be overridden by the keypad 
(e.g., to avoid 100% intensity at night)

Ketra Dimming 
Photocell (Master 
Intensity)

1.  The photocell is Leviton brand 
AND 
2.  The group(s) to be controlled by the 
photocell will not be controllable from  
a keypad

The groups’ master intensity will be 
directly controlled by the photocell

Intensity 1.  The photocell is any brand other  
than Leviton 
AND 
2.  Every group controlled by the photocell 
will also be controllable from a keypad

The groups’ intensity will be 
controlled by the photocell, but it 
can be overridden by the keypad 
(e.g., to avoid 100% intensity at 
night)

Master Intensity 1.  The photocell is Leviton brand 
AND 
2.  The group(s) to be controlled by the 
photocell will not be controllable from  
a keypad

The groups’ master intensity will be 
directly controlled by the photocell

 fig. 135
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8	 Click Next. 

9	 Use the checkboxes to determine which groups should be dimmed by the sensor.

Note: The Master Brightness Override and Analog IO Refresh checkboxes should be left 
unchecked for photocells. 

10	 Click Next.

The port is now configured to receive and process contact-closure input from the occupancy or 
vacancy sensor. 

Troubleshooting Unexpected Behavior

•	 Adjust the ultrasonic and infrared configurations on the device.

•	 Confirm that the sensor has been wired to the correct port on the N3 Satellite.

•	 Double-check your configurations in Design Studio.
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Enabling Emergency 
Mode Lighting

Note: This section applies to Ketra Only installations. In Ketra 
with HomeWorks QS installations, any emergency power relays 
should be linked to the Lutron HomeWorks QS processor and 
configured using HomeWorks QS, not Ketra Design Studio.

Contents

Requirements		      118

Instructions	 	     119

In the event of an emergency, any Ketra lights configured for Emergency Mode will do the following:

1	 Go to their restore states (Restore states are covered in detail in Managing Lighting Power-
Restore States, page 59) 

2	 Ignore any and all commands from user input, timeclock events, etc. 

3	 Remain in their restore states until they receive confirmation that they are no longer in an 
emergency setting.

Requirements

Before configuring lights for Emergency Mode, ensure that the following system-level requirements 
are met:

•	 Spacing, quantity, and restore state (color and intensity) of the Ketra emergency light sources 
must meet requirements for emergency light levels.

•	 The backup AC power source must produce a sinusoidal (sine) wave. Some inverters produce a 
square wave; this will not work for Ketra products. 

•	 To use KetraNet Mesh lamps and fixtures (i.e., anything that does not connect to an N3 Satellite) 
as emergency lighting, ensure that the products have a means of losing power for 2 seconds 
before restoring in Emergency Mode. 

–– By requiring a power-cycle event to enter Emergency Mode, the KetraNet Mesh system can 
respond to an emergency without relying on wireless communication. 

–– If the backup system switches to emergency power in under 2 seconds, a shunt relay  
can be used to enforce a 2-second delay. (Typically this is not necessary in systems relying  
on generators.)
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Instructions

1	 Configure an Emergency Mode contact closure.

i	 Go to Device Control > Integration.

ii	 Select the appropriate N3 Satellite from the My Control Devices list on the left.

iii	 Go to the Analog I/O tab.

iv	 Consult the Ketra submittal to see which port the relay or inverter is wired to. There are 4 
Analog I/O ports on the N3 Satellite. In the Ketra submittal, “COM1” corresponds to Port 1, 
“COM2” to Port 2, etc. 

COM 1 corresponds 
to Port 1

fig. 136

v	 Set the Port Type dropdown to "Contact Closure".

vi	 Set whether the port is normally open or normally closed. Each contact-closure port has 
two states—open and closed—depending on its input. Whether the port is normally open or 
normally closed depends on the emergency relay/inverter. 

vii	 In the dropdown on the right, select the Emergency Mode profile.

viii	 Click Next.

fig. 137

Varies by devicev vi vii

ix	 Publish your configurations by clicking Publish and Save in the top-right corner.

2	 Create a group for the emergency lights.

i	 Go to the Organization tab.

ii	 Add a custom group to the highest-level group in the hierarchy.

iii	 Rename the group something like “EM Lighting.”

iv	 Select the lights you intend to use for emergency lighting, then copy/paste them into the 
new group.

continued on next page
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Note: You can copy and paste using Ctrl+C and Ctrl+V. Make sure to use the copy function, 
not cut. 

Caution: Do not put any lights into the EM Lighting group that also belong to groups 
with unusual default power-restore states. The usual default is 3000K, 100% intensity. For 
example, if you have configured KA00110101’s group to restore to a dim blue, you should not 
use KA00110101 as an emergency light. 

continued on next page

Copy/paste 
emergency lights 
into a new group

fig. 138

3	 Enable Emergency Mode on KetraNet Mesh fixtures. (See fig. 139)

i	 Go to the Device Settings tab.

ii	 If necessary, set the Settings For dropdown to "Lamps".

iii	 Use the Device Filter dropdown to select the EM Lighting group you just created.

iv	 Check the Select All box to highlight all devices in the group.

v	 In the Modify Lamp Settings pane, set the Emergency Mode dropdown to "Enabled".

vi	 Click Apply to Selected.

Caution: Check to make sure that none of the lighting devices in the EM Lighting group 
shows “Enabled” in the Restore State on Power Cycle column. If any do, we strongly 
recommend disabling that feature on those devices. 
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4	 Step 4: Publish configurations

i	 Go to the Device Control tab.

ii	 Click Publish and Save in the top-right corner.

fig. 139

ii iii
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fig. 140
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Integrating Third-Party Lighting

Contents

Lighting Integration  
Workflow		      122

Configuring 0-10V Output  
for Lighting		      123

Configuring Contact-Closure 
Output for Lighting	     125

Configuring DMX Output  
for Lighting		      127

Configuring an X2 Dimmer   127

Using Third-Party  
Lighting in Scenes	     128

In both Ketra Only and Ketra with HomeWorks QS installations, 
Design Studio supports the integration of third-party lighting loads 
into the Ketra system.

In Ketra with HomeWorks QS installations, we recommend 
integrating third-party lighting to the Ketra system rather than 
HomeWorks QS; you can do so via DMX output from an N3 Satellite. 
See DMX Output, page 141.

After integrating (in either kind of installation), you will be able 
to include the third-party fixtures in scenes just like Ketra lights. 
For each scene, you can configure the lights’ intensity, color 
settings, and/or other parameters depending on the fixture and the 
integration method. In Ketra with HomeWorks QS installations, you 
can then import those scenes into HomeWorks QS. In Ketra Only 
installations, you can assign them directly to Ketra keypad buttons, 
contact-closure inputs, and shows. 

Lighting Integration Workflow

In a Ketra with HomeWorks QS installation, integration of third-party lighting loads follows  
this sequence:

1	 Wire the fixture(s) to the appropriate N3 Satellite or Satellites’ DMX out ports (Wiring not 
covered in this manual)

2	 In Tech Tool, configure the N3 Satellite(s) for DMX Output (See DMX Output, page 141)

3	 In Design Studio, add the output(s) into groups on the Organization tab, then incorporate 
those groups into scenes (See Using Third-Party Lighting in Scenes, page 128)

In a Ketra Only installation, integration of third-party lighting loads follows this sequence:

1	 Wire the fixture(s) to the appropriate Ketra control—either N3 Satellite or X2 Dimmer (Wiring 
not covered in this manual)

2	 Configure one of the following:

i	 0-10V output from an N3 Satellite (See Configuring 0-10V Output for Lighting, page 123)

Note: If the Ketra submittal indicates that a fixture should be integrated using a “0-10V+CC” 
protocol, consult Configuring 0-10V Output for Lighting, page 123.

ii	 Contact-closure output from an N3 Satellite (See Configuring Contact-Closure Output for 
Lighting, page 125)

continued on next page



DESIGN STUDIO 3.0123

DESIGN STUDIO 3.0 
COMMISSIONING AN INSTALLATION

iii	 DMX output from an N3 Satellite (See DMX Output, page 141)

iv	 Line-voltage dimming from an X2 Keypad (See Configuring an X2 Dimmer, page 127)

3	 In Design Studio, add the output(s) to groups on the Organization tab, then incorporate those 
groups into scenes (See Using Third-Party Lighting in Scenes, page 128)

Configuring 0-10V Output for Lighting

Note: 0-10V control of third-party fixtures is only supported in Ketra Only installations.

Integrating third-party lighting via 0-10V output allows you to set intensity for the loads in any 
scenes they appear in.

To enable an N3 Satellite to control third-party fixtures via 0-10V output, follow the steps below. 

1	 In Design Studio, go to Device Control > Integration.

2	 Select the appropriate N3 Satellite from the My Control Devices list on the left. At this step, 
satellites will not identify themselves by flashing indicator lights when selected.

3	 Go to the Analog I/O tab.

fig. 141

continued on next page
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4	 Consult the Ketra submittal to see which port the fixture is wired to. There are 4 Analog  
I/O ports on the N3 Satellite. In the Ketra submittal, “COM1” corresponds to Port 1, “COM2” to 
Port 2, etc.  
 

COM 2 corresponds 
to Port 2

COM 1 corresponds 
to Port 1

fig. 142 

If the third-party fixture requires 2 ports (as in fig. 142), only configure the first port. The second 
will be included automatically once you pick a profile in step 8.

5	 For the appropriate port, set the Port Type dropdown to "0-10V".

6	 Change the second dropdown to "Output".

7	 Set whether the output is Current Sink or Current Source. Consult the spec sheet for the device 
that you are interfacing with.

8	 Use the dropdown on the right to set the profile of the output.

–– If the next port is connected to a Ketra power pack (KL14), select "Intensity + Ketra  
Power Pack".

–– If the next port is connected to any power pack other than the KL14, select "Intensity + CC".

–– If the next port is not connected to a power pack, select "Intensity".

Note: For the Lutron LU05 power pack (shown in fig. 142), use "Intensity + CC".

continued on next page

fig. 143
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9	 Give the output a distinctive name so you know which fixtures it controls. Unlike with Ketra 
lights, you will not be able to select the output in Design Studio and have it identify in the 
space. Therefore it is very important to give it a descriptive name.

10	 If you selected a profile with a power pack, set whether the second port is normally open or 
normally closed. 

11	 Click Next.

12	 Optional: If you selected a profile that uses a power pack, adjust the voltage thresholds at 
which the contact closure should turn on and off. For example, if a third-party light starts 
flickering at 3V, its CC Off Voltage should be set to 3.

After performing those configurations, you are ready to add the output to a group on the 
Organization tab, then integrate it into scenes on the Scenes tab. See Using Third-Party Lighting in 
Scenes, page 128.

Configuring Contact-Closure Output for Lighting

Note: Contact-closure control of third-party fixtures is only supported in Ketra  
Only installations.

Integrating third-party lighting via contact-closure output allows you to toggle the loads on and off 
for any scene that they appear in.

fig. 144 

continued on next page
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To enable an N3 Satellite to control third-party fixtures via contact-closure output, follow the  
steps below. 

1	 In Design Studio, go to Device Control > Integration.

2	 Select the appropriate N3 Satellite from the My Control Devices list on the left. At this step, 
satellites will not identify themselves by flashing indicator lights when selected.

3	 Go to the Analog I/O tab.

fig. 145 

4	 Consult the Ketra submittal to see which port the fixture is wired to. There are 4 Analog  
I/O ports on the N3 Satellite. In the Ketra submittal, “COM1” corresponds to Port 1, “COM2” to 
Port 2, etc.

5	 For the appropriate port, set the Port Type dropdown to "Contact Closure".

6	 Change the second dropdown to Output.

7	 Set whether the output is Normally Open or Normally Closed. Each contact-closure port has 
two states—open and closed—depending on its input. Some sensors consider an occupied port 
to be open; others consider it to be closed.

8	 In the dropdown on the right, select "1:1 Mode".

9	 Give the output a distinctive name so you know which fixtures it controls. Unlike with Ketra 
lights, you will not be able to select the output in Design Studio and have it identify in the 
space. Therefore it is very important to give it a descriptive name.

fig. 146

5 6

7 9
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10	 Click Next.

After performing those configurations, you are ready to add the output to a group on the 
Organization tab, then integrate it into scenes on the Scenes tab. See Using Third-Party Lighting in 
Scenes, page 128.

continued on next page
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Configuring DMX Output for Lighting

For instructions on configuring DMX output, see DMX Output, page 141.

Configuring an X2 Dimmer

Note: Line-voltage dimming via X2 Dimmer is only supported in Ketra Only installations.

continued on next page

An X2 Dimmer connected to a third-party 
fixture in the Ketra submittal packet

fig. 147

Ketra X2 Keypads equipped with onboard dimmers can modulate power to incandescent loads. 
As soon as the dimmer is wired to the incandescents’ circuit, it is ready to use. Optional additional 
configurations described in this section include:

•	 Renaming the dimmer (The name change applies only within Design Studio and Tech Tool)

•	 Setting a dim curve

•	 Setting custom trims for maximum and minimum light output

To access these features, follow these steps:

1	 In Design Studio, go to Device Control > Integration.

2	 Select the X2 Keypad from the My Control Devices panel on the left.

fig. 148
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About Dim Curves

Three curve options are available: Ketra, Linear, and Square Law. Certain load types look better with 
certain curves.

•	 Use the Square Law curve for incandescents (recommended). Square Law dim curves enhance 
the visibility of intensity adjustments at low levels.

•	 Use the Ketra curve to match third-party lighting’s dim curve to that of Ketra lights. Ketra uses 
an exponential dim curve. 

•	 Use the Linear curve whenever it is not a high priority to match third-party lighting’s dim curve 
to that of Ketra lights. Linear dim curves match input with voltage so that a 10% increase from 
the keypad leads to a 10% increase in voltage. Since Ketra lights use an exponential dim curve, a 
linear curve will not match precisely. 

Note: Recall that any dim curve selected here will apply only to your non-Ketra lights. 

About Trims

You can set non-default trims to limit the maximum or minimum output of your lights. 

Note: Setting non-default trims will affect the fade curve of non-Ketra lights. Dim curves are 
adjusted to start or end at the trim value rather than simply cutting off at the trim value. This 
ensures that fades have the same duration, but it also means that trimmed loads will not 
match the fade curve of Ketra lights.

Setting a high trim limits the maximum output of a light, and can therefore extend the light’s 
lifespan. Low trims are recommended when the third-party light cannot dim as low as a Ketra light. 
To find the proper low trim value for a light, start at 50% and edge down in increments of 5%. You 
will see the load dim as the X2 restricts its power, and at some point the lights may turn off or start 
to flicker. Your low trim should be the value right above where they turned off or started to flicker. 
If you get all the way to 1% and the lights have not turned off or started to flicker, the load does not 
need a low trim. 

Don’t forget to save your configurations by clicking Publish and Save. Your changes will not take 
effect until published. 

Using Third-Party Lighting in Scenes

The Ketra system treats each output (whether from an N3 or X2) as a device in the installation. 

This enables you to include these outputs in groups and scenes, just like Ketra lights. For each 
scene, you can configure the third-party lights’ intensity, color settings, and/or other parameters 
(depending on the fixture and the integration method). You will be able to trigger these scenes from 
inputs in the installation. 

•	 In a Ketra with HomeWorks QS installation, you can import the scenes into HomeWorks QS and 
assign them to Lutron keypads.

•	 In a Ketra Only installation, you can assign the scenes to Ketra keypad buttons, contact-closure 
inputs, and shows. 

continued on next page
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To utilize your configured outputs, follow these steps: 

1	 On Design Studio’s Organization tab, move the outputs to their appropriate places in the 
groups hierarchy. Use the Cut, Copy, and Paste buttons to move the outputs between groups.

fig. 149

2	 Navigate to Device Control > Scenes.

fig. 150

3	 Select a scene from the My Scenes panel (left).

4	 In the scene’s grouping tree, highlight a group containing third-party lighting outputs.

5	 In the color picker (right), select the 3rd Party Outputs tab. 

continued on next page
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6	 Customize the scene as needed. 

fig. 151

For information on deploying the scene in a Ketra Only installation, see:

•	 Programming Ketra Keypads > Assigning a Scene, page 104

•	 Building Shows > Setting Scenes for Time Triggers, page 87

•	 Any section dealing with contact-closure inputs. Although you can assign the scene to any kind 
of CCI, not just sensors, the Occupancy/Vacancy Sensors section of this manual, page 113, gives  
a good generic overview on assigning scenes to CCIs. 

To deploy the scene in a Ketra with HomeWorks QS installation, just click Publish and Save, then 
import the Design Studio installation into HomeWorks QS. In that software, you will be able to 
assign the scene to a Lutron keypad.
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All Analog Integration Profiles

Contents

Contact-Closure Input  
Profiles			       131

0-10V and 0-24V Input  
Profiles			       132

Contact-Closure Output 		
Profiles			       134

0-10V Output Profiles	     135

The N3 Satellite enables the Ketra system to integrate with a 
significant number of sensors, relays, building management 
systems, and third-party lighting devices. Some of these 
integrations are covered in more detail in Enabling Sensor Control, 
page 113, Enabling Emergency Mode Lighting, page 118, and 
Integrating Third-Party Lighting, page 122. 

For other uses of the N3’s analog integration profiles, reference the 
table below as a guide to which profile to select.

Contact-Closure Input Profiles

Profile Use Profile for... Effect Ports
Occupancy Mode 
(Configure 2 scenes)

Occupancy sensor  
whose groups are NOT 
also controlled by a  
Ketra keypad

When vacancy detected, sets 
groups to one scene or show; when 
occupancy detected, sets groups to 
another scene or show

1

Occupancy Mode 
(Linked to Keypad)

Occupancy sensor whose 
groups ARE also controlled 
by a Ketra keypad

When vacancy detected, sets groups 
to off and modifies keypad state; 
when occupancy detected, sets 
groups to designated scene or show 
and modifies keypad state

1

Vacancy Mode 
(Configure 1 scene)

Vacancy sensor  
whose groups are NOT 
also controlled by a  
Ketra keypad

When vacancy detected, sets groups 
to scene or show

1

Vacancy Mode  
(Linked to Keypad)

Vacancy sensor whose 
groups ARE also controlled 
by a Ketra keypad

When vacancy detected, sets groups 
to off and modifies keypad state

1

Emergency Mode Emergency inverter When switched, sets enabled Ketra 
lights to Emergency Mode

1

Automated Demand 
Response

Automated Demand 
Response management 
system

When ADR signal received, dims 
lights by a designated scale factor

1

Master Intensity  
Off Trigger

Device that sets a single 
intensity level for groups 
(including but not 
necessarily 0%)

When switched, sets groups  
to desired intensity

1

continued on next page
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Contact-Closure Input Profiles (Cont'd)

Profile Use Profile for... Effect Ports
Master Intensity  
On/Off Triggers

Device that sets one of 
two intensity levels for 
groups at a time  
(including but not 
necessarily 0% and 100%)

When switched, sets groups to one 
intensity level or the other

1

1:1 Mode  
(Recall 2 scenes)

Device that triggers 1-2 
scenes/shows

Two scene/show triggers: one for 
the normal state, and one for the 
switched state

1

2 Port Linked Mode 
(Recall 4 scenes)

Device that triggers 1-4 
scenes/shows

Four scene/show triggers: one  
for Normal-Normal, one for 
Switched-Normal, etc.

2

3 Port Linked Mode 
(Recall 8 scenes)

Device that triggers 1-8 
scenes/shows

Eight scene/show triggers: one  
for N-N-N, one for S-N-N, etc.

3

4 Port Linked Mode 
(Recall 16 scenes)

Device that triggers 1-16 
scenes/shows

Sixteen scene/show triggers: one  
for N-N-N-N, one for S-N-N-N, etc.

4

0-10V and 0-24V Input Profiles

Profile Use Profile for... Effect Ports
Occupancy Mode 
(Configure 2 scenes)

Occupancy sensor 
outputting 0-10/0-24V 
whose groups are  
NOT also controlled by  
a Ketra keypad

Mimics contact closure. When 
vacancy detected, sets groups to 
one scene or show; when occupancy 
detected, sets groups to another 
scene or show

1

Occupancy Mode 
(Linked to Keypad)

Occupancy sensor 
outputting 0-10/0-24V 
whose groups ARE  
also controlled by a  
Ketra keypad

Mimics contact closure. When 
vacancy detected, sets groups to  
off and modifies keypad state; when 
occupancy detected, sets groups 
to designated scene or show and 
modifies keypad state

1

Vacancy Mode 
(Configure 1 scene)

Vacancy sensor outputting 
0-10/0-24V whose groups 
are NOT also controlled by 
a Ketra keypad

Mimics contact closure. When 
vacancy detected, sets groups  
to scene or show

1

Vacancy Mode  
(Linked to Keypad)

Vacancy sensor outputting 
0-10/0-24V whose groups 
ARE also controlled by a 
Ketra keypad

Mimics contact closure. When 
vacancy detected, sets groups to  
off and modifies keypad state

1

continued on next page
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0-10V and 0-24V Input Profiles (Cont'd)

Profile Use Profile for... Effect Ports
Ketra Dimming 
Photocell  
(Master Intensity) 
0-10V Input Only

Ketra photocell whose 
groups are NOT controlled 
by a Ketra keypad

Makes intensity of groups 
proportional to input voltage

2

Ketra Dimming 
Photocell  
0-10V Input Only

Ketra photocell whose 
groups ARE controlled by 
a Ketra keypad

Makes master intensity of groups 
proportional to input voltage

2

Intensity Non-Ketra photocell  
or other intensity  
control whose groups  
are NOT controlled by  
a Ketra keypad

Makes groups’ intensity proportional 
to input voltage

1

Master Intensity Non-Ketra photocell  
or other intensity  
control whose groups  
are NOT controlled by  
a Ketra keypad

Makes groups’ intensity proportional 
to input voltage

1

Master Intensity  
Off Trigger

Device outputting 
0-10V/0-24V that sets a 
single intensity level for 
groups (including but not 
necessarily 0%)

Mimics contact closure. Sets groups 
to desired intensity when 0V 
received from input

1

Master Intensity  
On/Off Triggers

Device outputting 
0-10V/0-24V that sets  
one of two intensity 
levels for groups at a 
time (including but not 
necessarily 0% and 100%)

Mimics contact closure. Sets groups 
to a min intensity level at a low-
voltage threshold, high intensity 
level at a high-voltage threshold

1

1:1 Mode  
(Recall 2 scenes)

Device outputting 
0-10V/0-24V that triggers 
1-2 scenes/shows

Mimics contact closure. When  
0V, sets groups to one scene/show; 
when 10V, sets groups to another 
scene/show.

1

2 Port Linked Mode 
(Recall 4 scenes)

Device outputting 
0-10V/0-24V that triggers 
1-4 scenes/shows

Mimics contact closure. One scene/
show for 0V-0V, one for 10V-0V, etc.

2

3 Port Linked Mode 
(Recall 8 scenes)

Device outputting 
0-10V/0-24V that triggers 
1-8 scenes/shows

Mimics contact closure. One scene/
show for 0V-0V-0V, one for 10V-0V-
0V, etc.

3

4 Port Linked Mode 
(Recall 16 scenes)

Device outputting 
0-10V/0-24V that triggers 
1-16 scenes/shows

Mimics contact closure. One scene/
show for 0V-0V-0V-0V, one for 
10V-0V-0V-0V, etc.

4

continued on next page



DESIGN STUDIO 3.0134

DESIGN STUDIO 3.0 
COMMISSIONING AN INSTALLATION

0-10V and 0-24V Input Profiles (Cont'd)

Profile Use Profile for... Effect Ports
Master Intensity  
Off Trigger

Device outputting 
0-10V/0-24V that sets a 
single intensity level for 
groups (including but not 
necessarily 0%)

Mimics contact closure. Sets  
groups to desired intensity when  
0V received from input

1

Master Intensity  
On/Off Triggers

Device outputting 
0-10V/0-24V that sets one 
of two intensity levels for 
groups at a time (including 
but not necessarily 0% and 
100%)

Mimics contact closure. Sets groups 
to a min intensity level at a low-
voltage threshold, high intensity 
level at a high-voltage threshold

1

RGB -  
Red, Green, Blue

Device that controls color 
(RGB)

Syncs Red, Green, Blue values  
to voltage at each port

3

RGBI - Red, Green,  
Blue, Intensity

Device that controls color 
(RGB) and intensity

Syncs Red, Green, Blue, Intensity 
values to voltage at each port

4

RGBW - Red,  
Green, Blue, White

Device that controls color 
(RGB) and vibrancy

Syncs Red, Green, Blue, Vibrancy 
values to voltage at each port

4

CCT (2000K-10000K) Device that controls  
color (CCT)

Syncs CCT value to voltage 1

CCTI (2000K-10000K, 
Intensity)

Device that controls color 
(CCT) and intensity

Syncs CCT, Intensity values  
to voltage at each port

2

CCTDuvl 
(2000K-10000K,  
Tint, Intensity)

Device that controls color 
(CCT), tint, and intensity

Syncs CCT, Tint, Intensity values  
to voltage at each port

3

Contact-Closure Output Profiles

Profile Use Profile for... Effect Ports
1:1 Mode Any device that  

requires a contact  
closure connection

Can be added to groups, configured 
in scenes, and then added to input 
triggers (including keypad buttons, 
contact-closure inputs, and shows)

1

Ketra Power  
Pack Mode

Devices controlled 
through on/off with a 
Ketra Power Pack (KL14)

Can be added to groups, configured 
in scenes, and then added to input 
triggers (including keypad buttons, 
contact-closure inputs, and shows)

1
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0-10V Output Profiles

Profile Use Profile for... Effect Ports
Intensity Device or fixture that 

turns off on its own at  
0V, not requiring an 
additional port to turn  
off power at 0V

Can be added to groups, configured 
in scenes, and then added to input 
triggers (including keypad buttons, 
contact-closure inputs, and shows)

1

0-10V + CC Device or fixture that uses 
a non-Ketra power pack  
to turn on/off.

Requires 2 ports: 1 for 0-10V out,  
1 for CCO

2

0-10V + Ketra  
Power Pack

Device or fixture that uses 
a Ketra Power Pack (KL14) 
to turn on/off.

Requires 2 ports: 1 for 0-10V out,  
1 for CCO

2



DESIGN STUDIO 3.0136

DESIGN STUDIO 3.0 
COMMISSIONING AN INSTALLATION

DMX Integration

Contents

DMX Input		      136

Wireless Patching  
Limitations		      137

DMX Input Instructions	     139

DMX Output		      141

The Ketra N3 Satellite bridges external DMX systems and Ketra. The 
N3 can be configured as DMX master or slave, and receive or output 
a full universe of DMX512-A. 

This section covers necessary configurations in Design Studio 
and Tech Tool before the N3 can receive or deliver DMX data. For 
guidelines on wiring a DMX network external to the Ketra system, 
refer to our DMX Control Support with Ketra app note. 

•	 Web link (Requires Internet access)

•	 Appendix B, page 199 

DMX Input

Some configurations in Design Studio are required before a DMX source can begin controlling  
the Ketra system. DMX sources interface with the Ketra system via the N3 Satellite. The N3 can take 
a full universe of DMX-512A, and Ketra provides a high number of profiles to account for a variety  
of situations. 

Before making any configurations, make sure you know what parameters the DMX source is 
outputting and also what channels it will be using to talk to the Ketra system.

The N3 Satellite will listen to whichever channels you specify in Design Studio, then convert the 
input data to color and intensity configurations to propagate (“patch”) to Ketra groups. You can  
set up multiple profiles and map their configurations to as many groups as needed. 

Example:

N3 Satellite

Group A: RGBW, channels 1-4
Group B: RGBW, channels 1-4
Group C: CctDuvl, channels 5-7
Group D: [no patch]

Configurations set 
in Design Studio:

DMX Input 
Channels 1-7

Group A 
RGBW

Group B 
RGBW

S30

S30

A20

Group C 
CctDuvl

S38

D3

D3

Group D 
[no patch]

A20

D3

D3

fig. 152

https://cdn2.hubspot.net/hubfs/4094434/Ketra%20February2018/Pdf/DMX%20Control%20Support%20with%20Ketra.v4.pdf
https://cdn2.hubspot.net/hubfs/4094434/Ketra%20February2018/Pdf/DMX%20Control%20Support%20with%20Ketra.v4.pdf
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Important Notes:

•	 If any of the groups to which the N3 will patch DMX contain wireless devices (Ketra lamps, 
downlights, or other N3 Satellites), you will experience time delays and you may also  
encounter restrictions on which groups you can patch. These are covered in Wireless Patching 
Limitations, below.

•	 If you intend to use the DMX source to fade Ketra lights, set the source’s fade time to 0. Fade 
needs to be configured as a parameter taking up a channel, such that the N3 (rather than the 
DMX controller) can execute the fade. 

If the N3 Satellite will only be patching DMX to directly-attached luminaires or onboard analog 
outputs, skip to Enabling DMX Input, page 139. 

Wireless Patching Limitations

If the N3 Satellite will be relaying DMX input wirelessly (even if it will also be relaying DMX 
commands by wire), all of the following limitations apply.

Wireless broadcasting incurs a time delay.  
The N3 relays DMX input over KetraNet Mesh in 55-channel data frames, one frame at a time. In 
most cases, the first frame broadcasts immediately. After the first frame, each additional frame 
requires up to 1.5 seconds to broadcast. Once all frames have been broadcast, a final “go” command 
is issued and all of the affected lighting products change state in unison. 

Note: The 1.5-second delay occurs between all broadcasts. Therefore, the first 55-channel 
frame will only experience a delay if the N3 Satellite broadcast a frame from another 
command less than 1.5 seconds previously.

To calculate the maximum delay possible (in seconds), use the following four-step calculation: 

1	 Divide the number of DMX channels the N3 is listening to by 55. 

2	 Round up to nearest whole number.

3	 Multiply the result by 1.5.

4	 Subtract 1.5 to represent the first frame, assuming no other frame was broadcast within 1.5 
seconds previously.

T = 1.5 x ceil (  ) - 1.5
n

55

where n is the number of DMX 
channels the N3 is listening to

fig. 153

continued on next page

Example: In the diagram pictured in fig. 152 (previous page), an N3 patches channels 1-4 (RGBW) to 
Groups A and B, and it patches channels 5-7 (CctDuvI) to Group C. The number of channels to which 
the N3 is listening is 7. Since 1.5 x ceil (7/55) - 1.5 = 0, there will be no detectable delay between the 
start of transmission and the time when the lights change color.
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Note: If the N3 patches DMX input by wire and KetraNet Mesh, the wired communication 
speed will downgrade to match the KetraNet Mesh speed. This ensures that all devices 
change in sync.

Fade rates must be sent as a parameter.  
Due to the wireless latency discussed above, initiating a fade up or fade down from a DMX  
console may result in the wireless Ketra lights making large steps in intensity rather than  
smoothly transitioning. 

To ensure a smooth transition, Ketra offers profiles that include a fade rate parameter (e.g., RGBIF). 
When the N3 Satellite receives the DMX input, it will relay the fade value to Ketra groups; when the 
“go” command is given, the groups will transition to the desired color and intensity over the period 
of time set by the fade rate parameter. 

This enables you to calculate the expected wireless latency using the formula in fig. 153, then send 
the DMX values that far in advance of when a transition should occur. Most DMX controllers include 
timeline editing and can support this use case.

Example: A DMX512 theatrical console outputs 60 bytes of data on 60 channels, including several 
that control fade rates for various groups. The N3 will broadcast the input over KetraNet Mesh 
with a wireless latency of 2.7 seconds. You can set a trigger on the theatrical console to output 
information to the Ketra system 2.7 seconds before the desired transition. All Ketra lights will 
change in unison at the expected time.

Only 1 N3 Satellite can wirelessly patch input per KNet. 
There are restrictions on the number of N3 Satellites that can patch DMX input wirelessly to 
unattached groups or other N3s.

Restrictions (for the number of N3s wirelessly relaying DMX commands) 

Installation with a single N4 Hub Installation with multiple N4 Hubs
•	 No more than one N3 can  

wirelessly relay DMX commands.
•	 Each KNet can include no more than one N3 

Satellite wirelessly relaying  
DMX commands.

•	 Also, each KNet can support wirelessly-relayed 
DMX commands from no more than one N3 
Satellite. (That is, no KNet can have some devices 
receiving wireless DMX from one N3 as well as 
other devices receiving wireless DMX from a 
different N3.)

continued on next page
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Fig. 154 illustrates a valid DMX setup in an installation with multiple N4 Hubs. An N3 Satellite in KNet 
1 wirelessly relays DMX commands to groups in both KNet 1 and KNet 2. Fig. 155 shows the same 
setup slightly altered to be invalid.

continued on next page

N3 Satellite

DMX Device

N4 Hub N4 Hub

Group 1

KNet 1 KNet 2

Group 2

Group 3

Other Ketra 
devices

Other Ketra 
devices

N3 Satellite

DMX Device

N4 Hub N4 Hub

KNet 1 KNet 2

Group 1

Group 2

Group 3

N3 Satellite

DMX Device

N4 Hub N4 Hub

KNet 1 KNet 2

N3 Satellite

DMX Device

Group 1 Group 4

Group 2

Group 3

N3 Satellite

DMX Device

N4 Hub N4 Hub

KNet 1 KNet 2

N3 Satellite

DMX Device

Group 1 Group 4

Group 2

Group 3

Fig. 154’s DMX wireless setup is valid: it meets both rules 
for installations with multiple N4 Hubs.

fig. 154

Fig. 155’s DMX wireless setup is invalid: KNet 2 violates 
the second rule, because some of its devices receive 
wireless DMX from one N3 Satellite while others receive 
them from a different N3 Satellite. 

fig. 155

DMX Input Instructions

To configure an N3 Satellite to accept DMX input, follow these steps (see fig. 156, next page):

1	 Go to Device Control > Integration.

2	 Select the N3 Satellite. At this step, satellites will not identify themselves by flashing indicator 
lights when selected.

3	 Select a group to patch with DMX input. Design Studio removes groups from the Available 
Groups list if they violate the rule that each KNet can only receive wireless DMX patches from 1 
N3 Satellite.

Notes: 

–– When patching additional groups, you will be able to reuse these input channels. However, 
avoid patching DMX to multiple groups that overlap, e.g., parent and child groups.

–– Groups that contain analog outputs or dimmers, or whose subgroups contain analog 
outputs or dimmers, can only be controlled by intensity profiles.

4	 Select a DMX profile for the group. 

Note: To perform fades on wireless Ketra devices, pick a profile with the ‘F’ (Fade) parameter. 
The DMX source should be configured to output fade rates as a parameter rather than 
executing the fades itself. For more details, see Wireless Patching Limitations , page 137.
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5	 Set the profile’s starting channel. Based on the profile you chose, Design Studio will 
automatically determine the number of additional channels to listen to for input data.  
 
Example: The DMX source outputs 8-bit red, blue, green, and white values on channels 14-17. In 
Design Studio, the profile and starting channel should be RGBW, channel 14. 

6	 Optional: Set Brightness Override or DMX Refresh. 

–– Enable Brightness Override: This grants the DMX source full control of the group’s  
intensity. The source’s intensity commands will override those of any Ketra devices like 
keypads or shows.

–– Enable DMX Refresh: This ensures that the group will return to its current DMX values  
within 10 seconds if changed from another control source. Do not use this if a keypad also 
controls the group. The primary use case for this feature is to enable you to test lighting 
content from Design Studio, knowing that the lights will revert back to their DMX values 
within 10 seconds.

7	 Click Set. A checkmark should appear next to the group. 

1 5

6

2

7

3

4

fig. 156

8	 Repeat steps 3-7 for other groups as needed. You can reuse channels for separate profiles. For 
example, Group A might be patched an RGBI profile (red, green, blue, intensity) for channels 4-7, 
while Group B is patched an IF (intensity, fade) profile for channels 7-8. Both profiles use channel 
7 for intensity.  
 

continued on next page
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This ability to overlap profiles can reduce wireless latency delay by lowering the number of 
channels the N3 has to broadcast. However, it can also cause problems if you accidentally 
overlap profiles that shouldn’t overlap. In the example above, Group B would behave 
unexpectedly if it were patched CctDuvI for channels 7-9. We recommend keeping track of the 
profiles you use and the channels they correspond to.

9	 Click Publish and Save in the top-right corner. Your configurations will take effect as soon as 
you publish. However, if you’ve selected a profile with Fade Rate and the fade channel is set to a 
very long fade, you may not see the devices respond immediately.

continued on next page

fig. 157

DMX Output

Note: The N3 Satellite can be configured for DMX output in both Ketra Only and Ketra with 
HomeWorks QS installations. 

An N3 Satellite properly configured for DMX output enables the Ketra system to control third-party 
lighting and other devices. The N3 can output a full universe of DMX-512A using a variety of profiles. 
It will refresh the receivers’ settings at a rate of 44 Hz (i.e., 44 times per second) to ensure quick 
correction of any transmission errors. 

For every scene in the installation, you can define specific output settings for each DMX profile 
range. An example application would be that when a user presses Scene 2 on a Ketra or HomeWorks 
QS keypad, the N3 Satellite sends out 0, 119, and 255 for an RGB profile on channels 1-3; this would 
cause any RGB-enabled receivers listening to those channels to go to an aqua color. 

Not including wiring, the workflow is as follows:

1	 Configure profile ranges for DMX output in Ketra Tech Tool.

2	 Sort each profile into a Ketra group in Design Studio.

3	 Customize each group as part of a scene in Design Studio. 

4	 Assign the scene to an input source, i.e., a HomeWorks QS keypad button, Ketra keypad button, 
contact-closure input, or time trigger in a show. 
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1	 Configure profile ranges in Tech Tool

i	 Open the installation in Ketra Tech Tool.

ii	 On the DMX Output tab, select an N3 Satellite to configure.

iii	 Click Add New Profile.

continued on next page

fig. 158

iv	 Set the profile and channel range, then give the profile a descriptive name. The name will 
help you identify the profile later on when adding it to groups. 
 
When selecting a profile, reference the table below as a key to the profile parameters.  
(Step 1 continued after table)

DMX Profile Parameters

Symbol Parameter Name Range
(Min = 0, Max = 255 8-bit  
or 65535 16-bit)

Implementation Notes

Color Parameters

R Red Min: Off, Max: Red LED to  
full intensity

G Green Min: Off, Max: Green LED to 
full intensity

B Blue Min: Off, Max: Blue LED to  
full intensity

W White Min: Off, Max: White LED to 
full intensity

A Amber Min: Off, Max: Amber LED to 
full intensity



DESIGN STUDIO 3.0143

DESIGN STUDIO 3.0 
COMMISSIONING AN INSTALLATION

X CIE 1931 x 
coordinate

Min: 0.0, Max: 1.0

Y CIE 1931 y 
coordinate

Min: 0.0, Max: 1.0

Cct Color 
temperature

Min: 2000K, Max: 9970K or 
10000K (8-bit vs. 16-bit)

Duv Tint (distance 
from the black 
body locus)

Min: -0.05, Max: +0.0496 At 50% (127 for 8-bit, 32768 for 16-
bit), the tint is +0.00, meaning the 
color temperature is on the black 
body locus

Intensity Parameters

I Intensity Min: 0%, Max: 100% Use if at least one scene will  
set the receivers’ intensity to a 
<100% value

Masteri Master Intensity Min: 0%, Max: 100% Use if all scenes will leave the 
receivers’ intensity at 100%  
unless dimmed from a keypad  
or other input

Symbol Parameter Name Range
(Min = 0, Max = 255 8-bit  
or 65535 16-bit)

Implementation Notes

Other Parameters

V Vibrancy Min: 0%, Max: 100% At 0%, the current color point is 
powered more by the W emitter. 
At 100%, the color point is powered 
more by the RGB emitters. Objects 
illuminated at higher vibrancy 
typically appear more saturated

F Fade Min: 0 seconds, Max: 255 
seconds or 6553.5 seconds  
(8-bit vs. 16-bit)

Generally unnecessary when N3 
is DMX master. Only use if the 
receiving devices require that fade 
times be sent as a parameter

Note: You will only be able to dim third-party lighting controlled by DMX if you choose an 
RGB/RGBA profile or any profile with an intensity parameter (‘I’ or “Masteri”). In RGB/RGBA 
profiles, the minimum value for each channel will turn the corresponding LED off, meaning 
that if all those channels are at 50%, the light will be at 50% intensity. By contrast, a CCT 
parameter’s minimum value does not equate to Off but rather to 2000K, so without an 
accompanying intensity parameter, it will be stuck at 100% intensity.

DMX Profile Parameters Cont'd

continued on next page
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v	 Repeat steps 1.iii-1.iv for additional profiles, one at a time.

vi	 Click Save Current Configuration To Satellite. This assigns your DMX Output configurations 
to the N3. Note that this step will fail if the N3 is not powered on.

fig. 160

continued on next page

fig. 159

2	 Sort profiles into groups in Design Studio

i	 Open the installation in Design Studio. On the Organization tab, you should see your DMX 
outputs in the My Devices list, as shown in fig. 160. 
 
You can think of each of these outputs as representing the DMX receivers listening to the 
channel range. For example, the “RGBA chs. 7-10” output in fig. 160 might represent several 
third-party LEDs with addresses of 7 that are listening for RGBA input. It might be more 
intuitive to imagine sorting those into a group rather than sorting the profile into a group.
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ii	 Sort the profiles into groups using the Cut/Copy/Paste buttons or shortcuts. The buttons 
and corresponding shortcuts are shown in fig. 161. Note that you can have the same profile 
in multiple groups if needed. For example, you could use third-party lights as everyday 
lighting and safety lighting. 

continued on next page

fig. 161

3	 Customize the DMX outputs in scenes (See fig. 162)

i	 Go to Device Control > Scenes.

ii	 Select a scene in the My Scenes panel, or create a new one.

iii	 Select a group from the scene’s grouping hierarchy that contains a DMX output profile. 

Note: The group’s color and intensity settings do not apply to the DMX output, only to 
Ketra lights. If the group shows a color and intensity setting of blue, 50%, the DMX output 
will remain at its default unless you go to the 3rd Party Outputs tab as covered in step 3.4 
and make changes there. 

iv	 In the color picker panel on the right, click the 3rd Party Outputs tab. You should see the 
profile’s parameters as adjustable values. 

Note: If you created a new scene and the group defaulted to NA, you will need to click 
the + icon next to the group’s name before you can see the appropriate DMX sliders for 
the group. 

v	 Configure the information the N3 Satellite will send out on each channel when the scene  
is triggered. 
 
Example: In fig. 162, when a user triggers the Hangout scene, the N3 Satellite will output the 
values 153, 0, 153, and 0 on channels 7-10 (since Group 1 contains the output “RGBA chs. 7-10”). 
The receiving devices should be configured to interpret data from those channels as red, 
green, blue, and amber, respectively. 
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Note: Using the intensity slider at the top of the color picker panel will only affect the 
group’s Ketra lights. To control the DMX output’s intensity, use the profile’s intensity 
parameter or lower all of its RGB/RGBA values equally.

vi	 Configure the number of seconds it will take the selected output’s corresponding receivers 
to transition to the scene. This is done using the "Fade" text field. Example: In fig. 162, when 
a user triggers the Hangout scene, the receiving devices will transition from their current 
state to their Hangout state over the course of 2 seconds.

vii	 Repeat steps  3.iii-3.vi for any additional groups DMX outputs.

viii	 In the top-right, click Publish and Save.

fig. 162

Intensity slider does 
not affect DMX outputi
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4	 Assign the scene to an input trigger 
You can assign the scene to any of the following:

–– A HomeWorks QS keypad button (through the HomeWorks QS software)

–– A Ketra keypad button

–– A contact-closure input

–– A time trigger in a show
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Integrating with Lutron

Design Studio 3.0 supports LAN (local area network) integration 
with HomeWorks QS and Quantum control systems. After 
integration, these systems will be able to control Ketra by playing 
scenes and shows, raising/lowering intensity, and toggling power 
for Ketra groups. 

Both types of integration (HomeWorks and Quantum) require that 
you commission an installation in Design Studio and then import it 
into the appropriate Lutron commissioning software (HomeWorks 
QS for HomeWorks, Q Design for Quantum). Specific instructions 
and references for each are included in the sections below.

Note: If you import a Ketra installation into the Lutron 
software and subsequently make changes in Design Studio, 
you will need to re-import the installation. 

Integrating with HomeWorks QS

To integrate Ketra with HomeWorks QS, refer to Lutron’s thorough app note on the subject 
(“Integrating Ketra productions into HomeWorks QS Systems,” #696):

•	 Web link (Requires Internet access)

•	 Appendix A, page 178

We also recommend reading Enabling Control of Multiple Groups, page 150, if you intend to use 
individual triggers (e.g., keypad buttons) to control multiple Ketra groups.  

Integrating with Quantum

To integrate a Design Studio installation with Quantum, you have to export a command set from 
Design Studio, enable at least one N4 for telnet communication, import the command set into 
Lutron’s Q Design software, and then link the command set to an N4.

Exporting a Command Set from Design Studio

A Design Studio command set lists every possible action that can be performed on every possible 
group. For example, “Group A-Intensity Up” or “Group B-Scene 1” might be lines in your command 
set. Once you import this list into Q Design, the Quantum system will be able to send any of these 
commands to an N4 Hub via telnet. 

Caution: A command set is a static snapshot. If you make changes to the installation after 
exporting, you should also export a new command set, import that into Q Design, and link 
it to the N4.

Contents

Integrating with  
Homeworks QS		      147

Integrating with 
Quantum		      147

Exporting a Command  
Set from Design Studio	     147

Enabling N4 Hubs 
for Telnet Integration	     149

Enabling Control of 
Multiple Groups		      150

continued on next page

http://www.lutron.com/TechnicalDocumentLibrary/048696.pdf
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fig. 163

Leave as default1

2

3
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When you export a command set, Design Studio creates one or more CSV (spreadsheet) files. The 
number of CSVs determines the number of N4s you will need to enable for telnet in the next step. 

For now, follow these instructions to export a command set:

1	 Navigate to Device Control > Integration.

2	 Select any N4 Hub from the My Control Devices list. At this point, it doesn’t matter which N4 
you select. 

3	 In the Telnet Configuration pane, confirm that the Max Export Lines, Max Command Name 
Length, and Export Format fields look like fig. 163. 

Note: You can modify those fields, but Q Design will not accept CSVs with more than 1500 
lines, or commands with names longer than 50 characters. 

4	 Click Export.

5	 Click Proceed in any popup windows.

6	 In the Save As window, select a place to save the CSV(s) and click Save.
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Enabling N4 Hubs for Telnet Integration

Quantum telnet commands reach the Ketra system via the N4 Hub. The hub then propagates those 
commands wirelessly to other Ketra devices. 

This setup requires that you enable telnet on 1 N4 per CSV. For example, if the export generates 3 
CSV files, you should enable telnet on 3 N4s. It doesn’t matter which N4s you choose, because any 
hub is capable of relaying commands to others as necessary.

To see the number of CSVs that were automatically generated when you exported your command 
set, use the Windows File Explorer to navigate to the command set’s folder. 

To enable telnet on an N4, follow these steps: 

1	 Navigate to Device Control > Integration.

2	 Select any N4 Hub from the My Control Devices list. Again, it doesn’t matter which N4 you pick, 
because any N4 can relay commands to any other N4.

3	 In the Telnet Configuration pane, set the username and password that the N4 will look for in 
each command. If you have already set a telnet username and password in Q Design, use the 
same values here.

Note: Telnet is not encrypted. Do not use sensitive passwords.

4	 Optional: Change the port number for the integration. Use port 23 unless told otherwise by a 
facility IT administrator. 

5	 Click Enable Telnet.

fig. 164
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6	 If necessary, repeat steps 2-5 for additional N4 Hubs. You should enable telnet for 1 N4 per CSV 
file in the command set.

7	 Click Publish and Save in the top-right corner of the screen. 

Note: We recommend keeping Design Studio open as you perform the remaining integration 
steps in Lutron Q-Design. If not, make a note of the telnet-enabled N4s’ serial numbers and IP 
addresses before closing Design Studio. IP addresses can be found on the Organization tab by 
selecting the hub in the My Devices panel. 

For instructions on integrating third-party products with the Quantum system through Q Design, 
refer to the relevant Lutron documentation. 

Caution: Telnet integration requires that the N4 Hub keep the same IP address over time. 
To accomplish this, you can either set a static address for the N4 (see Setting Static IP 
Addresses for Hubs, page 28) or reserve an address in the DHCP server. If you do not do so, 
your integration will stop working as soon as the hub’s address changes.

Enabling Control of Multiple Groups 

Note: This section discusses control groups, a feature that is only useful for installations that 
integrate with Lutron control systems. If you are not integrating with Lutron, you do not 
need to use control groups. 

Design Studio control groups make it easier to program a Lutron keypad button to control multiple 
Ketra groups. Control groups are created in Design Studio, then implemented in HomeWorks QS or 
Q Design.

Example: If you wanted a Lutron keypad button to control your Kitchen and Dining Room  
groups, you could create a Kitchen + Dining control group. In the Lutron commissioning software, 
you would then assign the scene to Kitchen + Dining, thereby having it affect the kitchen and  
dining room. 

To create and configure a control group in Design Studio, follow these steps:

1	 In the Design Studio installation, navigate to Device Control > Control Groups.

2	 Click Create New Control Group. (See fig. 165, next page.)

3	 Use the checkboxes to set the groups you want to include in the control group.

4	 Click Publish and Save in the top-right corner. 
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After following these steps, you may need to re-import the installation into Lutron’s commissioning 
software. For Quantum systems, that requires exporting a command set and then importing the CSV 
into Q Design. For HomeWorks systems, you don’t have to export anything from Design Studio; just 
re-import the Ketra installation into HomeWorks QS. 

Note: Control groups do not appear in the installation’s grouping hierarchy in Design Studio. 
You can only see them by going to Device Control > Control Groups.

fig. 165
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Publishing: Saving Configurations  
to Devices

Contents

Problems While Publishing   153

Publishing saves configurations to your devices as default states. 
Without publishing, most Ketra devices will return to their default 
states when power-cycled. For example, if you program a Ketra 
keypad in Design Studio but never publish, a power outage would 
cause the keypad to return to an unprogrammed, blank state. 

Note: Publishing is an important last step to any changes that you make in Design Studio. 
However, it is not the only recommended way of saving progress in an installation. See Part 
Four: Saving Your Progress, page 168, for more details.

In large installations, publishing can take a long time because it requires Design Studio to 
communicate with every device.

To receive their new defaults, the devices you are publishing to must be powered on.

You can publish from any Device Control tab, as well as the Organization tab, by clicking Publish 
and Save in the top-right corner of the screen.

fig. 166
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Problems While Publishing

Design Studio may encounter errors while attempting to publish, in which case you will see a screen 
saying “There was a problem with configuring your devices,” as well as a list of the specific devices 
that failed to publish. Below each device in the list is a brief summary of why the device failed to 
publish, and recommended steps for fixing the problem. For an example, see fig. 167.

In this screen, you have the options to Ignore, Retry, or Retry All.

• Ignore dismisses all errors while publishing.

Caution: Devices may not function properly until published successfully. Do not click Ignore 
until retrying publishing. If devices repeatedly fail publishing, we recommend confirming 
that they are receiving power, and then (if they are receiving power) running diagnostics. 
See Running Diagnostics, page 172. 

• Retry allows you to redo publishing for a specific device. First highlight the device in the list, and
then click Retry.

• Retry All allows you to retry publishing for all devices in the problem list.

If problems persist, you can perform a diagnostics check. See Running Diagnostics, page 172.

fig. 167
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Collaborating with Other Users

PART 3: MAINTAINING AN INSTALLATION

Contents

Version Control  
Through Syncing	     154

Viewing an Installation's  
Sync Status		      155

Collaboration Guidelines	    155

Sharing Access 
to an Installation	     157

Viewing an Installation's  
Authorized Users	     158

Revoking Access   
Permissions		      158

Version Control Through Syncing

In any collaborative software, version control is essential. Version 
control refers to any method of keeping a file in-sync between 
multiple users or computers, so that no one makes changes to an 
outdated file version. 

Ketra does version control using a cloud backup of every installation. 
Any computer can quickly sync with the cloud over Internet 
connection—i.e., pull the latest changes (sync down) or push its own 
updates (sync up). This enables collaboration without flash drives or 
other forms of manual file transfer.

Design Studio attempts to sync with the cloud at two different times:

•	 It syncs down whenever you open an installation. Syncing down overwrites your computer’s 
local file with the cloud backup.

•	 It syncs up whenever you close out of the installation (by returning to the Existing Installations 
list or exiting Design Studio). Syncing up overwrites the cloud backup with your computer’s  
local file.

Caution: Cloud-based version control streamlines collaboration, but it also comes with its 
own risks. To avoid potential data loss, we recommend reading Collaboration Guidelines, 
page 150.

Cloud Backup

Local Copy Local Copy

Syncing enables version control across machines

fig. 168
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Viewing an Installation’s Sync Status

You can see the sync status of your installations in the Existing Installations menu. 

fig. 169

There are three possible statuses:

•	 Sync Successful: When Design Studio last checked, your copy of the installation was up to date 
with the cloud backup. 

Caution: Sync Successful does not necessarily mean you have the latest version of  
the installation. 

–– If you opened Design Studio without Internet access, the attempt to check your 
installation against the cloud will fail. However, the “Sync Successful” label will hold 
over from the last successful check. 

–– If another computer has made changes without syncing up, the cloud backup itself 
is outdated, and so is your local file. Since the out of date backup matches your out 
of date file, you will see the “Sync Successful” label in Design Studio.

•	 Sync Pending: Changes to your installation have been saved locally on your computer but not 
synced up to the cloud. No other computer will be able to see your changes. Your changes will 
be synced up the next time you open Design Studio with Internet access. Alternatively, once 
acquiring Internet access, you can right-click the installation in the Existing Installations list and 
select Sync Now.  

•	 Sync Required: Your copy of the installation is out of date compared to the cloud backup. You 
must sync down before you can access the installation. 

Collaboration Guidelines

Ideally, each installation’s cloud backup is 100% up to date. However, if the backup is out of date 
because a computer has made changes but not synced, another computer might pull the outdated 
copy of the installation. This can end up causing significant data loss. For an example of how this 
might happen, see the “Wrong” column of the table below. 

To avoid that situation, follow the guidelines below.

•	 If possible, ensure that all computers editing the installation have Internet access.  
Syncing with the cloud backup requires Internet connection, so all computers editing an 
installation should have Internet access. 

continued on next page
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•	 During commissioning, sync regularly by closing out of the installation and reopening. 
This ensures that both the cloud backup and your local copy of the installation are up to date. 
To sync, confirm that you have Internet access and then follow these steps: 

1	 Close out of the installation. You can do this by returning to the Existing Installations list 
from the sidebar, or closing Design Studio. This triggers a sync up—i.e., it overwrites the 
cloud backup with your version of the installation.

2	 Reopen the installation. This triggers a sync down—i.e., it overwrites your version of the 
installation with the cloud backup.

•	 Always sync from one computer before opening on another. Never have multiple computers 
edit an installation simultaneously.  
Ignoring this recommendation will almost certainly result in data loss. Changes made on one 
computer are not reflected on others in real time. That means that if multiple computers are 
editing an installation file simultaneously, their copies of the file conflict with one another. 
When each computer syncs up to the cloud backup, Ketra will only preserve whichever one 
synced up last.  
 
Example: 

Wrong Correct

1	 Computer A and Computer B are both 
editing Example Installation. Computer A 
works on the Keypads tab while Computer 
B works on the Integration tab.

1	 Computer A is editing the Keypads tab in 
Example Installation.

2	 Computer A closes Design Studio, triggering 
a sync up (backup to the cloud).  
The cloud now has Computer A’s changes  
to the Keypads tab.

2	 Computer A closes Design Studio, triggering 
a sync up (backup to the cloud).  
The cloud now has Computer A’s changes  
to the Keypads tab.

3	 Computer B closes Design Studio, triggering 
a sync up.  
The cloud now has Computer B’s changes 
to the Integration tab, but Computer B’s 
outdated keypad settings have overwritten 
Computer A’s Keypads settings.

3	 Computer B opens Example Installation, 
triggering a sync down (updating local file  
with cloud backup).  
Computer B now has the up to date  
Keypads tab.

4	 Computer A opens the installation in Design 
Studio, triggering a sync down (updating 
local file with cloud backup).  
Computer A now has the up to date 
Integration tab, but all of its changes to the 
Keypads tab are gone.

4	 Computer B edits the Integration tab, then 
closes Design Studio, triggering a sync up.  
The cloud now has Computer B’s changes  
to the Integration tab.

5	 Computer A opens the installation in  
Design Studio, triggering a sync down. 
Both computers have the up to date 
Keypads and Integration tabs.  
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Sharing Access to an Installation

Sharing allows another Design Studio account to access an installation. The account will be able 
to access the installation on-site and remotely (as long as remote access is enabled; see Enabling 
Remote Access, page 159). 

There are two requirements for sharing:

•	 Only the account that created the installation can share access.

•	 Sharing only works when the computer that is trying to share access has an Internet connection.

Note: If you need to share an installation but cannot access the account that created the 
installation, contact Ketra Tech Support. You can reach us Monday through Friday, 9 AM - 5 
PM, CST. Call 1-844-588-6445, or email ketrasupport@lutron.com.

Caution: After sharing, we strongly recommend against having more than one computer 
edit the same installation simultaneously (regardless of whether they are using the same 
or different Design Studio accounts). If that happens, the computer that syncs last will 
overwrite any changes made from the other computer(s).

You can share an installation in one of two ways:

•	 Share from the Existing Installations list

1	 Go to the Design Studio home screen.

2	 Right-click the installation in the Existing Installations list.

3	 Choose Share.

4	 Enter the Design Studio account email address and click Share. A green Success message 
will appear below the email address field to confirm that the installation shared successfully. 

fig. 170

•	 Share from the my.goketra Customer Web Portal

1	 Navigate to https://my.goketra.com.

continued on next page
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2	 Log in if prompted. You should log in with the same Design Studio account that created 
the installation.

3	 In the list of installations, find the installation and click Share.

4	 Enter the Design Studio account email address and click Share.

The user will now be able to access the installation from their Existing Installations list in Design 
Studio and my.goketra. 

Viewing an Installation’s Authorized Users

To see which Design Studio accounts have permission to access an installation, follow these steps:

1	 Navigate to https://my.goketra.com.

2	 Log in if prompted.

3	 In the list of installations, find the installation and click Details.

4	 Look at the list under the Users heading.

Revoking Access Permissions

For security reasons, you may decide to deauthorize an account’s access to an installation file. 
This will remove the file from the user’s Existing Installations list, ensuring that they cannot access 
it to make changes.

Only Ketra Tech Support can revoke access permissions for a Design Studio account. You can reach us 
Monday through Friday, 9 AM - 5 PM, CST. Call 1-844-588-6445, or email ketrasupport@lutron.com.

Note: You can also remove an installation from your account using the Customer Web Portal. 
However, the installation will not be removed from Design Studio until you log out and log 
back in.

mailto:ketrasupport@lutron.com
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Accessing Remotely

If remote access is enabled for an installation, you (and other shared Design Studio users) can 
access the installation file without being on the N4s’ LAN. This enables you to make changes off-
site, perform remote firmware updates, and streamline troubleshooting by Lutron and Ketra tech 
support when needed.

Note: For security, remote access can only be enabled by an on-site computer connected to 
the same network as the N4s.

Note: Accessing the N4s’ LAN remotely requires that the computer and the N4s’ network 
have Internet access.

Only users who have permission to open the installation file—i.e., users with whom the  
installation’s creator has shared the install—can access the installation remotely. As a safety 
measure, someone controlling an installation remotely cannot deprovision or replace N4 Hubs,  
or delete the installation.

If you encounter problems trying to access an installation remotely, see Trouble Accessing an 
Installation, page 170. 

Enabling Remote Access

To enable remote access, follow these steps:

1	 While connected to the N4s’ LAN, open the installation in Design Studio.

2	 Open the installation sidebar by clicking the user icon.

3	 Click Enable Remote Access.

4	 Click Yes.

Ensuring Security with Remote Access Enabled

When remote access is enabled, any Design Studio account that has permission to access the 
installation (i.e., with which the installation’s creator has shared the installation) will be able to do  
so at any time. 

Note: As a security measure, no one accessing an installation remotely can deprovision or 
replace N4 Hubs, or delete the installation. 

If desired, an on-site user can keep remote access off most of the time, only turning it on for 
technical support or scheduled maintenance.
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Updating Firmware

Contents

The Firmware Update Tab    160

Before Updating		     160

Performing an Update	     162

Periodically, Design Studio may prompt you to update your 
Ketra devices’ firmware. Firmware updates can add new device 
functionality and often improve device longevity. 

Firmware updates can be performed on-site or remotely. 
Instructions for both are included in Performing an Update,  
page 162.

The Firmware Update Tab

fig. 171

Repeat query 
for firmware 
status

Filter devices 
by hub

Identify device 
in space

Firmware statusSelect/deselect 
devices to update

As shown in fig. 171, Tech Tool’s Firmware Update page provides a list of your devices and tells you 
whether they need a firmware update. You can perform the update itself from this page as well.

Before Updating

Plan a time to perform the update. 
We recommend performing the update at a time when the space is not in use. The time required to 
update an entire installation varies by the number and type of devices, and may take several hours. 
Lights and control devices will remain functional throughout the update, though you may notice 
lights flashing as they reset.

continued on next page
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Updating may cause lights to go to their default restore states. 
Firmware updates often end with Tech Tool rebooting Ketra lights’ onboard computers. In Ketra 
with HomeWorks QS installations, this will (by default) cause lights to go to whatever their state 
(color and intensity) was before the update. In Ketra Only installations, it will (by default) cause 
lights to go to their default restore states; the unmodified factory default is 3000K, 100% brightness. 
To control your lights’ restore states, see Managing Lighting Power-Restore States, page 59.

Try to resolve any communication issues before updating. 
Use the Diagnostics tool in Design Studio (see fig. 169) before administering the update. If any 
devices fail to communicate, ensure that they are powered on in the installation space. If the 
devices are powered on and can’t communicate after a retry, make a note of their serial numbers. 
You can expect those serial numbers to fail the firmware update. For more details on Diagnostics, 
see Running Diagnostics, page 172.

For remote updates, ensure the installation is remote access enabled. (See fig. 173) 
Remote access must be enabled for the installation before any operations can be performed 
remotely. Enabling remote access must be done on-site, and requires firmware version 1.14 or higher 
on all N4 Hubs. To enable remote access, open the installation in Design Studio, click the user icon in 
the top-left corner to open the sidebar, and click Enable Remote Access. 

fig. 173

fig. 172
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Performing an Update

Note: We recommend reading Before Updating, page 160, before updating firmware.

To perform the update (on-site or remotely), follow these steps:

1	 Open the installation in Ketra Tech Tool.

2	 If performing remotely, click Yes in the remote connection popup.

fig. 174

Note: If this popup does not appear, the installation is not enabled for remote access. 
Enabling must take place on-site within the Design Studio installation, and it requires 
firmware 1.14 or higher on all N4 Hubs. 

3	 In the installation dashboard, check for any warnings in the Status column of the Firmware 
Update tab. Any warnings will appear as clickable links that open additional information about 
the issue. 

4	 In the Update Method dropdown, choose "Upgrade From Control Device(s)". A general estimate 
of update time is in the lower left. 

5	 Click Start. Tech Tool will first update your installation’s N4s, and then the N4s will propagate 
the update to the devices on their KNets. 

35

4

fig. 175

continued on next page
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6	 Keep Tech Tool open at least until the box at lower left turns green. That indicates that the N4 
Hubs have been updated. They will now update the rest of the installation in parallel. 
 
When the box turns green, you can close Tech Tool. (You will not be able to use Design Studio 
until after the update.)

Note: If older lights are later added to the installation, they will need to be updated before 
you can set any configurations. Until they receive the update, the Device Settings and Device 
Control tabs in Design Studio will be grayed out.
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Other Operations

Contents

Removing a Healthy 
Device (Deprovisioning)	     164

Renaming an Installation	    165

Converting to a 
Secure Installation	     165

Deleting an Installation	     166

Removing a Healthy Device (Deprovisioning)

Deprovisioning removes functioning devices from your installation 
and restores them to factory default settings. You will be able 
to discover the device again by clicking Find New Devices in 
the top-right corner of the screen. In Ketra Only installations, 
deprovisioning can also be used to delete virtual devices.

Note: Deprovisioning only works for devices that are 
functioning normally. For troubleshooting unresponsive 
devices, see Device Troubleshooting, page 172.

To deprovision a device, follow these steps:

1	 Open the installation in Design Studio and go to the Organization tab.

2	 Select the device(s) in the My Devices list.

3	 At the top of the My Devices list, click the x! button.

If you are unable to deprovision the device due to communication failures, ensure that the device is 
powered on. 

fig. 176
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Renaming an Installation

Any user can rename an installation. To rename, follow these steps:

1	 Open the installation in Design Studio.

2	 Click the user icon in the top-left corner to open the sidebar. 

3	 Double-click the name in the Installation Name box, then type a new name.

The installation name will be automatically updated for all accounts with access to the installation.

fig. 177

Converting to a Secure Installation

If you created the installation as an open installation, you can convert to secure at any time. Secure 
installations have two advantages over open installations:

•	 Exclusive control: All devices get set to private networks unique to the installation, meaning 
they cannot be discovered by other installations. 

•	 Multiple N4 Hubs: Whereas an open installation can only support 1 N4 (limiting the installation 
to 50 devices), a secure installation can support multiple.

To convert to a secure installation, follow these steps:

1	 Make sure all your installation’s devices are powered on! If a device doesn’t have power when 
you convert to a secure installation, it won’t join the new secure network and therefore it won’t 
be able to communicate with the rest of your installation.

continued on next page
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Note: If you encounter that problem, you can resolve it using Tech Tool’s Find a Missing 
Device feature in the Advanced Features tab. See Recovering a Device, page 174.

2	 Open the installation in Design Studio.

3	 Click the user icon in the top-left corner to open the sidebar.

4	 Click Convert to Secure Installation. 

5	 Select your N4 Hub.

6	 Select a channel for your N4 Hub. 20 and 25 are ideal. The next preferred channels are 11, 14, 16, 
19, 21, and 24. 
 
When selecting a channel, keep in mind that adjacent KNets should be on different channels to 
prevent interference. 

7	 Click Change.

fig. 178

Deleting an Installation

Deleting an installation removes it from your Existing Installations list as well as that of any  
user with whom you’ve shared it, and from the Customer Web Portal (my.goketra). Any user with 
access to an installation can delete it; however, installations must be deleted on-site, not via  
remote access.

To delete an installation, follow these steps:

1	 Open the installation in Design Studio.

2	 Click the user icon in the top-left corner to open the sidebar.

continued on next page
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3	 Click Delete this Installation. 

4	 In the popup, click Delete.

Your devices will turn red for 30 seconds to confirm deletion before returning to their factory default 
settings. They will be removed from secure networks.

Note: Design Studio requires that all your devices be powered on and in range when you 
delete the installation. If Design Studio cannot communicate with all your devices, the 
deletion will fail (although the ones it can communicate with will be deprovisioned). If you’ve 
lost a device or a device is malfunctioning when you intend to delete the installation, see 
Deleting a Malfunctioning Device, page 177.

fig. 179
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PART 4: SAVING YOUR PROGRESS

Two Ways to Save
There are two ways to save progress in Design Studio: publishing and syncing. It is very important to 
do both whenever you make changes to an installation. 

Publishing saves configurations to your devices. For some devices (e.g., Ketra keypads), this is 
required before your changes can take effect. For all devices, this is required before your devices will 
preserve their configurations between power-cycles. (For more details on publishing, see Publishing: 
Saving Configurations to Devices, page 152.) In large installations, publishing can take a long time 
because it requires Design Studio to communicate with every device.

Syncing backs up your copy of the installation to the cloud, making it a quick way to ensure 
that none of your settings gets lost. It requires Internet access. In addition to backing up your 
configurations, syncing also streamlines collaboration. For more details on syncing, see Version 
Control Through Syncing, page 154.

Our recommendations for publishing and syncing vary depending on whether the computer making 
changes has Internet access.

Saving With Internet Access

•	 Sync regularly.  
To sync, close out of the installation by exiting Design Studio or returning to the Existing 
Installations list from the sidebar. This overwrites the cloud backup with your local copy of  
the installation. 

•	 Click Publish and Save whenever recommended by instructions in this manual, and when you 
wrap up your changes.  
This requires communication with every device in the installation and may take a substantial 
amount of time in large installations. Unfortunately, there is no way to publish a subset  
of changes. Because of the time delay involved, we do not recommend regular publishing  
during commissioning. 

Saving Without Internet Access

Always try to commission with Internet access, even if it entails using your phone as a Wifi hotspot. 
If Internet access is unavailable, do the following to save your progress:

•	 Leave Design Studio open until you reacquire Internet access, then close.  
Closing the installation when you have Internet access will trigger a sync up, so that your 
configurations get written to Ketra’s cloud backup of the installation. 

•	 In small installations (1 or 2 KNets), click Publish and Save regularly during commissioning.  
This saves configurations to the devices and to your local installation file. 

continued on next page
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•	 In large installations, avoid clicking Publish and Save until you have finished making changes 
and successfully synced. 
Publishing requires communication with every device and may take a substantial amount of 
time in large installations. In some cases, Design Studio may time out and have to restart, in 
which case your configurations will be lost. This is why we recommend syncing before publishing 
in large installations.
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Trouble Accessing an Installation

PART 5: TROUBLESHOOTING

When attempting to open an installation, you may encounter the following error messages.

Error Message: Failed to Sync (fig. 180)

•	 Meaning: Design Studio could not sync up or 
down from the installation’s cloud backup.

•	 Correction: 

–– Confirm you have Internet, then click Retry. 

–– Continue to commissioning by clicking 
Ignore. Note that editing an unsynced 
installation copy can cause data loss in 
collaborative installations. For details, see 
Version Control Through Syncing, page 154. 
 

Error Message: Sync Required  (fig. 181)

•	 Meaning: This installation’s cloud backup is 
more current than your copy. Design Studio 
cannot continue until you sync down.

•	 Correction: Acquire Internet access and  
retry opening the installation. 
 

Error Message: Could Not Connect to Network, 
with prompt to connect remotely (fig. 182)

•	 Meaning: You are not on the N4s’ LAN (Local 
Area Network), but remote access is enabled  
for the installation.

•	 Correction: Click Yes to connect to the N4s  
via Internet (if available). Changes you make  
in Design Studio will be reflected on the  
devices themselves, and you will be able to 
publish configurations. 
 

continued on next page

fig. 180

fig. 182

fig. 181
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Error Message: Could Not Connect to Network, 
with warning that hubs are not available (fig. 183)

•	 Meaning: One or multiple N4s are not on your 
computer’s network.

•	 Correction: 

–– Make sure all N4s are powered on. (Will take 
a few minutes to power on.)

–– If remote access is enabled, confirm that 
you and the N4s’ network both have 
Internet connection, then click Try Again.

–– If remote access is disabled, make sure all 
N4s are connected to the same network as 
your computer, then click Try Again. 
 

Error Message: It appears that someone else 
has accessed this installation without syncing 
afterwards (fig. 184)

•	 Meaning: Another computer has accessed this 
installation without syncing. If it made changes, 
your copy of the file will be out of date. 
Modifying an outdated file causes data loss.

•	 Correction: 

–– If Internet: close out, sync from the other 

fig. 183

fig. 184

fig. 185

computer, reopen on this computer.

–– If no Internet: close out, acquire Internet, reopen; follow steps in previous bullet. 

–– For an explanation of how editing an outdated file can result in data loss, see Version 
Control Through Syncing, page 154. 
 

Error Message: Could not verify that this 
installation has been synced correctly (fig. 185)

•	 Meaning: DS failed to query the N4s for a date 
of last access. If another computer has accessed 
and changed the install, your copy of the file 
will be out of date. Modifying an outdated file 
causes data loss.

•	 Correction: 

–– If you are sure no other computer has 
accessed this installation, continue.

–– Otherwise, connect to the N4s’ LAN and 
retry. If necessary, use the flowchart in 
Troubleshooting N4 Hubs, page 25 (skipping the “Add N4s to Installation” step).

–– We strongly recommend acquiring Internet access and reopening.

–– Note that after clearing this error, you may encounter a different error that says, “It appears 
someone has accessed this installation without syncing afterward.” If so, reference this 
section for instructions.
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Device Troubleshooting

Contents

Running Diagnostics	     172

Replacing a 
Malfunctioning Device	     173

Recovering an  
Unresponsive Devices	     174

Deleting a  
Malfunctioning Device	     177

Running Diagnostics

Design Studio provides a diagnostic feature to help you identify 
hardware and communication problems with your Ketra devices. 
The diagnostics program queries on every device (not group) in  
the installation.

Note: Runs of linear fixtures are not included separately from 
their N3 Satellite. 

We recommend running a diagnostic test before contacting Tech 
Support, because the problem might be easy to resolve on-site; however, this is a recommendation, 
not a requirement.

To run a diagnostics check on your installation, follow these steps:

1	 From the Organization tab or Device Control tab, click the heartbeat icon in the top-left corner.

2	 Click Start. The program may take a while to run, since it attempts to contact every device in  
the installation.

The results will tell you two things:

•	 Radio signal strength of your devices

–– Green: Good

–– Yellow: Fair

–– Red: Poor — The device’s housing is interfering with its signal, or it is too distant from other 
nodes on the same KNet

–– Dark: Unknown — The device is not powered on or is completely out of range

•	 Device problems, represented by an error code to the right of the signal-strength status. Click the 
error code to open a detailed description.

fig. 186
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Replacing a Malfunctioning Device

Design Studio supports device replacement for when a device is no longer functioning and you have 
already received a replacement device from Ketra. 

Note: Replace a Device is intended only for devices that are no longer functioning and 
cannot be wirelessly addressed. If you mean to replace a functioning device, deprovision it in 
the Organization tab and provision the replacement device. (See Removing a Healthy Device 
(Deprovisioning), page 164.)

When you replace a device, the bad device’s configurations in Design Studio will automatically 
map to the replacement device. This ensures that you do not have to do any reprogramming after 
replacing the device. 

Note: If you are replacing multiple linear fixtures in a single run, physically replace all linear 
fixtures in the run before using Replace a Device, and just specify the serial number of one 
replaced linear and whatever replacement linear will go in the same position. Design Studio 
will republish all fixtures in the run in a single pass.

Follow these steps to replace your malfunctioning Ketra device (see fig. 187, next page):

1	 Write down the replacement device’s serial number. In most cases, serial numbers are easy  
to locate on the devices themselves. They all begin with two letters followed by eight digits,  
e.g. KA00112325. 

2	 Remove the malfunctioning fixture. 

3	 Plug in the replacement fixture. Ensure that your replacement device is powered on. Design 
Studio has to be able to communicate with it in order to provision it for your installation.  
Note that N3 Satellites may take a minute between when they power up and when they  
start communicating.

4	 Open the installation in Design Studio.

5	 Click the user icon in top-left to open the installation sidebar. 

6	 In the sidebar, click Replace a Device.

7	 Follow the instructions in the Device Replacement window. You have to enter the serial number 
of the old device, even if you have renamed it in Design Studio. The serial number can be found 
on the device itself or on the Organization tab.

8	 Click Replace. Design Studio automatically programs the new device with the old  
device’s configurations.

continued on next page
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Note: If the replacement device requires a firmware update, Design Studio will notify you. 
Firmware can be updated in Tech Tool. For details, see Updating Firmware, page 160.

Recovering an Unresponsive Device

Tech Tool’s Find a Missing Device feature reestablishes communication with functional devices that 
for some reason fell off the communication grid. Use this tool if:

•	 You lost communication with devices after changing an N4 Hub’s channel

•	 You lost communication with devices after converting to a secure installation

•	 You lost communication with devices for an unknown reason, but they are still emitting light or 
their indicator lights are still illuminating

To run Find a Missing Device, follow these steps:

1	 Make sure the device is powered on.

2	 Open the installation in Tech Tool.

3	 Go to the Advanced Features tab.

4	 Use the Select a Feature dropdown to select Find a Missing Device.

6

5 7

8
fig. 187 

continued on next page
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5	 If possible, set options to save runtime:

–– Select the N4 Hub that the device or devices belong to. We recommend doing this
if the devices belong to a single N4’s KNet, as it saves runtime. However, if you lost
communication with devices across multiple KNets, leave this set to <All>.

–– Enter a specific serial number to search for.  Like setting an N4 Hub, this option
saves runtime.

–– Use an N1 Network Dongle rather than an N4 Hub. Use this feature if the device is no
longer in range for radio communication with its original N4. Connect an N1 to your laptop
and move closer to the device.

6	 Click Start Search.

Note: If Tech Tool does not find the devices, confirm that they are all powered on. Run the 
search again. (If the devices are controllers like keypads or N3s, you may need to wait a few 
minutes between power-up and running the search.) If you still can’t find the device, 
contact Ketra Tech Support. You can reach us Monday through Friday, 9 AM - 5 PM, CST. 
Call 1-844-588-6445, or email ketrasupport@lutron.com.

7	 Once Tech Tool finds the devices, deprovision them from the installation. To do so, check their 
boxes and click Deprovision Selected Devices.

fig. 188
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8	 Close Tech Tool and open the installation in Design Studio.

9	 Go to Organization > Add Devices and click Find New Devices. If the installation has multiple 
hubs, select the hub the device previously belonged to.

Note: Control devices such as N3s or keypads may take a few minutes to initialize before you 
can find them. If they do not appear on the first search, wait a few minutes and click Refresh.

10	 Provision the devices to the installation. If you need instructions on provisioning, refer to Adding 
Devices, page 38.

11	 Click Finish This Hub.

12	 Click Publish and Save. Publishing configurations ensures that the re-added device receives the 
configurations it had prior to deprovisioning.

fig. 189
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Deleting a Malfunctioning Device

Tech Tool’s Delete a Device feature can be used to remove malfunctioning devices from the 
installation file. There are two common applications for this feature:

•	 Design Studio won’t let you delete an installation because it can’t communicate with a missing  
or malfunctioning device. 

•	 A replacement device was provisioned to the installation on the Organization tab rather than 
using the Replace a Device feature (described in Replacing a Malfunctioning Device, page 173). 

Note: Do not use this feature to a) replace a malfunctioning device or b) remove a 
functioning device from your installation. Instead, see Replacing a Malfunctioning Device, 
page 173, or Removing a Healthy Device (Deprovisioning), page 164. 

To delete a device from your installation, follow these steps:

1	 Open the installation in Tech Tool.

2	 Go to the Advanced Features tab.

3	 Make sure the Select a Feature dropdown says "Delete a device".

4	 Check the device or devices’ boxes in the device list. For convenience, you can also filter by hub.

5	 Click Delete Selected Devices. It is not necessary to turn the device on prior to using this feature.

fig. 190
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Appendix A App Note:  
Integrating Ketra Products into 
HomeWorks QS Systems
Overview

Lutron Designer version 14.0 introduces functionality that allows a dealer to import Ketra Design 
Studio installations. After the import process is complete, Ketra scenes and shows will be assignable 
items in Lutron Designer. These scenes and shows can be triggered from any HomeWorks QS input 
action (e.g., keypad button press, timeclock event).

Scenes and shows are triggered at a group level and Ketra groups are typically comprised of zone, 
room, floor, and residence levels. These groups are then mapped to areas created in Lutron Designer 
using the import function found in the Tools menu.

This system works by having HomeWorks QS processors, a Lutron Connect bridge, and Ketra N4 hubs 
communicate over a local network connection. If the network is configured correctly, the system 
will continue to function if an internet connection is lost or the router goes offline.

Programming and commissioning is done by using both Ketra Design Studio and Lutron Designer 
software applications. HomeWorks QS firmware updates are performed using Lutron Designer and 
Ketra firmware updates are performed using the Ketra Tech Tool.
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APPENDIX A
INTEGRATING KETRA PRODUCTS INTO HOMEWORKS QS SYSTEMS

Devices and Features
•	 Ketra scenes and shows can be controlled from any HomeWorks QS trigger (e.g., button press, 

timeclock event, occupancy sensor).

•	 HomeWorks QS keypad raise or lower control of Ketra groups

•	 HomeWorks QS keypad LED feedback of Ketra scenes

•	 Ketra groups can be controlled from the Lutron Connect app

•	 Ketra groups can be controlled through voice control (e.g., Amazon Alexa, Google Home)

Required Devices

•	 HomeWorks QS processor with firmware version 14.0 or later

•	 Lutron Connect Bridge

•	 Ketra N4 hub with firmware version 2.0 or later

•	 HomeWorks QS designer version 14.0 or later

•	 Ketra Design Studio version 3.0 or later

Required Devices

•	 Ketra model numbers starting with “HW-”:

–– Lamps (A20, S30, S38)

–– Downlights (D3, D4R)

–– Linear luminaires (G2, P4, L3I, L4R)

–– N3 satellite

–– N3 DMX output

•	 Ketra N4 hub (required for system communication)

•	 Ketra devices require firmware version 2.0 or later

•	 HomeWorks QS processors require firmware version 14.0 or later

•	 Lutron Connect Bridge (e.g., CONNECT-BDG-1, CONNECT-BDG2-1)

Devices Not Supported

•	 Ketra model numbers that do not start with “HW-”

•	 Integration with Ketra products via N3 inputs/outputs

•	 Ketra X2 keypads

•	 Ketra virtual keypads or the Ketra app

•	 Integration with Ketra products via telnet

•	 Ketra emergency mode. For general information on emergency lighting with Lutron systems, see 
Application Note #106 (P/N 048106) at www.lutron.com
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Design and Programming

Design and programming steps can be performed off-site, prior to commissioning, and in both 
Lutron Designer and Ketra Design Studio. Groups, scenes, and shows can be created in Ketra Design 
Studio before identifying lights and adding them to groups. An area tree can be created in Lutron 
Designer that matches the organization layout in Ketra Design Studio. The Ketra Design Studio 
groups will be mapped to areas in Lutron Designer during the import or update process. After the 
import or mapping is completed, Ketra scenes and shows will show as assignable items in Lutron 
Designer and they can be triggered by any HomeWorks QS input action.

Note: Design Studio (DS) must be initially logged into while connected to the internet. 
However, after that point DS does not require internet access to run. DS will automatically 
sync once it is opened when there is internet access.

Ketra Design Studio

For more information on configuring the Ketra installation, please refer to the Ketra Design Studio 
3.0 user manual.

1	 Click CREATE A NEW INSTALLATION and then SECURE INSTALLATION to create a new secure 
installation in Ketra Design Studio.

3 www.lutron.com/support

Application Note #696

Design and Programming
Design and programming steps can be performed off-site, prior to commissioning, and in both Lutron Designer and Ketra 
Design Studio. Groups, scenes, and shows can be created in Ketra Design Studio before identifying lights and adding 
them to groups. An area tree can be created in Lutron Designer that matches the organization layout in Ketra Design 
Studio. The Ketra Design Studio groups will be mapped to areas in Lutron Designer during the import or update process. 
After the import or mapping is completed, Ketra scenes and shows will show as assignable items in Lutron Designer and 
they can be triggered by any HomeWorks QS input action.

NOTE: Design Studio (DS) must be initially logged into while connected to the internet. However, after that point DS does 
not require internet access to run. DS will automatically sync once it is opened when there is internet access.

Ketra Design Studio
For more information on configuring the Ketra installation, please refer to the Ketra Design Studio 3.0 user manual at  
www.ketra.com/products/tech-tools/DesignStudio

1.  Click CREATE A NEW INSTALLATION and then SECURE INSTALLATION to create a new secure installation in Ketra 
Design Studio.

2.  Click N4 Hub(s) and select Ketra with HomeWorks QS. Only installations with an N4 hub can integrate with 
HomeWorks QS systems.

Continued on next page...

3 www.lutron.com/support

Application Note #696

Design and Programming
Design and programming steps can be performed off-site, prior to commissioning, and in both Lutron Designer and Ketra 
Design Studio. Groups, scenes, and shows can be created in Ketra Design Studio before identifying lights and adding 
them to groups. An area tree can be created in Lutron Designer that matches the organization layout in Ketra Design 
Studio. The Ketra Design Studio groups will be mapped to areas in Lutron Designer during the import or update process. 
After the import or mapping is completed, Ketra scenes and shows will show as assignable items in Lutron Designer and 
they can be triggered by any HomeWorks QS input action.

NOTE: Design Studio (DS) must be initially logged into while connected to the internet. However, after that point DS does 
not require internet access to run. DS will automatically sync once it is opened when there is internet access.

Ketra Design Studio
For more information on configuring the Ketra installation, please refer to the Ketra Design Studio 3.0 user manual at  
www.ketra.com/products/tech-tools/DesignStudio

1.  Click CREATE A NEW INSTALLATION and then SECURE INSTALLATION to create a new secure installation in Ketra 
Design Studio.

2.  Click N4 Hub(s) and select Ketra with HomeWorks QS. Only installations with an N4 hub can integrate with 
HomeWorks QS systems.

Continued on next page...

2	 Click N4 Hub(s) and select Ketra with HomeWorks QS. Only installations with an N4 hub can 
integrate with HomeWorks QS systems.

continued on next page
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3	 Enter the Installation Location and click on the appropriate Installation Template.

4 Customer Assistance — 1.844.LUTRON1

Application Note #696

Ketra Design Studio (continued)

3.  Enter the Installation Location and click on the appropriate Installation Template.

4.  If the N4 hub is available, select it, click Add Hub to Installation, and click Continue. If an N4 hub is not currently 
available, click Continue and add it later.

When multiple N4s are physically close together, they can cause mutual interference if they are on the same channel. When 
using multiple N4s, each N4 should be set to its own channel. This will improve performance when devices on multiple N4s 
are entering the same scene, as well as improve firmware transfer speeds to devices.

Continued on next page...
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Application Note #696

Ketra Design Studio (continued)

3.  Enter the Installation Location and click on the appropriate Installation Template.

4.  If the N4 hub is available, select it, click Add Hub to Installation, and click Continue. If an N4 hub is not currently 
available, click Continue and add it later.

When multiple N4s are physically close together, they can cause mutual interference if they are on the same channel. When 
using multiple N4s, each N4 should be set to its own channel. This will improve performance when devices on multiple N4s 
are entering the same scene, as well as improve firmware transfer speeds to devices.

Continued on next page...

4	 If the N4 hub is available, select it, click Add Hub to Installation, and click Continue. If an N4 
hub is not currently available, click Continue and add it later.  
When multiple N4s are physically close together, they can cause mutual interference if they are 
on the same channel. When using multiple N4s, each N4 should be set to its own channel. This 
will improve performance when devices on multiple N4s are entering the same scene, as well as 
improve firmware transfer speeds to devices.

continued on next page
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5	 Create group hierarchy 
Consider the area layout and lighting for the installation. These groups will be mapped to areas 
in Lutron Designer. See step 6 on page 194 for more information on the mapping process.

i	 On the Organization tab, add groups by highlighting the higher level (parent) groups in  
the My Devices list, selecting a group template at right, and pressing the green Add  
Group button.

5 Customer Assistance — 1.844.LUTRON1

Application Note #696

Ketra Design Studio (continued)

5.  Create group hierarchy

Consider the area layout and lighting for the installation. These groups will be mapped to areas in Lutron Designer.  
See step 6 on page 9 for more information on the mapping process.

a.  On the Organization tab, add groups by highlighting the higher level (parent) groups in the My Devices list, selecting a 
group template at right, and pressing the green Add Group button

b.  Add the parent groups (e.g., wings, floors, other sections of the home) and then lower level (child) groups (e.g., rooms). 

6.  Create groups for each intended zone of lighting (e.g., downlight, overhead, accent light). Actual lamps and fixtures will be 
added to these groups later.

7.  Optional: Divide runs of G2 linear luminaires into separate groups. By default, all G2 linear luminaires in a run have to be 
grouped together. A run of G2 linear luminaires can be divided into multiple groups using the Ketra Tech Tool. For more 
details, see the Ketra Design Studio 3.0 user manual at www.ketra.com/products/tech-tools/DesignStudio

 

Continued on next page...
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Ketra Design Studio (continued)

5.  Create group hierarchy

Consider the area layout and lighting for the installation. These groups will be mapped to areas in Lutron Designer.  
See step 6 on page 9 for more information on the mapping process.

a.  On the Organization tab, add groups by highlighting the higher level (parent) groups in the My Devices list, selecting a 
group template at right, and pressing the green Add Group button

b.  Add the parent groups (e.g., wings, floors, other sections of the home) and then lower level (child) groups (e.g., rooms). 

6.  Create groups for each intended zone of lighting (e.g., downlight, overhead, accent light). Actual lamps and fixtures will be 
added to these groups later.

7.  Optional: Divide runs of G2 linear luminaires into separate groups. By default, all G2 linear luminaires in a run have to be 
grouped together. A run of G2 linear luminaires can be divided into multiple groups using the Ketra Tech Tool. For more 
details, see the Ketra Design Studio 3.0 user manual at www.ketra.com/products/tech-tools/DesignStudio

 

Continued on next page...
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Ketra Design Studio (continued)

5.  Create group hierarchy

Consider the area layout and lighting for the installation. These groups will be mapped to areas in Lutron Designer.  
See step 6 on page 9 for more information on the mapping process.

a.  On the Organization tab, add groups by highlighting the higher level (parent) groups in the My Devices list, selecting a 
group template at right, and pressing the green Add Group button

b.  Add the parent groups (e.g., wings, floors, other sections of the home) and then lower level (child) groups (e.g., rooms). 

6.  Create groups for each intended zone of lighting (e.g., downlight, overhead, accent light). Actual lamps and fixtures will be 
added to these groups later.

7.  Optional: Divide runs of G2 linear luminaires into separate groups. By default, all G2 linear luminaires in a run have to be 
grouped together. A run of G2 linear luminaires can be divided into multiple groups using the Ketra Tech Tool. For more 
details, see the Ketra Design Studio 3.0 user manual at www.ketra.com/products/tech-tools/DesignStudio

 

Continued on next page...

ii	 Add the parent groups (e.g., wings, floors, other sections of the home) and then lower level 
(child) groups (e.g., rooms).

6	 Create groups for each intended zone of lighting (e.g., downlight, overhead, accent light). 
Actual lamps and fixtures will be added to these groups later.
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7	 Optional: Divide runs of G2 linear luminaires into separate groups. By default, all G2 linear 
luminaires in a run have to be grouped together. A run of G2 linear luminaires can be divided 
into multiple groups using the Ketra Tech Tool. For more details, see the Ketra Design Studio 3.0 
user manual.

8	 Creating Control Groups 
When a scene will affect lights in multiple Ketra groups, a Control Group should be created in 
Design Studio. For example, if a dining scene is to control lights within the “Dining Room” and 
“Kitchen” groups, a separate Control Group named “Dining Room + Kitchen” should be created.

i	 Navigate to Device Control > Control Groups in Design Studio

ii	 Click Create New Control Group

iii	 Name the Control Group

iv	 Select the groups to include
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Ketra Design Studio (continued)

8.  Creating Control Groups

When a scene will affect lights in multiple Ketra groups, a Control Group should be created in Design Studio. For example, if 
a dining scene is to control lights within the “Dining Room” and “Kitchen” groups, a separate Control Group named “Dining 
Room + Kitchen” should be created.

a.  Navigate to Device Control -> Control Groups in Design Studio

b.  Click Create New Control Group

c.  Name the Control Group

d.  Select the groups to include 

9.  Creating Scenes

The process below outlines scene creation using the tree view. For information on building scenes using the template view, 
please refer to the Ketra Design Studio 3.0 user manual at www.ketra.com/products/tech-tools/DesignStudio

a.  From the Device Control tab, select the Scenes panel. There are several predefined scenes based on the installation 
template used and the types of groups added. These scenes can be customized and new ones can be added.

b.  Select brightness, fade time, white light color temperature and vibrancy, and saturated color settings for each group. 
Click “x” to make the group unaffected.

c.  Changing the settings for a parent group will update the values of the child groups. However, if settings are then changed 
for one of the child groups, those settings will have priority over the settings automatically updated by the parent group.
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Ketra Design Studio (continued)

8.  Creating Control Groups

When a scene will affect lights in multiple Ketra groups, a Control Group should be created in Design Studio. For example, if 
a dining scene is to control lights within the “Dining Room” and “Kitchen” groups, a separate Control Group named “Dining 
Room + Kitchen” should be created.

a.  Navigate to Device Control -> Control Groups in Design Studio

b.  Click Create New Control Group

c.  Name the Control Group

d.  Select the groups to include 

9.  Creating Scenes

The process below outlines scene creation using the tree view. For information on building scenes using the template view, 
please refer to the Ketra Design Studio 3.0 user manual at www.ketra.com/products/tech-tools/DesignStudio

a.  From the Device Control tab, select the Scenes panel. There are several predefined scenes based on the installation 
template used and the types of groups added. These scenes can be customized and new ones can be added.

b.  Select brightness, fade time, white light color temperature and vibrancy, and saturated color settings for each group. 
Click “x” to make the group unaffected.

c.  Changing the settings for a parent group will update the values of the child groups. However, if settings are then changed 
for one of the child groups, those settings will have priority over the settings automatically updated by the parent group.

9	 Creating Scenes 
The process below outlines scene creation using the tree view. For information on building 
scenes using the template view, please refer to the Ketra Design Studio 3.0 user manual.

i	 From the Device Control tab, select the Scenes panel. There are several predefined scenes 
based on the installation template used and the types of groups added. These scenes can be 
customized and new ones can be added.
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ii	 Select brightness, fade time, white light color temperature and vibrancy, and saturated color 
settings for each group. Click “x” to make the group unaffected.
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Ketra Design Studio (continued)

8.  Creating Control Groups

When a scene will affect lights in multiple Ketra groups, a Control Group should be created in Design Studio. For example, if 
a dining scene is to control lights within the “Dining Room” and “Kitchen” groups, a separate Control Group named “Dining 
Room + Kitchen” should be created.

a.  Navigate to Device Control -> Control Groups in Design Studio

b.  Click Create New Control Group

c.  Name the Control Group

d.  Select the groups to include 

9.  Creating Scenes

The process below outlines scene creation using the tree view. For information on building scenes using the template view, 
please refer to the Ketra Design Studio 3.0 user manual at www.ketra.com/products/tech-tools/DesignStudio

a.  From the Device Control tab, select the Scenes panel. There are several predefined scenes based on the installation 
template used and the types of groups added. These scenes can be customized and new ones can be added.

b.  Select brightness, fade time, white light color temperature and vibrancy, and saturated color settings for each group. 
Click “x” to make the group unaffected.

c.  Changing the settings for a parent group will update the values of the child groups. However, if settings are then changed 
for one of the child groups, those settings will have priority over the settings automatically updated by the parent group.
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10. Creating Shows

a.  From the Device Control tab, click on the Shows panel. There will be a pre-built Natural show that consists of many 
astronomical steps (scenes) that have color temperature and fade settings for each group. The Natural show can be 
customized and up to 10 new shows can be created.

b.  Click Schedule and in the CONTROL: field, select Trigger with Show Group.

c.  If you want the show to start automatically, set a timeclock event in Lutron Designer to trigger the show group rather than 
selecting Run Always in Ketra Design Studio.

11. Click Publish and Save.

Continued on next page...
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10. Creating Shows

a.  From the Device Control tab, click on the Shows panel. There will be a pre-built Natural show that consists of many 
astronomical steps (scenes) that have color temperature and fade settings for each group. The Natural show can be 
customized and up to 10 new shows can be created.

b.  Click Schedule and in the CONTROL: field, select Trigger with Show Group.

c.  If you want the show to start automatically, set a timeclock event in Lutron Designer to trigger the show group rather than 
selecting Run Always in Ketra Design Studio.

11. Click Publish and Save.

Continued on next page...

iii	 Changing the settings for a parent group will update the values of the child groups. 
However, if settings are then changed for one of the child groups, those settings will have 
priority over the settings automatically updated by the parent group.

10	 Creating Shows

i	 From the Device Control tab, click on the Shows panel. There will be a pre-built Natural 
show that consists of many astronomical steps (scenes) that have color temperature and 
fade settings for each group. The Natural show can be customized and up to 10 new shows 
can be created.

ii	 Click Schedule and in the CONTROL: field, select Trigger with Show Group.

iii	 If you want the show to start automatically, set a timeclock event in Lutron Designer to 
trigger the show group rather than selecting Run Always in Ketra Design Studio.

11	 Click Publish and Save.
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Lutron Designer

1	 In Lutron Designer, create a new project or choose an existing project.

2	 Create the Area hierarchy in Lutron Designer.

i	 The area tree in Lutron Designer should be similar to the grouping hierarchy in Ketra  
Design Studio.

ii	 Create a separate area in Lutron Designer named “Whole Home” or “Residence” that does 
not contain children areas. Ketra groups cannot be mapped to Lutron Designer areas 
containing children.

8 Customer Assistance — 1.844.LUTRON1

Application Note #696

Lutron Designer
1.  In Lutron Designer, create a new project or choose an existing project.

2.  Create the Area hierarchy in Lutron Designer.

a.  The area tree in Lutron Designer should be similar to the grouping hierarchy in Ketra Design Studio.

b.  Create a separate area in Lutron Designer named “Whole Home” or “Residence” that does not contain children areas. 
Ketra groups cannot be mapped to Lutron Designer areas containing children. 

3.  To add equipment, click the design tab and select equipment from the drop down menu. Examples of equipment that can 
be added are: panels, processors, Lutron Connect bridges, hybrid repeaters.

4.  To add controls, click the design tab and select controls from the drop down menu. Examples of controls that can be 
added are: keypads, Pico wireless controls, sensors, thermostats.
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Lutron Designer
1.  In Lutron Designer, create a new project or choose an existing project.

2.  Create the Area hierarchy in Lutron Designer.

a.  The area tree in Lutron Designer should be similar to the grouping hierarchy in Ketra Design Studio.

b.  Create a separate area in Lutron Designer named “Whole Home” or “Residence” that does not contain children areas. 
Ketra groups cannot be mapped to Lutron Designer areas containing children. 

3.  To add equipment, click the design tab and select equipment from the drop down menu. Examples of equipment that can 
be added are: panels, processors, Lutron Connect bridges, hybrid repeaters.

4.  To add controls, click the design tab and select controls from the drop down menu. Examples of controls that can be 
added are: keypads, Pico wireless controls, sensors, thermostats.
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Lutron Designer
1.  In Lutron Designer, create a new project or choose an existing project.

2.  Create the Area hierarchy in Lutron Designer.

a.  The area tree in Lutron Designer should be similar to the grouping hierarchy in Ketra Design Studio.

b.  Create a separate area in Lutron Designer named “Whole Home” or “Residence” that does not contain children areas. 
Ketra groups cannot be mapped to Lutron Designer areas containing children. 

3.  To add equipment, click the design tab and select equipment from the drop down menu. Examples of equipment that can 
be added are: panels, processors, Lutron Connect bridges, hybrid repeaters.

4.  To add controls, click the design tab and select controls from the drop down menu. Examples of controls that can be 
added are: keypads, Pico wireless controls, sensors, thermostats.

3	 To add equipment, click the design tab and select equipment from the drop down menu. 
Examples of equipment that can be added are: panels, processors, Lutron Connect bridges, 
hybrid repeaters.

4	 To add controls, click the design tab and select controls from the drop down menu. Examples 
of controls that can be added are: keypads, Pico wireless controls, sensors, thermostats.
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5	 Click the design tab and select link assignment from the drop down menu to configure the 
processor links and link-assign Lutron devices.
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Lutron Designer (continued)

5.  Click the design tab and select link assignment from the drop down menu to configure the processor links and link-assign 
Lutron devices.

6.  Import a Ketra project.

a.  Click Tools and then Import Ketra Project. Select the desired Ketra installation. 

b.  Map Ketra groups to Lutron Designer areas. Assign residence and floor level Ketra groups to a Lutron Designer area. In 
the example below, a Lutron Designer area (without children) was previously created and named “Whole Home”. Control 
Groups that include multiple rooms (example: Dining Room + Kitchen) can also be mapped to this Whole Home area.

c.  Map parent level Ketra groups to Lutron Designer areas. This allows a HomeWorks QS system to trigger a scene or show 
at the room level. This group will show under Assignable Items in Lutron Designer but it will not show in the Lutron 
Connect app.

 
 
 
 

Continued on next page...
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Lutron Designer (continued)

5.  Click the design tab and select link assignment from the drop down menu to configure the processor links and link-assign 
Lutron devices.

6.  Import a Ketra project.

a.  Click Tools and then Import Ketra Project. Select the desired Ketra installation. 

b.  Map Ketra groups to Lutron Designer areas. Assign residence and floor level Ketra groups to a Lutron Designer area. In 
the example below, a Lutron Designer area (without children) was previously created and named “Whole Home”. Control 
Groups that include multiple rooms (example: Dining Room + Kitchen) can also be mapped to this Whole Home area.

c.  Map parent level Ketra groups to Lutron Designer areas. This allows a HomeWorks QS system to trigger a scene or show 
at the room level. This group will show under Assignable Items in Lutron Designer but it will not show in the Lutron 
Connect app.

 
 
 
 

Continued on next page...
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Lutron Designer (continued)

5.  Click the design tab and select link assignment from the drop down menu to configure the processor links and link-assign 
Lutron devices.

6.  Import a Ketra project.

a.  Click Tools and then Import Ketra Project. Select the desired Ketra installation. 

b.  Map Ketra groups to Lutron Designer areas. Assign residence and floor level Ketra groups to a Lutron Designer area. In 
the example below, a Lutron Designer area (without children) was previously created and named “Whole Home”. Control 
Groups that include multiple rooms (example: Dining Room + Kitchen) can also be mapped to this Whole Home area.

c.  Map parent level Ketra groups to Lutron Designer areas. This allows a HomeWorks QS system to trigger a scene or show 
at the room level. This group will show under Assignable Items in Lutron Designer but it will not show in the Lutron 
Connect app.

 
 
 
 

Continued on next page...

 

6	 Import a Ketra project.

i	 Click Tools and then Import Ketra Project. Select the desired Ketra installation.

ii	 Map Ketra groups to Lutron Designer areas. Assign residence and floor level Ketra groups to 
a Lutron Designer area. In the example below, a Lutron Designer area (without children) was 
previously created and named “Whole Home”. Control Groups that include multiple rooms 
(example: Dining Room + Kitchen) can also be mapped to this Whole Home area.

iii	 Map parent level Ketra groups to Lutron Designer areas. This allows a HomeWorks QS system 
to trigger a scene or show at the room level. This group will show under Assignable Items in 
Lutron Designer but it will not show in the Lutron Connect app.
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iv	 Map child level (lowest level) Ketra groups to Lutron Designer areas. These groups will 
appear in the Lutron Connect app as zones.

10 Customer Assistance — 1.844.LUTRON1

Application Note #696

Lutron Designer (continued)

d.  Map child level (lowest level) Ketra groups to Lutron Designer areas. These groups will appear in the Lutron Connect app as 
zones.

e.  Review report.

7.  Program a Ketra Project.

Now that a Ketra project has been imported, the Ketra groups, scenes, and shows will be available for selection during 
programming. 

a.  Single action buttons

i.  Click the program tab and select devices from the drop down menu. In the Assignable Items drop down menu, 
select Ketra Groups.

ii.  Select a Ketra scene or show at the desired group level. In the example below, the Natural Show will only affect Ketra 
groups included in the 1st Floor group.

Note:  Only one Ketra scene or show can be recalled at a time from a single HomeWorks QS button press or 
input action.

Continued on next page...
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Lutron Designer (continued)

d.  Map child level (lowest level) Ketra groups to Lutron Designer areas. These groups will appear in the Lutron Connect app as 
zones.

e.  Review report.

7.  Program a Ketra Project.

Now that a Ketra project has been imported, the Ketra groups, scenes, and shows will be available for selection during 
programming. 

a.  Single action buttons

i.  Click the program tab and select devices from the drop down menu. In the Assignable Items drop down menu, 
select Ketra Groups.

ii.  Select a Ketra scene or show at the desired group level. In the example below, the Natural Show will only affect Ketra 
groups included in the 1st Floor group.

Note:  Only one Ketra scene or show can be recalled at a time from a single HomeWorks QS button press or 
input action.

Continued on next page...
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Lutron Designer (continued)

d.  Map child level (lowest level) Ketra groups to Lutron Designer areas. These groups will appear in the Lutron Connect app as 
zones.

e.  Review report.

7.  Program a Ketra Project.

Now that a Ketra project has been imported, the Ketra groups, scenes, and shows will be available for selection during 
programming. 

a.  Single action buttons

i.  Click the program tab and select devices from the drop down menu. In the Assignable Items drop down menu, 
select Ketra Groups.

ii.  Select a Ketra scene or show at the desired group level. In the example below, the Natural Show will only affect Ketra 
groups included in the 1st Floor group.

Note:  Only one Ketra scene or show can be recalled at a time from a single HomeWorks QS button press or 
input action.

Continued on next page...

 
 
 
 
 

v	 Review report.

7	 Program a Ketra Project.  
 
Now that a Ketra project has been imported, the Ketra groups, scenes, and shows will be 
available for selection during programming.

i	 �Single action buttons
a	 Click the program tab and select devices from the drop down menu. In the Assignable 

Items drop down menu, select Ketra Groups.

b	 Select a Ketra scene or show at the desired group level. In the example below, the 
Natural Show will only affect Ketra groups included in the 1st Floor group.

Note: Only one Ketra scene or show can be recalled at a time from a single HomeWorks 
QS button press or input action.
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ii	 Toggle buttons
a	 Click the program tab and select devices from the drop down menu. In the Assignable 

Items drop down menu, select Ketra Groups.
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Lutron Designer (continued)

b.  Toggle buttons

i.  Click the program tab and select devices from the drop down menu. In the Assignable Items drop down menu, 
select Ketra Groups.

ii.  On the Press On tab, select a Ketra scene or show.

iii.  On the Off Level tab, select 0% level for the Ketra group.

Note:  A scene or show can also be selected for the Off Level if a level other than 0% is desired.

Continued on next page...
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Lutron Designer (continued)

b.  Toggle buttons

i.  Click the program tab and select devices from the drop down menu. In the Assignable Items drop down menu, 
select Ketra Groups.

ii.  On the Press On tab, select a Ketra scene or show.

iii.  On the Off Level tab, select 0% level for the Ketra group.

Note:  A scene or show can also be selected for the Off Level if a level other than 0% is desired.

Continued on next page...
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Lutron Designer (continued)

b.  Toggle buttons

i.  Click the program tab and select devices from the drop down menu. In the Assignable Items drop down menu, 
select Ketra Groups.

ii.  On the Press On tab, select a Ketra scene or show.

iii.  On the Off Level tab, select 0% level for the Ketra group.

Note:  A scene or show can also be selected for the Off Level if a level other than 0% is desired.

Continued on next page...

b	 On the Press On tab, select a Ketra scene or show.

c	 On the Off Level tab, select 0% level for the Ketra group.

Note: A scene or show can also be selected for the Off Level if a level other than 0%  
is desired.
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iii	 Raise or lower buttons
a	 Master raise or lower buttons will affect all lights assigned to the last button pressed on 

the keypad. This includes Lutron lighting zones and Ketra groups.
b	 Single Scene Raise/Lower buttons allows a single Ketra group (and multiple Lutron 

lighting zones) to be affected by the raise or lower button, regardless of the last button 
pressed on the keypad.

Note: Only one Ketra group can be affected from a Single Scene Raise/Lower button. To 
raise or lower more than one group at a time, raise/lower a higher group in the hierarchy 
or use Master Raise/Lower buttons.
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Lutron Designer (continued)

c.  Raise or lower buttons

i.  Master raise or lower buttons will affect all lights assigned to the last button pressed on the keypad. This includes 
Lutron lighting zones and Ketra groups.

ii.  Single Scene Raise / Lower buttons allows a single Ketra group (and multiple Lutron lighting zones) to be affected by 
the raise or lower button, regardless of the last button pressed on the keypad.

Note:  Only one Ketra group can be affected from a Single Scene Raise / Lower button. To raise or lower more than 
one group at a time, raise / lower a higher group in the hierarchy or use Master Raise / Lower buttons.

Additional Actions Available

Adding Ketra Devices in Ketra Design Studio
Note:  On-site radio communication required to add Ketra devices.

N4 hubs

1.  Click Organization and select the Add Hubs tab on the right pane.

2.  Click Find New Hubs and add to the installation.

3.  To set network settings, click the Device Settings tab and then click Settings for: Hubs.

4.  Click Publish and Save.

5. In Lutron Designer, click Tools > Map Ketra Poject File > Import / Update Ketra Configurations.

Lamps and Luminaires

1.  Click Organization and select the Add Devices tab on the right pane.

2.  Click Find New Hubs and add to the installation.

3.  Click Find New Devices and add the discovered devices to the appropriate groups.

4.  Click Publish and Save.

5. In Lutron Designer, click Tools > Map Ketra Poject File > Import / Update Ketra Configurations.

Continued on next page...

Additional Actions Available

Adding Ketra Devices in Ketra Design Studio

Note: On-site radio communication required to add Ketra devices.

N4 hubs

1	 Click Organization and select the Add Hubs tab on the right pane.

2	 Click Find New Hubs and add to the installation.

3	 To set network settings, click the Device Settings tab and then click Settings for: Hubs.

4	 Click Publish and Save.

5	 In Lutron Designer, click Tools > Map Ketra Poject File > Import/Update Ketra Configurations.

Lamps and Luminaires

1	 Click Organization and select the Add Devices tab on the right pane.

2	 Click Find New Hubs and add to the installation.

3	 Click Find New Devices and add the discovered devices to the appropriate groups.

4	 Click Publish and Save.
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5	 In Lutron Designer, click Tools > Map Ketra Poject File > Import/Update Ketra Configurations.

Firmware Updates in Ketra Tech Tool

The Ketra devices may need the firmware version to be updated. This is accomplished via the Ketra 
Tech Tool. Firmware updates can take up to 4 hours to complete for a system with fully loaded N4 
hubs; however, the initial update to the N4 hubs takes a lot less time. After the N4 hubs are updated, 
the Ketra Tech Tool can be closed and the computer can be disconnected from the network while 
the N4 hubs update the associated devices.

Ketra Design Studio cannot be opened while the Ketra Tech Tool is in use. If you want to keep the 
Ketra Tech Tool open to monitor the status of the updates, first build the Ketra groups, scenes, 
and shows in Ketra Design Studio before updating the firmware with the Ketra Tech Tool. Mapping, 
programming, and activation can be performed in Lutron Designer while the Ketra device firmware 
update is taking place.

1	 Open the Tech Tool and select the installation.

2	 The tool will show a list of all Ketra devices and their status.
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Additional Actions Available (continued)

Firmware Updates in Ketra Tech Tool
The Ketra devices may need the firmware version to be updated. This is accomplished via the Ketra Tech Tool. Firmware 
updates can take up to 4 hours to complete for a system with fully loaded N4 hubs; however, the initial update to the N4 
hubs takes a lot less time. After the N4 hubs are updated, the Ketra Tech Tool can be closed and the computer can be 
disconnected from the network while the N4 hubs update the associated devices.

Ketra Design Studio cannot be opened while the Ketra Tech Tool is in use. If you want to keep the Ketra Tech Tool open to 
monitor the status of the updates, first build the Ketra groups, scenes, and shows in Ketra Design Studio before updating 
the firmware with the Ketra Tech Tool. Mapping, programming, and activation can be performed in Lutron Designer while the 
Ketra device firmware update is taking place.

1.  Open the Tech Tool and select the installation.

2.  The tool will show a list of all Ketra devices and their status.

3.  To update your device, select Upgrade from Control Device(s) from the drop-down on the left and then click Start.

Note:  Once the initial upload to the N4s is complete (indicated by receiving the message below), the programming computer 
can be disconnected from the network and the Tech Tool can be closed.

Continued on next page...
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Additional Actions Available (continued)

Firmware Updates in Ketra Tech Tool
The Ketra devices may need the firmware version to be updated. This is accomplished via the Ketra Tech Tool. Firmware 
updates can take up to 4 hours to complete for a system with fully loaded N4 hubs; however, the initial update to the N4 
hubs takes a lot less time. After the N4 hubs are updated, the Ketra Tech Tool can be closed and the computer can be 
disconnected from the network while the N4 hubs update the associated devices.

Ketra Design Studio cannot be opened while the Ketra Tech Tool is in use. If you want to keep the Ketra Tech Tool open to 
monitor the status of the updates, first build the Ketra groups, scenes, and shows in Ketra Design Studio before updating 
the firmware with the Ketra Tech Tool. Mapping, programming, and activation can be performed in Lutron Designer while the 
Ketra device firmware update is taking place.

1.  Open the Tech Tool and select the installation.

2.  The tool will show a list of all Ketra devices and their status.

3.  To update your device, select Upgrade from Control Device(s) from the drop-down on the left and then click Start.

Note:  Once the initial upload to the N4s is complete (indicated by receiving the message below), the programming computer 
can be disconnected from the network and the Tech Tool can be closed.

Continued on next page...

3	 To update your device, select Upgrade from Control Device(s) from the drop-down on the left 
and then click Start.
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Additional Actions Available (continued)

Firmware Updates in Ketra Tech Tool
The Ketra devices may need the firmware version to be updated. This is accomplished via the Ketra Tech Tool. Firmware 
updates can take up to 4 hours to complete for a system with fully loaded N4 hubs; however, the initial update to the N4 
hubs takes a lot less time. After the N4 hubs are updated, the Ketra Tech Tool can be closed and the computer can be 
disconnected from the network while the N4 hubs update the associated devices.

Ketra Design Studio cannot be opened while the Ketra Tech Tool is in use. If you want to keep the Ketra Tech Tool open to 
monitor the status of the updates, first build the Ketra groups, scenes, and shows in Ketra Design Studio before updating 
the firmware with the Ketra Tech Tool. Mapping, programming, and activation can be performed in Lutron Designer while the 
Ketra device firmware update is taking place.

1.  Open the Tech Tool and select the installation.

2.  The tool will show a list of all Ketra devices and their status.

3.  To update your device, select Upgrade from Control Device(s) from the drop-down on the left and then click Start.

Note:  Once the initial upload to the N4s is complete (indicated by receiving the message below), the programming computer 
can be disconnected from the network and the Tech Tool can be closed.

Continued on next page...

Note: Once the initial upload to the N4s is complete (indicated by receiving the message 
below), the programming computer can be disconnected from the network and the Tech Tool 
can be closed.

Firmware Updates in Ketra Tech Tool

1	  In Lutron Designer, click the activate tab and select processors from the drop down menu. 

2	 Activate the Lutron Connect bridge and all other desired devices.

Note: Select Save and Transfer when prompted before initial device activation, after any new 
devices are added, or after link assignments are changed.

Transfer

1	 Go to the transfer tab in the HomeWorks QS Designer software.

2	 Press Start Transfer.

Test

After programming is complete, walk around and check that all devices are working as expected. 

Lutron Connect App

1	 Download the Lutron Connect app from the Apple App Store or Google Play  
online marketplaces.

2	 Create an account for the homeowner.

3	 Pair the homeowner account with the Lutron Connect bridge.

4	 Once connected, the Ketra zones will be displayed in their appropriate areas and can  
be controlled.

Note: For more information, see the Application Note #649 (P/N 048649) at www.lutron.com.
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Voice Control

1	 In the Lutron Connect app, click Settings > Amazon Alexa & Google Home.

2	 Select the scenes and lighting zones to be available and add them. Customize the voice 
command if desired.

3	 In the Amazon Alexa or Google Home app, add the Lutron Connect smart home skill.

4	 Log in with the homeowner account.

5	 Discover the devices. The scenes and zones that were specified will now be available for  
voice control.

Best Practices

Ketra Scenes

Only one Ketra group can be controlled at a time. This is good for certain applications, like when a 
dining scene is set to control Ketra lights only within the “Dining Room” group.

If the dining scene is to control lights within the “Dining Room” and “Kitchen” groups, a separate 
Control Group named “Dining Room + Kitchen” should be created.

App Control

Create virtual keypads in Lutron Designer to be used in the Lutron Connect app. When building a 
Ketra and HomeWorks QS installation, virtual keypads have been removed from Ketra Design Studio.

Customers will be able to access physical keypad buttons in the Lutron Connect app, but they 
may desire additional control. Consider creating virtual keypads with buttons that change group 
settings. This will provide control of intensity, correlated color temperature, tint, vibrancy, and the 
full gamut of color settings.

Remote Access

HomeWorks QS systems and Ketra installations can be accessed remotely. It is recommended that 
remote programming be reserved for system tweaks like changes to keypads button programming 
and scene settings. More substantial actions like firmware updates or lamp commissioning should 
be performed on site. 

Lutron recommends using a VPN connection for remotely programming a HomeWorks QS system. 
For more information, refer to Application Note #231 (048231) at www.lutron.com.

It is possible to Publish to a Ketra system remotely. To enable this option, navigate to Settings > 
Enable Remote Access in the Ketra Design Studio. Enabling remote access must be done while 
connected to the same local network as the installation.

continued on next page
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Upgrading an Existing Ketra Installation

If the Ketra Design Studio installation was created with a software version older than 3.0, it  
cannot be added to a HomeWorks QS system. Additional actions are needed. Follow the steps  
below to decommission and update all Ketra products so that the can be added to a new 
HomeWorks QS installation.

1	 Use the Ketra Tech Tool to update the firmware in all Ketra devices to version 2.0 or later.

2	 Open the existing installation in the Ketra Design Studio and click Delete Installation. This will 
decommission all the Ketra devices.

3	 Create a new Ketra with HomeWorks QS installation. Follow the system design and 
commissioning practices explained previously in this document.

Lutron Button Type and LED Logic

Button Type: Single Action 
LED Logic: Scene

This should be used for buttons that correlate with daily activities or moods (e.g., dining, watching 
TV, reading, relaxing). When a keypad contains these buttons, the customer should be provided with 
an “Off” button at the bottom of the keypad. Each button press or input action will typically trigger 
the same output action when using normal programming.

Scene LED logic means that all affected lighting zones, Ketra groups, and shades need to be at their 
programmed level for the status LED to be on. Changing the level of any of the affected devices will 
cause the LED to turn off.

Button Type: Toggle 
LED Logic: Room

This should be used to turn on/off zones or groups with one button (e.g., pendants, main tracks, 
basement). “Press on” action typically turns on affected lights to a programmed level. “Press off” 
action either turns off affected lights or dims them to a low light level.

Room LED logic means that the status LED will be on if any of the affected lights in the area are on 
at any light level. If the status LED is on, the next button press will trigger the “Press off” action. If 
the status LED is off, the next button press will trigger the “Press on” action.

Button Type: Single Action or Toggle 
LED Logic: Pathway

This should be used for creating a path of light from one area to another (e.g., midnight snack, 
bathroom). The status LED will be on if affected Lutron lighting zones are on at any level. The status 
LED will turn off if any of the affected zones are turned off.

Pathway LED logic functions differently when Ketra groups are included. The status LED uses scene 
LED logic for any Ketra groups. If the settings of the affected Ketra group change at all, the status 
LED will turn off.

continued on next page
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Button Type: Single Action 
LED Logic: Room

Not Recommended

Button Type: Toggle 
LED Logic: Scene

Not Recommended

Double Tap Programming: If both the press and the double tap include Ketra groups, the  
Ketra lights will incur a delay (about 1 second) on the double tap due to the propagation of the  
first command.

Automatic Sequences: Due to the 1.5 second delay between Ketra commands, automatic sequences 
for Ketra scenes should not be run faster than 1.5 seconds per step. 

Troubleshooting

Lutron Designer

1	 Ketra mapping is only supported in Lutron Designer version 14.0 or later.

2	 If the Ketra installation is not showing, verify that the installation was created as a Secure 
Installation, using a Ketra N4 hub, and with Ketra with HomeWorks QS selected.

3	 Publish or sync the Ketra installation.

4	 If Ketra groups are not showing on the programming tab, ensure that assignable items are 
shown in an area containing mapped Ketra groups.

5	 Cycle dim is not supported.

6	 If Ketra groups, scenes, or shows are not showing in Lutron Designer:

i	 Make sure the area has Ketra groups mapped to it.

ii	 Verify that the Ketra project was synced after the group, scene, or show was added. Syncing 
is accomplished by clicking Publish and Save and then closing Ketra Design Studio.

Lutron Connect Bridge and App

1	 Make sure the Lutron Connect bridge was activated successfully using Lutron Designer.

2	 Verify that the Lutron Connect bridge firmware is updated. Performing a power-cycle while the 
Lutron Connect bridge has an active internet connection will prompt a firmware download and 
installation if an update is available. 

continued on next page
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3	 If Ketra groups are not showing in the Lutron Connect app, ensure the following steps  
were performed:

i	 The Ketra installation was published or synced successfully.

ii	 The Ketra installation was imported or updated in Lutron Designer.

iii	 The Lutron Designer database was transferred successfully.

iv	 Cycle power to the Lutron Connect bridge.

v	 In the Lutron Connect app, go to Settings > Edit Home > Diagnostics > Redownload System 
Configuration.

Basic Functionality is Lost (e.g., keypad control, app control)

1	 When launching the Lutron Connect app, a warning message will be displayed if the Lutron 
Connect bridge cannot communicate with the Ketra N4 hub.

2	 Make sure the N4 Hub, Lutron Connect bridge, and the HomeWorks QS processor can be 
pinged at their expected IP addresses.

3	 Major changes to organization can “break” the integration between the HomeWorks QS system 
and Ketra devices. Since HomeWorks QS programming points to Ketra groups, removing lamps 
from a group will cause them to stop responding to HomeWorks QS input actions pointing to 
that group.

Ketra N4 Hub

1	 Ensure the Ketra N4 hubs have been updated using the Ketra Tech Tool.

2	 In Ketra Design Studio, verify communication with the N4 hub.

3	 In case the multicast traffic is blocked, enter the IP addresses of the Ketra N4 hubs into  
Lutron Designer.

Orphaned Ketra Lamps

Once the lamps are in a Ketra N4 hub system, they must be decommissioned (via the associated  
N4 hub) before they can be added to another system.

•	 Lamps cannot be returned to factory settings.

•	 If an N4 hub has lamps associated to it, do not reset the N4 hub as this will leave the  
lamps stranded.

•	 If an N4 hub with associated lamps is reset, open the installation and use the device 
replacement tool to add a new N4 hub to the installation.

APPENDIX A
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Special Considerations

Backup Control Options

Ensure reliable network

Successful integration of Ketra devices in a HomeWorks QS system relies on the local network for all 
of the devices to function properly. Therefore, it is essential to have the HomeWorks QS processors, 
Lutron Connect bridges, and Ketra N4 hubs all connected together in a robust way.

Networking Rule 1 
Avoid daisy-chaining through other devices and switches. Instead, connect all devices directly 
to the same switch (home run). This will allow the lighting devices to communicate even if other 
components have issues. 

Networking Rule 2 
Use a reliable switch that can function independently from the router or other network equipment. 
If using DHCP and the DHCP server goes down, the Lutron and Ketra devices will maintain their 
DHCP addresses and still be able to communicate. Alternatively, static IP addresses can be used. 

Note: Internet access is not required for run-time system functionality but is required for LAN 
connectivity. If the internet connection is lost, the system will not be affected. Internet access 
is still desirable for periodic updates.

Networking Rule 3 
HomeWorks QS processors are the only devices that should be daisy-chained via the built in 
Ethernet ports. Do not connect N4 hubs or Lutron Connect bridges to the Ethernet ports.

Networking Rule 4 
Connect each N4 hub to a port on the network switch rather than daisy-chaining the N4 hubs.

Networking Considerations 
Consider putting the network switch, HomeWorks QS processor, Lutron Connect bridge, and the N4 
hub on a battery backup in case power is lost.

Optional Manual Bypass Control

By default, all Ketra and Lutron lights will turn on to their last level. Lutron recommends keeping 
this default setting for almost all applications to avoid lights from coming on after a power outage. 
However, to provide control of Ketra lighting in an unexpected loss of system functionality due to 
networking or other problems, there are options to allow for backup control. Consider these when 
designing and wiring the installation or when solving a problem.

Specific Ketra lamps or fixtures can be wired and designated as safety lighting. This is accomplished 
by setting their poweron behavior to go to a predefined level. This can be specified per device 
in Ketra Design Studio. By doing this and allowing a means to toggle power to these lights, the 
occupant will be able to turn them on or off even if the system is completely off or disconnected.

continued on next page
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Ensure that there is an accessible, convenient way to toggle power to these lamps and wire  
them appropriately. Possibilities include:

•	 Toggle switches in closet or mechanical room

•	 Lutron PowPak module paired directly (a.k.a. standalone) to a Pico wireless control

•	 Lutron switching power module (e.g., LQSE-4S8-120-D) with system control and manual  
override switch

•	 Lutron Remote Power Module (RPM) with system control and manual override switch 

•	 Breaker

Scenarios

Scenario 1 
The specified Ketra safety lights come on after power outages at an unoccupied vacation home.

Recommendation: Add a timeclock event to be activated along with vacation mode. If these lamps 
are turned on after a power outage and the home is vacant, the system will turn them off.

Scenario 2 
The specified safety lights come on after power outages in the middle of the night.

Recommendations:

•	 Do not specify bedroom lights for this feature.

•	 Select lights as needed for stairways, egress areas, and other common areas.

•	 Avoid selecting all lights or bright light levels.

Note: These lights will be controllable after the system is restored after the power loss.

Best Practices

•	 Communicate with the homeowner regarding the behavior of any specified safety lights, 
specifically the power outage scenarios.

•	 Once a lamp loses power for more than 2 seconds, even with a generator, the lamp will perform 
its specified power-on behavior when power is restored.

•	 Considering using locally controlled Lutron dimmers and switches in addition to Ketra lighting 
for manual bypass control.

•	 Clearly label any backup points of control.

APPENDIX A
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Lutron, HomeWorks, and Pico are trademarks of Lutron Electronics Co., Inc., registered in the U.S. and other countries.

Lutron Designer and Lutron Connect are trademarks of Lutron Electronics Co., Inc.

Ketra is a trademark of Lutron Ketra, LLC.

Amazon and Alexa are trademarks of Amazon.com, Inc. or its affiliates.

Google Home and Google Play are trademarks of Google, Inc.

Apple and Siri registered trademarks and HomeKit is a trademark of Apple, Inc. App Store is a service mark of Apple, Inc.

Lutron Contact Numbers

World Headquarters 
USA
Lutron Electronics Co., Inc. 
7200 Suter Road 
Coopersburg, PA 18036-1299

TEL: +1.610.282.3800 
FAX: +1.610.282.1243

support@lutron.com 
www.lutron.com/support

North & South America Customer Assistance 
USA, Canada, Caribbean:
1.844.LUTRON1 (1.844.588.7661)

Mexico:
+1.888.235.2910
Central/South America:
+1.610.282.6701

European Headquarters 
United Kingdom
Lutron EA Limited 
125 Finsbury Pavement 
4th floor, London EC2A 1NQ 
United Kingdom

TEL: +44.(0)20.7702.0657 
FAX: +44.(0)20.7480.6899 
FREEPHONE (UK): 0800.282.107

Technical Support: +44.(0)20.7680.4481

lutronlondon@lutron.com 

Asian Headquarters 
Signapore
Lutron GL Ltd. 
390 Havelock Road
#07-04 King’s Centre
Singapore 169662

TEL: +65.6220.4666 
FAX: +65.6220.4333s

Technical Support: 800.120.4491 
lutronsea@lutron.com

Asia Technical Hotlines 
Northern China: 10.800.712.1536 
Southern China: 10.800.120.1536 
Hong Kong: 800.901.849 
Indonesia: 001.803.011.3994 
Japan: +81.3.5575.8411 
Macau: 0800.401 
Taiwan: 00.801.137.737 
Thailand: 001.800.120.665853 
Other Countries: +65.6220.4666
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Introduction

About DMX

DMX512 is an industry-standard control protocol, built upon RS485, that has roots in entertainment 
and theatrical lighting applications. It is easy to use, robust, and low-cost, and has found its way 
into many applications beyond the theater. As the name suggests, it is a way to send 512 8-bit data 
values over a single cable.

There are several rules of thumb to follow when physically wiring DMX networks:

•	 Total run length should not exceed 300m (~1000 feet)

•	 Maximum number of receivers connected to the cable is 32

•	 The end of the cable run (farthest from transmitter) should be terminated properly with a  
120-ohm resistor

•	 All products should be connected in a serial fashion, not in star or “home run” topologies

N3 Satellite as DMX Console

The N3 Satellite acts as a bridge between the external DMX system and the Ketra lighting system.  
Its DMX ports (shown below) can send or receive a full universe (512 channels) of DMX512-A.
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DMX ports

An N3 can be configured as DMX master or DMX slave, which determines the directionality  
of control data. 

• DMX master — N3 outputs DMX to a 3rd party device (i.e., Ketra controls external system)

• DMX slave — N3 receives DMX from a 3rd party device and relays it to the Ketra system (i.e., 
external system controls Ketra)

Introduction

ABOUT DMX

DMX512 is an industry-standard control protocol, built upon RS485, that has roots in entertainment 
and theatrical lighting applications. It is easy to use, robust, and low-cost, and has found its way 
into many applications beyond the theater. As the name suggests, it is a way to send 512 8-bit data 
values over a single cable.

There are several rules of thumb to follow when physically wiring DMX networks:

• Total run length should not exceed 300m (~1000 feet)

• Maximum number of receivers connected to the cable is 32

• The end of the cable run (farthest from transmitter) should be terminated properly with a  
120-ohm resistor

• All products should be connected in a serial fashion, not in star or “home run” topologies

N3 SATELLITE AS DMX CONSOLE

The N3 Satellite acts as a bridge between the external DMX system and the Ketra lighting system. 
Its DMX ports (shown below) can send or receive a full universe (512 channels) of DMX512-A.

An N3 can be configured as DMX master or DMX slave, which determines the directionality of  
control data.

•	 DMX master — N3 outputs DMX to a 3rd party device (i.e., Ketra controls external system)

•	 DMX slave — N3 receives DMX from a 3rd party device and relays it to the Ketra system (i.e., 
external system controls Ketra)
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DMX CONTROL SUPPORT WITH KETRA

DMX vs. Analog Control

In addition to supporting DMX input and output, the N3 Satellite separately supports analog 
input and output, including 0-10V, 0-24V, and sustained contact closures. Each method is useful in 
different applications.

Ideal Usage Input Example Output Example

DMX Sending or receiving 
adjustable color and 
intensity configurations

Ketra controlled by a 
third-party console with 
sliders for red, green, 
blue, and intensity

Ketra controls third-
party lighting with 
red, green, blue, and 
intensity parameters

0-10V / 0-24V (Analog) Sending or receiving 
adjustable intensity 
configurations

Ketra controlled by a 
photosensor outputting 
a 0-10V signal

Ketra controls third-
party lighting’s intensity

Contact Closure 
(Analog)

Sending or receiving 
triggers, such as 
commands to turn on/ 
off or play a scene

Ketra controlled by an 
occupancy sensor

Ketra controls a window 
shade with raise and 
lower commands

This app note discusses DMX, not analog integration. 

DMX Slave

When an N3 Satellite is configured as DMX slave, it enables external DMX to control the Ketra 
lighting system. The N3 receives data from a DMX driver, then patches (transmits) that data to Ketra 
groups (i.e., to each control zone’s lights).

The N3 uses any combination of 3 methods to patch DMX data to Ketra groups:

•	 KetraNet Mesh — wireless communication between the N3 and Ketra products, including lamps, 
downlights, and other N3 Satellites

•	 KetraNet PLC — wired communication between the N3 and an attached run of linear fixtures

•	 0-10V signal — wired communication between the N3 and a third party product that accepts 
0-10V intensity information 
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DMX VS. ANALOG CONTROL

In addition to supporting DMX input and output, the N3 Satellite separately supports analog 
input and output, including 0-10V, 0-24V, and sustained contact closures. Each method is useful in 
different applications. 

Ideal Usage Input Example Output Example
DMX Sending or receiving 

adjustable color and 
intensity configurations

Ketra controlled by a 
third-party console with 
sliders for red, green, 
blue, and intensity

Ketra controls third-
party lighting with 
red, green, blue, and 
intensity parameters

0-10V / 0-24V 
(Analog)

Sending or receiving 
adjustable intensity 
configurations

Ketra controlled by a 
photosensor outputting 
a 0-10V signal

Ketra controls third-
party lighting’s intensity

Contact Closure 
(Analog)

Sending or receiving 
triggers, such as 
commands to turn on/
off or play a scene

Ketra controlled by an 
occupancy sensor

Ketra controls a window 
shade with raise and 
lower commands

This app note discusses DMX, not analog integration.

DMX Slave

When an N3 Satellite is configured as DMX slave, it enables external DMX to control the Ketra 
lighting system. The N3 receives data from a DMX driver, then patches (transmits) that data to 
Ketra groups (i.e., to each control zone’s lights).

The N3 uses any combination of 3 methods to patch DMX data to Ketra groups:

• KetraNet Mesh — wireless communication between the N3 and Ketra products, including lamps, 
downlights, and other N3 Satellites

• KetraNet PLC — wired communication between the N3 and an attached run of linear fixtures

• 0-10V signal — wired communication between the N3 and a third party product that accepts 
0-10V intensity information

AC Mains

AC Mains

AC MainsAC Mains Ketra 
Downlight N3 Satellite

N3 Satellite
Ketra Linear 
Luminaire

Ketra Linear 
Luminaire

3rd Party 
Product

Ketra  
Lamp

DMX 
Controller

DMX Data KetraNet PLC

KetraNet Mesh

0-10V Signal
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Workflow

1	 Physically install and connect power to Ketra’s products.

2	 Run the Design Studio software and create an installation file.

3	 Create groups and add devices as required for project application.

4	 Set up DMX profiles in Design Studio and select which lighting groups each profile is mapped to. 
"Publish” Ketra installation data.

5	 Set up 3rd party controller to send the corresponding DMX profile ranges to the Ketra  
N3 Satellite.

For instructions on steps 2-5, see the Design Studio user manual.

Performance

The N3 patches DMX to Ketra devices in 55-channel data frames, one frame at a time. Once all 
frames have been sent out, a final “go” command is issued and all of the affected lighting products 
change state in unison.

The frame rate varies based on whether data is being patched over wire or KetraNet Mesh.

•	 Over wire, the N3 patches data at a rate of 20 Hz, or ~20 f/s. So, patching a full DMX universe 
would take at most ~0.5 seconds. That means speed is seldom an issue when patching solely  
by wire.

•	 Over KetraNet Mesh, the N3 patches data at a rate of 0.67 Hz, or ~0.67 f/s (1.5 seconds per frame 
after the first frame). So, patching a full DMX universe would take up to ~13.5 seconds.

Note: In an application where both KetraNet Mesh and wired communication (KetraNet PLC 
or 0-10V output) are used, the wired communication speed will “downgrade” to match the 
KetraNet Mesh speed. This ensures that all devices change in sync.

Since the delay when communicating over KetraNet Mesh can be significant, we recommend 
reading Wireless Latency to calculate and account for delays.

Performing Fades

Fade rates should be sent from the DMX controller as a parameter.

Ketra offers profiles that include a fade rate parameter (e.g., RGBIF). When the N3 Satellite receives 
the DMX input, it will relay the fade value to Ketra groups; when the “go” command is given, the 
groups will transition to the desired color and intensity over the period of time set by the fade  
rate parameter.

This is especially important in applications that patch DMX input over KetraNet Mesh. Due to 
wireless latency, initiating a fade up or fade down from a DMX console may result in the wireless 
Ketra lights making large steps in intensity rather than smoothly transitioning. Sending fade rate as 
a parameter eliminates this problem.

APPENDIX B
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Wireless Latency

If the N3 Satellite has to patch DMX data to at least 1 KetraNet Mesh device (lamp, downlight, or 
other N3 Satellite), you may experience delays between the beginning of transmission and the Ketra 
lights’ response.

In most cases, the first 55-channel data frame broadcasts immediately. After the first frame, each 
additional frame requires up to 1.5 seconds to broadcast. Once all frames have been broadcast, a 
final “go” command is issued and all of the affected lighting products change state in unison.

Note: The 1.5-second delay occurs between all broadcasts. Therefore, the first 55-channel 
frame will only experience a delay if the N3 Satellite broadcast a frame from another 
command less than 1.5 seconds previously.

To calculate the maximum delay possible (in seconds), use the following four-step calculation:

1	 Divide the number of DMX channels the N3 is listening to by 55. (You do not need to count the 
same channel range multiple times if you are patching it to multiple groups.)

2	 Round up to nearest whole number.

3	 Multiply the result by 1.5.

4	 Subtract 1.5 to represent the first frame, assuming no other frame was broadcast within 1.5 
seconds previously.
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This is especially important in applications that patch DMX input over KetraNet Mesh. Due to 
wireless latency, initiating a fade up or fade down from a DMX console may result in the wireless 
Ketra lights making large steps in intensity rather than smoothly transitioning. Sending fade rate 
as a parameter eliminates this problem.

WIRELESS LATENCY

If the N3 Satellite has to patch DMX data to at least 1 KetraNet Mesh device (lamp, downlight, or 
other N3 Satellite), you may experience delays between the beginning of transmission and the 
Ketra lights’ response. 

In most cases, the first 55-channel data frame broadcasts immediately. After the first frame, each 
additional frame requires up to 1.5 seconds to broadcast. Once all frames have been broadcast, a 
final “go” command is issued and all of the affected lighting products change state in unison. 

Note: The 1.5-second delay occurs between all broadcasts. Therefore, the first 55-channel frame 
will only experience a delay if the N3 Satellite broadcast a frame from another command less 
than 1.5 seconds previously.

To calculate the maximum delay possible (in seconds), use the following four-step calculation: 

1. Divide the number of DMX channels the N3 is listening to by 55. (You do not need to count the 
same channel range multiple times if you are patching it to multiple groups.)

2. Round up to nearest whole number.

3. Multiply the result by 1.5.

4. Subtract 1.5 to represent the first frame, assuming no other frame was broadcast within 1.5 
seconds previously.

continued on next page

T = 1.5 x ciel ( ) - 1.5
n

55

where T is delay in seconds, and n is the number of 
DMX channels the N3 is listening to

Note: 1.5 seconds is a maximum figure. Actual latency time varies with signal interference. 

Example: An N3 patches 60 DMX channels over KetraNet Mesh. 2 data frames will be required: 1 for 
the first 55 channels, and 1 for the remaining 5 channels. The first frame experiences no delay, while 
the second takes up to 1.5 seconds to broadcast. Therefore, the maximum latency is 1.5 seconds. 

Note: 1.5 seconds is a maximum figure. Actual latency time varies with signal interference. 

Example: An N3 patches 60 DMX channels over KetraNet Mesh. 2 data frames will be required: 1 for 
the first 55 channels, and 1 for the remaining 5 channels. The first frame experiences no delay, while 
the second takes up to 1.5 seconds to broadcast. Therefore, the maximum latency is 1.5 seconds.

One way to account for wireless delays is to calculate the expected latency using the formula 
above, then send the DMX values that far in advance of when a transition should occur. Most DMX 
controllers include timeline editing and can support this use case. 

However, since 1.5 seconds per frame is a maximum figure, the transition may occur before the 
desired time. How much before depends on the number of data frames being broadcast. This is one 
reason we recommend against using Ketra’s wireless network for live applications such as theatre.
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Wireless Restrictions

Only 1 N3 Satellite can wirelessly patch input per KNet. A KNet refers to all the devices associated 
with a single N4 Hub.

•	 If the installation only has 1 N4 Hub, then only 1 N3 Satellite can wirelessly relay DMX commands.

•	 If the installation has multiple N4 Hubs, each KNet can only receive wirelessly-patched DMX 
data from one N3.

Fig. 1 illustrates a valid DMX setup in an installation with multiple N4 Hubs. An N3 Satellite in KNet 1 
wirelessly relays DMX commands to groups in both KNet 1 and KNet 2. Fig. 2 shows the same setup 
slightly altered to be invalid.
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One way to account for wireless delays is to calculate the expected latency using the formula 
above, then send the DMX values that far in advance of when a transition should occur. Most  
DMX controllers include timeline editing and can support this use case. 

However, since 1.5 seconds per frame is a maximum figure, the transition may occur before the 
desired time. How much before depends on the number of data frames being broadcast. This  
is one reason we recommend against using Ketra’s wireless network for live applications such  
as theatre. 

WIRELESS RESTRICTIONS

Only 1 N3 Satellite can wirelessly patch input per KNet. A KNet refers to all the devices associated 
with a single N4 Hub. 

• If the installation only has 1 N4 Hub, then only 1 N3 Satellite can wirelessly relay  
DMX commands.

• If the installation has multiple N4 Hubs, each KNet can only receive wirelessly-patched DMX 
data from one N3. 

Fig. 1 illustrates a valid DMX setup in an installation with multiple N4 Hubs. An N3 Satellite in KNet 
1 wirelessly relays DMX commands to groups in both KNet 1 and KNet 2. Fig. 2 shows the same 
setup slightly altered to be invalid.

Any groups that violate this rule will not appear in Design Studio as available groups for patching 
DMX data to.

N3 Satellite

DMX Device

N4 Hub N4 Hub

Group 1

KNet 1 KNet 2

Group 2

Group 3

Other Ketra 
devices

Other Ketra 
devices

N3 Satellite

DMX Device

N4 Hub N4 Hub

KNet 1 KNet 2

Group 1

Group 2

Group 3

N3 Satellite

DMX Device

N4 Hub N4 Hub

KNet 1 KNet 2

N3 Satellite

DMX Device

Group 1 Group 4

Group 2

Group 3

N3 Satellite

DMX Device

N4 Hub N4 Hub

KNet 1 KNet 2

N3 Satellite

DMX Device

Group 1 Group 4

Group 2

Group 3

Fig. 1

Fig. 1’s DMX wireless setup is valid. Neither KNet 

receives DMX data from more than 1 N3 Satellite

Fig. 2

Fig. 2’s DMX wireless setup is invalid. KNet 2 receives 

DMX input from 2 different N3 Satellites.

Any groups that violate this rule will not appear in Design Studio as available groups for patching 
DMX data to.

DMX Master

When an N3 Satellite is configured as DMX master, it enables the Ketra system to control an external 
DMX system. Using Design Studio, you can program DMX output values into Ketra scenes and shows. 
When one of those scenes or shows is triggered through the Ketra system (e.g., by a button press 
on a Ketra or Homeworks QS keypad), the N3 Satellite sends the corresponding DMX levels to the 
external DMX system.
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DMX Master

When an N3 Satellite is configured as DMX master, it enables the Ketra system to control an 
external DMX system. Using Design Studio, you can program DMX output values into Ketra scenes 
and shows. When one of those scenes or shows is triggered through the Ketra system (e.g., by a 
button press on a Ketra or Homeworks QS keypad), the N3 Satellite sends the corresponding DMX 
levels to the external DMX system.

AC Mains AC Mains

N3 Satellite DMX Driver DMX Reciever
Scene or 
Show Trigger

DMX DataKetraNet Mesh

The N3 Satellite’s DMX output port supports a full DMX universe at 44 Hz frame rate. 

WORKFLOW

1. Physically install and connect power to Ketra’s products.

2. Run the Design Studio software and create an installation file. 

3. Create groups and add devices as required for project application.

4. Configure profile ranges for DMX output in Ketra Tech Tool and save configurations.

5. Sort each profile into a Ketra group in Design Studio.

6. Customize each group as part of a scene in Design Studio. 

7. Assign the scene to an input source, i.e., a Homeworks QS keypad button, Ketra keypad button, 
contact-closure input, or time trigger in a show. 

8. “Publish” Ketra installation data.

9. Set up 3rd party DMX receiver(s) to listen to the appropriate channels.

For instructions on steps 2-8, see the Design Studio user manual available on our website.

PERFORMANCE

There is virtually no lag between input (e.g., keypad button press) and DMX receiver response. 

continued on next page

The N3 Satellite's DMX output port supports a full DMX universe at 44 Hz frame rate.
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Workflow

1	 Physically install and connect power to Ketra’s products.

2	 Run the Design Studio software and create an installation file.

3	 Create groups and add devices as required for project application.

4	 Configure profile ranges for DMX output in Ketra Tech Tool and save configurations.

5	 Sort each profile into a Ketra group in Design Studio.

6	 Customize each group as part of a scene in Design Studio.

7	 Assign the scene to an input source, i.e., a Homeworks QS keypad button, Ketra keypad button, 
contact-closure input, or time trigger in a show.

8	 “Publish” Ketra installation data.

9	 Set up 3rd party DMX receiver(s) to listen to the appropriate channels.

For instructions on steps 2-8, see the Design Studio user manual.

Performance

There is virtually no lag between input (e.g., keypad button press) and DMX receiver response.

Ketra DMX Profiles

Ketra offers a huge variety of DMX profiles applicable to master and slave applications.

Notes:

–– All profiles have 8-bit and 16-bit options. 16-bit offers extremely fine control and takes up 
twice as many channels. 8-bit is sufficient for the vast majority of applications.

–– Dimming requires either:

	 •  A profile with RGB (including RGB, RGBA, RGBW, etc.), or:

	 •  A profile with I (Intensity).

–– For a parameter key, see Ketra DMX Parameters, page 207.

continued on next page
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Ketra DMX Profiles

RGB Control Profiles

Profile Channels (8-Bit) Channels (16-Bit) Notes

RGB 3 6

RGBA 4 8 DMX Master only

RGBAF 5 10 DMX Master only

RGBAI 5 10 DMX Master only

RGBAIF 6 12 DMX Master only

RGBF 4 8

RGBI 4 8

RGBIF 5 10

RGBW 4 8

RGBWF 5 10

RGBWI 5 10

RGBWIF 6 12

CCT Control Profiles

Profile Channels (8-Bit) Channels (16-Bit) Notes

Cct 1 2 Dimming not supported

CctDuvI 3 6

CctDuvIF 4 8

CctDuvIV 4 8

CctDuvIVF 5 10

CctF 2 4 Dimming not supported

CctI 2 4

CctIF 3 6

CctIV 3 6

CctIVF 4 8

CctV 2 4 Dimming not supported

CctVF 3 6 Dimming not supported

continued on next page
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X/Y Control Profiles (CIE 1931)

Profile Channels (8-Bit) Channels (16-Bit) Notes

XYIV 4 8

XYIVF 5 10

Non-Color Control Profiles

Profile Channels (8-Bit) Channels (16-Bit) Notes

I 1 2

IF 2 4

IV 2 4

IVF 3 6

Masteri 1 2

MasteriF 2 4

V 1 2 Dimming not supported

VF 2 4 Dimming not supported

Ketra DMX Parameters

Every Ketra DMX profile contains a set of parameters, each corresponding to a channel.

Example: An RGB profile with starting channel 1 consists of the following:

•	 A Red value, outputting on channel 1

•	 A Green value, outputting on channel 2

•	 A Blue value, outputting on channel 3

When selecting a profile in Design Studio or Tech Tool, use the table below as a reference for  
each parameter.

continued on next page
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Ketra DMX Parameters

Color Parameters

Symbol Parameter Name Range (Min = 0, Max = 255 
8-bit or 65535 16-bit)

Implementation Notes

R Red Min: Off, Max: Red LED to 
full intensity

G Green Min: Off, Max: Green LED  
to full intensity

B Blue Min: Off, Max: Blue LED to 
full intensity

W White Min: Off, Max: White LED  
to full intensity

A Amber Min: Off, Max: Amber LED  
to full intensity

Ketra lights do not have an 
Amber emitter, so profiles with 
this parameter are unavailable 
for DMX Slave.

X CIE 1931 x 
coordinate

Min: 0.0, Max: 1.0 

Y CIE 1931 y 
coordinate

Min: 0.0, Max: 1.0

Cct Color Temperature Min: 2000K, Max: 9970K or 
10000K (8-bit vs. 16-bit)

Duv Tint (distance from 
black body locus)

Min: -0.05, Max: +0.0496 At 50% (127 for 8-bit, 32768 for 
16-bit), tint is +0.00, meaning 
the color temperature is on 
the black body locus.

Intensity Parameters

Symbol Parameter Name Range (Min = 0, Max = 255 
8-bit or 65535 16-bit)

Implementation Notes

I Intensity Min: 0%, Max: 100% Use if at least one scene will 
set the receivers’ intensity to a 
<100% value.

Masteri Master Intensity Min: 0%, Max: 100% Use if all scenes will leave the 
receivers’ intensity at 100% 
unless dimmed from a keypad 
or other input.

continued on next page
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Other Parameters

Symbol Parameter Name Range (Min = 0, Max = 255 
8-bit or 65535 16-bit)

Implementation Notes

V Vibrancy Min: 0%, Max: 100% At 0%, the current color 
point is powered more by 
the W emitter. At 100%, 
the color point is powered 
more by the RGB emitters. 
Objects illuminated at higher 
vibrancy typically appear more 
saturated.

F Fade Min: 0 seconds, Max: 255 
seconds or 6553.5 seconds 
(8-bit vs. 16-bit)

If N3 is DMX slave, ‘F’ 
parameter is required for 
fades. If N3 is DMX master, ‘F’ 
parameter should only be used 
if receivers require fade times 
be sent as a parameter.

Support

For questions and technical support please contact:

(844) 588-6645 
ketrasupport@lutron.com
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For questions and technical support please contact:

(844) 588-6445 
ketrasupport@lutron.com
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